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1 Introduction to Sonalleve MR-HIFU
1.1 About Sonalleve MR-HIFU

The Sonalleve MR guided High Intensity Focused Ultrasound (MR-HIFU) System has the following
therapeutic application:

MR guided treatment of uterine fibroids and uterine adenomyosis

MR guided pain palliation of bone metastasis

Sonalleve MR-HIFU is designed to be used with Philips MR scanners.
The use of MR-HIFU requires the following equipment:

Achieva 1.5 T/3.0 T or Ingenia 1.5 T/3.0 T MR scanner.

Sonalleve MR-HIFU system.

This manual will guide you in the use of the Sonalleve MR-HIFU system. In addition, all the
instructions and safety precautions for the MR scanner apply when working with the Sonalleve MR-
HIFU system. For more information, refer to the MR scanner's Instructions for Use.

1.2 About this manual

This manual applies to the following MR-HIFU system configurations:

SONALLEVE MR-HIFU V2 ACHIEVA 1.5T

SONALLEVE MR-HIFU V2 ACHIEVA 3T

SONALLEVE MR-HIFU V2 INGENIA 1.5T

SONALLEVE MR-HIFU V2 INGENIA 3T

This manual provides information on the correct and safe use of the Sonalleve MR-HIFU system.
These Instructions for Use are intended to assist users in the safe and effective operation of the
product described.
Before attempting to operate the system, you must read these Instructions for Use, noting and
strictly observing all WARNINGS and CAUTION notices.
Pay special attention to all the information given and procedures described in 2 Safety.

The intended use and standards compliance of the Sonalleve MR-HIFU product are described
in 1 Introduction to Sonalleve MR-HIFU. This chapter also explains the textual conventions used
in this manual.

The safety aspects of using the Sonalleve MR-HIFU system are described and important
instructions for the safe use of the product are given in 2 Safety.

An overview of the system components is given in 3 System overview.

The key terms and concepts related to working with Sonalleve MR-HIFU and an outline of the
different treatment methods are provided in 4 Treatment methods.

The basic organization and functions of the User Interface are explained in 5 User interface.
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You are guided through the entire treatment workflow from system and patient preparation to
post-treatment check-ups in 6 Workflow.

Regular daily, weekly and monthly maintenance instructions for ensuring reliable and fault-free
operation of the system are provided in 7 Maintenance.

The error and warning messages are described in 8 System Error and Warning messages.

For information on the safe and environmentally sound disposal of the product, refer to 9
Product disposal.

Additional information on certain topics is provided in 10 Appendices.

These Instructions for Use describe the most extensive configuration of the product, with the
maximum number of options and accessories. Not every function described may be available on
your product.

Important   
Apart from this manual, Profound Medical also produces a Technical Description (in English
only). It provides additional data essential for safe operation and the measures or
conditions necessary for installing the Sonalleve MR-HIFU system for use with the MR
scanner.

1.2.1 Notations

WARNING   
A WARNING alerts you to a potential serious outcome, adverse event or safety hazard.
Failure to observe a warning may result in death or serious injury to the user or patient.

CAUTION   
A CAUTION alerts you to where special care is necessary for the safe and effective use of
the product.
Failure to observe a caution may result in minor or moderate personal injury or damage to
the product or other property, and possibly in a remote risk of more serious injury, and/or
may cause environmental pollution.

NOTICE   
NOTICES highlight unusual points as an aid to the user.

WARNINGS and CAUTIONS in this Instructions for Use are each marked with one of the following
symbols, according to the cause of the safety hazard or the potential outcome:
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General symbol for WARNINGS and CAUTIONS

Crushing of hands

Electricity

Laser beam

Magnetic field

1.3 Intended use

This Profound Medical product is intended to be installed, used and operated only in accordance
with the safety procedures and operating instructions given in this Instructions for Use for the
purpose for which it was designed. The purpose for which the product is intended is given below.
However, nothing stated in this Instructions for Use reduces users’ responsibilities for sound clinical
judgment and best clinical procedure.
The system is designed to be used on patients with no MR contraindications and that fulfill the
criteria for treatment as indicated in 2.2 Contraindications and restrictions.
Installation, use and operation of this product is subject to the law in the jurisdiction in which the
product is being used. Users must only use and operate the product in such ways that do not
conflict with applicable laws, or regulations, which have the force of law.
Uses of the product for purposes other than those intended and expressly stated by the
manufacturer, as well as incorrect use or operation, may relieve the manufacturer (or its agent)
from all or some responsibility for resultant non-compliance, damage or injury.
The intended use is subject to regulatory approval and can have country-specific limitations.
In the Republic of Korea and in the People's Republic of China, the intended use of the Sonalleve
MR-HIFU therapy system is uterine fibroids only. Disregard all references to the treatment of
adenomyosis and to the Bone application.
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CAUTION   
In the United States of America:
CAUTION: Federal law restricts this device to sale by or on the order of a physician.

NOTICE   
This Sonalleve MR-HIFU System is NOT intended for diagnostic imaging. Several image quality
and other performance compromises have been made, which make this system inadequate for
general diagnostics.

1.3.1 Sonalleve Uterine Application

The Sonalleve MR-HIFU Uterine Therapy Application is indicated for the ablation of symptomatic
uterine fibroids or adenomyotic tissue in pre- or peri-menopausal women who desire a uterine
sparing treatment.
Women planning future pregnancy should consult with their physician before seeking MR-HIFU
treatment.

NOTICE   
Please look at the list of contraindications in 2.2 Contraindications and restrictions.

Adverse Effects
HIFU treatment may be associated with spontaneous detachment or expulsion of a pedunculated
intra-uterine fibroid. Patients may need to be informed about the possibility of detachment or
expulsion and, if considered clinically necessary, monitored after the treatment.
Although the MR-HIFU treatment of uterine fibroids is generally safe and often causes the patient
little or no pain, potential adverse effects have been reported in literature. Most of these effects are
transitory and can be avoided with careful treatment planning.
This list of adverse effects and the estimates on their frequency of occurrence are based on reports
in literature. References to the relevant literature will be supplied on request by your local Profound
Medical application support representative.
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Tab. 1: Potential adverse effects of MR-HIFU treatment, Uterine application.

Severity /
Duration

Occurrence
rate

Source Adverse effects

Mild and
transitory
effects

< 10% HIFU Nausea or vomiting

Heating sensation / pain during sonication

Pain

Leg and buttock pain

Sciatic pain / leg numbness

Nerve injury or damage

Abdominal tenderness or pain

First degree skin burns

Swelling

Abdominal cramping

Thermal injury to internal tissue

Fever

Above baseline vaginal bleeding

Patient
positioning

Shoulder, neck, or back pain (tension) from
immobilization

Catheter Urinary symptoms, such as infection or
hematuria

Urinary difficulty

Drugs
(contrast
agents,
painkillers)

Adverse reactions like nausea, vomiting,
headache, or dizziness
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Moderate and
transitory
effects

< 1% HIFU Second degree skin burns

Pain

Leg and buttock pain

Sciatic pain / leg numbness

Thermal injury to internal tissue

Deep vein thrombosis from sonication or
immobilization leading to cramping and pain
in lower extremities

Infection due to vaginal expulsion of the
fibroid

Catheter Urinary symptoms, such as infection or
hematuria

Other infections

Fever caused by infection

Bleeding

Serious or
permanent
effects

< 1% HIFU Third degree skin burns

Thermal injury to internal tissue

Premature menopause

Pulmonary embolism from long
immobilization in treatment position or
sonication to a vein

Inflammatory symptoms similar to
postembolization syndrome

< 0.01% HIFU Injury to abdominal and pelvic organs (e.g.
bladder, uterus, bowel)

Bowel perforation

Nerve injury or damage

Metabolic imbalance (Tumor Lysis
Syndrome)

1.3.2 Sonalleve Bone Application

The Sonalleve MR-HIFU Bone Pain Palliation Therapy Application is indicated for palliative
treatments to relieve pain associated with bone metastasis.

Adverse effects
Although the MR-HIFU treatment of bone metastases is generally safe, potential adverse effects
have been reported in literature. Most of these effects are transitory and can be avoided with
careful treatment planning.
This list of adverse effects and the estimates on their frequency of occurrence are based on reports
in literature. References to the relevant literature will be supplied on request by your local Profound
Medical application support representative.
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Tab. 2: Potential adverse effects of MR-HIFU treatment, Bone application.

Severity /
Duration

Occurrence
rate

Source Adverse effects

Mild and
transitory
effects

< 10% HIFU Nausea or vomiting

Pain

Sciatic pain / leg numbness

Nerve injury or damage

First degree skin burns

Swelling

Thermal injury to internal tissue

Catheter Urinary symptoms, such as infection or
hematuria

Urinary difficulty

Drugs
(contrast
agents,
painkillers)

Adverse reactions like nausea, vomiting,
headache, or dizziness

Moderate and
transitory
effects

< 10% HIFU Pain

< 3% HIFU Second degree skin burns

Thermal injury to internal tissue

< 1% HIFU Deep vein thrombosis from sonication or
immobilization leading to cramping and pain
in lower extremities

Catheter Urinary symptoms, such as infection or
hematuria

Other infections

Fever caused by infection

Bleeding
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Serious or
permanent
effects

< 1% HIFU Third degree skin burns

Thermal injury to internal tissue

Tendon rupture

Pulmonary embolism from long
immobilization in treatment position or
sonication to a vein

< 0.01% HIFU Nerve injury or damage

Fracture of treated site

Metabolic imbalance (Tumor Lysis
Syndrome)

1.4 Operator profile

The Sonalleve MR-HIFU operator can be a person with professional qualifications for and
experience in MR imaging. All operators treating patients with Sonalleve MR-HIFU must have
received training by Profound Medical in the safe use of the system.
In addition, hospital technicians, clinical scientists, application specialists and service personnel
who have attended Sonalleve MR-HIFU training may use the system for testing, upgrades,
maintenance and routine Quality Assurance (QA). For more information, see 7 Maintenance.

1.5 Compatibility

The Sonalleve MR-HIFU System is available for Philips Achieva and Ingenia MR scanners.
The product described in this manual should not be used in combination with other products or
components unless such other products or components are expressly recognized as compatible by
Profound Medical. A list of such products and components is available from Profound Medical.
The other products and components that may be used with the system may each have their own
Instructions for Use.
Changes and/or additions to the product should only be carried out by Profound Medical or by third
parties expressly authorized by Profound Medical to do so. Such changes and/or additions must
comply with all applicable laws and regulations that have the force of law within the jurisdiction(s)
concerned, and with best engineering practice.

WARNING   
Changes and/or additions to the product that are carried out by persons without the
appropriate training and/or using unapproved spare parts may lead to the Profound Medical
warranty being voided.
As with all complex technical products, maintenance by persons not appropriately qualified
and/or using unapproved spare parts carries serious risks of damage to the product and of
personal injury.

1 Introduction to Sonalleve MR-HIFU > 1.4 Operator profile

Instructions for Use  
109011C / 2025-12

12 (206)



1.6 Compliance

The Profound Medical Sonalleve MR-HIFU system complies with relevant international and
national standards and laws. Information on compliance will be supplied on request by your local
Profound Medical representative.

1.7 Training

Users of this product must have received adequate training on its safe and effective use before
attempting to operate the product described in this Instructions for Use. Training requirements for
this type of device will vary from country to country. Users must make sure they receive adequate
training in accordance with local laws or regulations.
If you require further information about training in the use of this product, please contact your local
Profound Medical representative.

1.8 Installation instructions

The installation instructions for the Sonalleve MR-HIFU system are supplied by Profound Medical
in separate documentation.
The installation must only be performed by appropriately trained personnel. Profound Medical can
only accept responsibility for basic safety, reliability and performance, if:

Qualified personnel carry out assembly operations, extensions, readjustments or repairs,

The electrical installation of the technical room complies with the appropriate requirements, and:

The Sonalleve MR-HIFU system is used in accordance with the Instructions for Use.

1.9 System classification

According to the classification in the international/European standard IEC/EN 60601-1:

Tab. 3: Equipment classification.

EQUIPMENT CLASSIFICATION

Classification according to IEC 60601-1, Medical electrical equipment

Protection against electrical shock System: Class 1 Medical Electrical Equipment.

Applied parts: type BF.

Protection against harmful ingress of
water or particulate matter

Ordinary equipment (enclosed equipment without
protection against ingress of water, IPX0).

Methods of sterilization or
disinfection

Not intended to be sterilized. Use of liquid surface
disinfectants only.

Mode of operation Continuous operation.
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2 Safety
2.1 General safety

Carefully read the safety instructions and always observe them when working with the Sonalleve
MR-HIFU equipment. Failure to follow appropriate safety measures may lead to injuries to the
patient or personnel, or damage to the equipment.
Make sure that all of the electrical and mechanical assemblies and parts of the Sonalleve MR-HIFU
system are used with care and routinely inspected according to the instructions in this manual.

WARNING   
Do not use the product for any application until you are sure that the user routine checks
have been satisfactorily completed, and that the periodic maintenance of the product is up
to date. If any part of the product is known (or suspected) to be defective or wrongly
adjusted, DO NOT USE the product until a repair has been made.
Operation of the product with defective or wrongly adjusted components could expose the
user or the patient to safety hazards. This could lead to fatal or other serious personal
injury, or to clinical mistreatment.

Make sure that all personnel who use the equipment:

Are instructed in the proper usage of the equipment, hardware and software.

Are aware of the limitations in the performance of the hardware and software.

Are aware of and observe all warnings and cautions that appear in this manual.

Are aware of the safety issues, instructions and limitations listed in this manual.

Are familiar with the MR scanner’s Instructions for Use as well as other manuals provided with
the MR imaging systems.

Before using the Sonalleve MR-HIFU system with an MR scanner, you should have a basic
knowledge of the MR system and its performance.

WARNING   
Do not use the product for any application until you have read, understood and know all the
safety information, safety procedures and emergency procedures contained in this SAFETY
section.
Operation of the product without a proper awareness of how to use it safely could lead to
fatal or other serious personal injury. It could also lead to clinical mistreatment.

WARNING   
Do not use the product for any application until you have received adequate and proper
training in its safe and effective operation. If you are unsure of your ability to operate this
product safely and effectively DO NOT USE IT.
Operation of this product without proper and adequate training could lead to fatal or other
serious personal injury. It could also lead to clinical mistreatment.
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WARNING   
Do not operate the product with patients unless you have an adequate understanding of its
capabilities and functions.
Using this product without such an understanding may compromise its effectiveness and/or
reduce the safety of the patient, you and others.

WARNING   
Never attempt to remove, modify, or over-ride or frustrate any safety features on the
product.
Interfering with safety features could lead to fatal or other serious personal injury.

WARNING   
Do not use the product for any purpose other than those for which it is intended. Do not use
the product with any product other than that which Profound Medical recognizes as
compatible.
Operation of the product for unintended purposes, or with an incompatible product, could
lead to fatal or other serious injury. It could also lead to clinical mistreatment.

WARNING   
No part of the system may be serviced or maintained while in use with a patient.
An attempt to service or maintain the system during treatment could lead to fatal or other
serious injury. It could also lead to clinical mistreatment.

WARNING   
There is a Configuration Editor included in the HIFU Service tools that is intended for
qualified service personnel only, changing configurations may compromise patient safety
and cause problems in the operation and performance of the Sonalleve MR-HIFU system.
Never change the configurations without first consulting the Profound Medical Service
organization.

WARNING   
Never expose volunteers to acoustic energy. Even low power ultrasound exposures may
cause tissue heating or other damage. To avoid unintended ultrasound exposures in
training sessions with volunteers, either make sure that the Sonalleve MR-HIFU system is
switched OFF, or that the ultrasound beam path is blocked with an absorption pad, or a
large positioning pad and a towel (see 7.5 Ultrasound protection for details). Do not
sonicate the absorption pad or the large positioning pad on purpose.
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When using the system for volunteer scanning, place another thin positioning pad, a thick towel or
cloth on top of the protectively used large positioning pad or absorption pad to prevent skin contact.
Do not place the absorption pad or the large positioning pad in the ultrasound beam, the pads can
become burning hot if exposed to ultrasound.

CAUTION   
In training and QA sessions, only sonicate a QA phantom or other absorbing material that is
in good contact with the ultrasound window.
Acoustic energy may be reflected from unsuitable targets and interfaces such as the liquid-
air interface. The reflected energy may damage the transducer in seconds. See also 7.5
Ultrasound protection. Do not sonicate a positioning pad on purpose.

2.2 Contraindications and restrictions

This Profound Medical product should not be used if any of the following contraindications exist or
are thought to exist:

Pregnancy

MR contraindications specified in the MR scanner's Instructions for Use.

For patients who express a desire for future pregnancy, the HIFU treatment should not be
targeted at the endometrium or other parts of uterus where the patient’s clinical situation would
prognosticate an increased risk of inability to conceive, of miscarriages, or of preterm deliveries
because of the treatment.

The patient weighs more than 140 kg (308 lbs).

NOTICE   
If the said evaluation of the patient’s clinical situation by a physician knowledgeable of HIFU
suggests that the foreseeable treatment benefits outweigh the possible risks, the patient should be
informed about the risks and benefits and his or her consent recorded according to the local
practices.

WARNING   
Because the patient may have to lie immobile for several hours during the treatment,
identify the patients with a high risk or a history of deep vein thrombosis or a similar
condition potentially affected by the long immobilization and evaluate the risks and benefits
before the treatment.

NOTICE   
If the physician's evaluation indicates that the patient is in the risk group, the risk and benefits
should be explained to the patient.
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2.3 Heat and Specific Absorption Rate (SAR)

WARNING   
Make sure that sufficient cooling is provided during the treatment and monitor patients with
insufficient cardiac functions.
Failure to do so may result in excessive heating and hyperthermia.

NOTICE   
If the physician's evaluation indicates that the patient is in the elevated risk group, the rationale for
cooling should be explained to the patient.

WARNING   
When the ultrasound transducer is sonicating (emitting acoustic energy), there is a blue
sonication indicator light in the liquid container. Never put body parts into the ultrasound
field as internal tissue heating and damage may occur in seconds.

2.3.1 Specific Absorption Rate (SAR)

Both the MR system and the Sonalleve MR-HIFU system produce thermal energy, which is
absorbed by the patient during treatment. The International/European standard IEC/EN 60601-2-33
Particular Requirements for the Safety of Magnetic Resonance Equipment for Medical Diagnosis
defines limits for the acceptable tissue and body temperature rise caused by the Specific
Absorption Rate (Definition of SAR see: IEEE C.95.1-1999) of radio frequency power per unit mass
of an object. The standard sets limits for the maximum allowed rise of the patient's core
temperature. The MR scanner achieves compliance with these requirements by controlling the
SAR of the MR protocols.
The SAR limits of the MR scanner are defined for conditions with a specific room temperature
24 °C (75.2 °F) and humidity 60% and minimal air flow. In addition, the patient is assumed to be
lightly clothed. The standard uses 6 minutes as the averaging period for determining the SAR for
all tissues. For a detailed description of the SAR operating modes and temperature and humidity
levels, see the MR scanner's Instructions for Use and the standard IEC/EN 60601-2-33.

2.3.2 Specific Energy Dose (SED)

The amount of radio frequency (RF) energy absorbed by the body, per unit mass, is called the
Specific Energy Dose (SED). The SED is determined by the SAR and scan duration. The SED is
expressed in kJ/kg.

NOTICE   
In some MR imaging protocols the total SED can become so high that it limits the use of the
protocol.
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2.3.3 Heat load induced by ultrasound

Also, the ultrasound energy delivered to the patient is ultimately absorbed and transformed to
thermal energy inside the patient.
Total ultrasound energy deposited in the patient is shown to the user in Treatment Cell Planning
page and Replanning tab.

Fig. 1: Total Energy Delivered label and value on Therapy page

The total thermal energy over the course of the treatment can be reduced by:

Using feedback cells instead of regular cells.

Using larger treatment cells.

Short term heat load over the course of a few minutes can be reduced by:

Increasing the cooling interval between sonications.

Using smaller treatment cells.

Note that increasing the cooling interval between sonications increases the total treatment time.

2.3.4 Cooling the patient

WARNING   
Always leave sufficient cooling intervals between sonications.
Failure to do so may cause heat buildup in the near field or far field, leading to skin burn or
other unwanted tissue damage.

The system visualizes temperature changes relative to the start of each sonication, not absolute
temperature. Estimates of heat buildup and predictions of cumulative heating in the near field are
calculated internally and affect cooling times.
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NOTICE   
Refer to 4.6 Temperature monitoring for more information on the temperature measurement
method and to 4.6.4 Cooling time for more information on cooling time.

The Sonalleve MR-HIFU systems include an active Direct Skin Cooling (DISC) device. The
purpose of the device is to facilitate faster tissue cooling by keeping the patient interface at a
constant temperature throughout the treatment. This effect is taken into account when the system
calculates cooling time recommendations. In most cases, active cooling will shorten the system-
recommended cooling times. Thus, using the DISC device may shorten the total treatment time.
The operational status of DISC is displayed in the System Status Display (see 5.10.1 System
Status Display).

2.3.5 Clothing and environmental conditions

Refer to the MR scanner’s Instructions for Use.

WARNING   
The whole body SAR limits are only valid for room temperatures not greater than 24 °C
(75.2 °F) and relative humidity not greater than 60%.

2.4 Contrast agents and medication

If preliminary images with contrast agents are needed, make sure these are obtained well before
the actual treatment as contrast agents cannot be used in the HIFU treatment.

WARNING   
The HIFU treatment may affect the chemical and physiological properties of certain
chemicals used in drugs. Make sure that the patient has been screened for such chemicals
and drugs.

WARNING   
Never administer Gadolinium-based contrast agents to the patient before treatment.
Certain Gadolinium-based compounds (such as contrast agents) may decompose when
sonicated, producing dangerous or poisonous compounds. The exact time period that must
be left between a contrast agent scan and the HIFU treatment cannot be defined as it
depends on the specific drug and the metabolism of the patient.

The following MRI contrast agents are Gadolinium-based and may decompose when sonicated.
This list may not be exhaustive.

Gadobenate (MultiHance®)

Gadobutrol (Gadovist®, Gadavist®)

Gadocoletate

Gadodenterate

Gadodiamide (Omniscan®)

Gadofosveset (Ablavar®, Vasovist®)
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Gadomelitol (Vistarem®)

Gadopenamide

Gadopentetate (Magnevist®)

Gadoterate (Dotarem®)

Gadoteridol (ProHance®)

Gadoversetamide (Optimark™)

Gadoxetate (Eovist®, Primovist®)

2.5 Emergency Stop and Safety Devices

There are three abort mechanisms in the Sonalleve MR-HIFU system:

Patient Emergency Stop Button (PESB) for the patient.

A Stop button in the Safety Device for the user.

An abort button in the user interface.

WARNING   
Use the Safety Device Stop button or PESB immediately in a hazardous situation. Use the
software abort button to stop the sonication in situations that do not present any hazard (if,
for example, the treatment is deemed sufficient before the planned treatment time is
reached).

2.5.1 Patient Emergency Stop Button (PESB)

The patient can stop the treatment at any point by pressing the Patient Emergency Stop Button
(PESB). Pressing the PESB terminates the sonication immediately, although scanning of the
temperature maps continues. As the patient presses the button, an indicator light is switched on in
the device, there is a beep sound in the MR room and in the operator's Safety Device, and the
Sonalleve Console displays an error. Always instruct the patient about the correct usage of the
PESB prior to the start of the treatment. If the patient has stopped the treatment because of pain,
analyze the cause of pain before continuing the treatment.
When the patient presses the PESB, the red indicator light in the Safety Device is switched on. No
further sonications are possible, before the user presses the green Enable button in the Safety
Device.
During pre-treatment scanning, and when sonication is not on, the PESB functions like the MR
nurse call button: it gives an audio signal but does not stop scanning.

WARNING   
Do not use the standard MR Nurse Call button with the Sonalleve MR-HIFU system. Use the
Patient Emergency Stop Button (PESB) instead.
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NOTICE   
Instruct the patient on how and when to use the patient emergency stop button (PESB). Such
situations include:

Sudden pain during the procedure.

Skin heating.

Numbness in legs or other body parts.

Nausea.

Cardiac symptoms.

2.5.2 Safety Device (SD)

The operator can terminate the treatment at any point using the Safety Device. Use the Safety
Device to stop the treatment if you detect a hazardous situation as an undesired heating pattern, or
a malfunction in the equipment. The Safety Device provides the following functions:

Audio signal to indicate that:

the patient has pressed the PESB, or
the PESB has been disconnected.

Sonication ON audible indicator – An audible beeping sound is emitted from the Safety Device
when the ultrasound transducer is emitting acoustic energy. A sound level switch is located
underneath the device.

Green Enable button – Pressing this button enables the ultrasound electronics. Sonication is
only possible when the button is lit. The green light will blink during sonication.

Red Stop button – The Stop button is lit when the ultrasound electronics are disabled and
sonication is not possible. The Stop button can be used at any time to disable ultrasound
electronics and to suppress the audio signal.

Fig. 2: The Safety Device.

-
-
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2.5.3 Software Abort Sonication button

The Sonalleve MR-HIFU user interface provides a software Abort Sonication button for
terminating the sonication. Use the software Abort Sonication button in non-hazardous situations,
for example if the target temperature is reached in the tissue before the planned treatment time is
over.

2.6 Emergency procedures

The emergency procedures described in the chapter "Safety" in the MR scanner’s Instructions for
Use apply also to Sonalleve MR-HIFU.
In a hazardous situation, terminate the HIFU treatment using the red Stop button on the Safety
Device and remove the patient from the table and the examination room.

2.7 Magnetic safety

All the equipment used in the examination room must be MR compatible. Never bring any metal
objects in the examination room.
Carefully read the warnings and follow the instructions in the MR scanner’s Instructions for Use.
The Sonalleve MR-HIFU Patient Table is MR Conditional. A patient on this table can be safely
scanned under the following conditions:

Static magnetic field of 1.5 T and 3.0 T

Maximum spatial field gradient of up to 4.500 gauss/cm (45 T/m) 

Maximum allowable patient weight of up to 140 kg (308 pounds)

MRI scans should be conducted using the Receive-only HIFU Coils provided with the Sonalleve
System. For more on the conditions of safe use of the HIFU Coils, please refer to labeling on the
coils.

2.8 Mechanical and electrical safety

Before using the Sonalleve MR-HIFU hardware components, visually check them to ensure that
they are undamaged. Especially, inspect all the wires, hoses, connectors and sockets. Patient or
operator injury could occur if these instructions are not properly followed.
Use this product in rooms or areas that comply with all applicable laws (or regulations having the
force of law) concerning electrical safety for this type of product.
For additional safety instructions, refer to the MR scanner’s Instructions for Use.

2 Safety > 2.6 Emergency procedures

Instructions for Use  
109011C / 2025-12

22 (206)



WARNING   
Do not remove covers or cables from this product unless expressly instructed to do so in
this Instructions for Use. Dangerous electrical voltages are present within this product.
Removing covers or cables could lead to serious or fatal personal injury.

WARNING   
Avoid touching the patient or objects connected to the patient during the procedure.
Touching increases the risk of exposure to potentially hazardous leakage currents.

NOTICE   
If there are other persons such as a support person of the patient in the RF room during therapy,
the rationale should be explained to the patient and to the additional persons.

WARNING   
To avoid risk of electric shock, this equipment must only be connected to a mains supply
with a protective earth.

2.9 Protecting the equipment against liquids

The HIFU treatment requires an acoustic contact liquid to be used between the gel pad and the
patient and on the membrane. Use disposable sheets to absorb any spilled liquid.
Do not allow liquids to enter any other part of the Sonalleve MR-HIFU equipment. Before each
treatment, visually check that the Sonalleve Patient Table is not leaking.

WARNING   
Daily inspect the Sonalleve MR-HIFU system and the magnet for leaks. The Sonalleve
Patient Table houses a liquid container. Do not connect the Sonalleve System Cables if you
find a leak. If a leak occurs during treatment:

  
• Terminate the sonication immediately using the Stop button of the Safety Device.

 • Remove the patient from the Patient Table.
 • Identify the reason for the leak.

 • To prevent further damage, remove the leaking part from the RF room.
 • Do not continue scanning or treatment until a qualified service engineer or equivalent has

examined the scanner and the Sonalleve MR-HIFU system.
  

A failure to follow these instructions may expose the patient or an operator to a risk of an
electric shock.
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2.10 Chemical safety

The ultrasound transducer inside the Sonalleve Patient Table is immersed in liquid. The liquid
inside the Patient Table is in a sealed container and does not come in contact with operators or
patients in normal operation of the system. For information on how to safely handle the liquid in the
event of a leak, refer to the Material Safety Data Sheet supplied with the system.

WARNING   
Usage of a damaged QA Phantom is not allowed.

 The Sonalleve QA Phantom, model 4510 000 82232, contains residues of acrylamide (CAS
nr.: 79-06-1) in a hermetically sealed container. If the container is damaged or the contents
come out of the container, dispose of the phantom and the liquids that have been in contact
with the exposed contents. Use nitrile rubber gloves when disposing of the material and the
liquids. Follow the disposal instructions.
Failure to follow this instruction may expose the operator, other personnel and patients to
poisonous chemicals and result in damage to the environment.

The Sonalleve QA Phantom, model 4510 000 82232, is classified as hazardous waste based on
the classification and the concentration of acrylamide used in its filling mixture.
The QA Phantom must be disposed of according to the instructions laid out for hazardous waste
handling. See 9.5 Disposal of the Sonalleve QA Phantom.

2.11 Explosion safety

WARNING   
• Do not use this product in the presence of explosive gases or vapors, such as certain
anesthetic gases.

 • Do not use flammable or potentially explosive disinfecting sprays.
 • Use of this product in an environment for which it was not designed can lead to fire or

explosion.

2.12 Fire safety

The use of an electrical product in an environment for which it was not designed can lead to fire or
explosion.
Fire regulations for the type of medical area being used should be fully applied, observed and
enforced. Fire extinguishers should be available for both electrical and non-electrical fires.
If it is safe to do so, attempt to isolate the product from electrical and other supplies before
attempting to fight a fire. This will reduce the risk of electric shocks.
For further information on fire safety and MR compatible fire extinguishers, refer to the MR
scanner’s Instructions for Use.

WARNING   
On electrical or chemical fires, only use extinguishers that are specifically labeled for those
purposes.
Using water or other liquids on an electrical fire can lead to fatal or other serious personal
injury.
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2.13 Battery safety

HP Z4G4 workstation is equipped with a battery type described below:

Battery type Manufacturer Size Specifications

Lithium Manganese
Dioxide Battery

Varta CR 2032 3 V, 210 mAh
20 mm x 3.2 mm
Primary (not
rechargeable)

 The battery that comes with the computer provides power to the real-time clock and has a
minimum lifetime of about three years.
The battery is intended to be changed only by Service Personnel.

WARNING   
HP Z4G4 workstations use lithium batteries.
Replacement by inadequately trained personnel could result in a HAZARD, such as
excessive temperatures, fire, explosion or chemical burn.

2.14 Electromagnetic compatibility (EMC)

The Sonalleve MR-HIFU system needs special precautions regarding EMC and needs to be
installed and put into service according to the EMC information provided in the accompanying
documents (Technical Description). Portable and mobile RF communications equipment can affect
the Sonalleve MR-HIFU system.
The Sonalleve system Patient Table must be used only in a shielded location with a minimum of
-80dB RF shielding effectiveness.

WARNING   
Use of this equipment adjacent to or stacked with other equipment should be avoided
because it could result in improper operation. If such use is necessary, this equipment and
the other equipment should be observed to verify that they are operating normally.

Sonalleve MR-HIFU system is tested against EMC standard for Medical electrical equipment.
Still under extreme conditions other equipment may negatively affect the performance of the
Sonalleve system. The system is continuously monitoring its main functions and in case of failure in
these functions the system will stop the operation to keep the system safe in all conditions.

2.15 Network safety, data security and privacy

The Sonalleve MR-HIFU system is protected against unauthorized access by a firewall and strong
passwords. In addition, the customer must have a comprehensive security strategy addressing
external and internal threats. For more information, refer to the Technical Description.
For safety reasons, the Sonalleve MR-HIFU system is isolated from the hospital network during the
Therapy stage.
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For unauthorized users who have physical access to the system, it is relatively easy to circumvent
access controls implemented in software, even those enforced by the operating system. You need
to implement physical safeguards for all workstations that access electronic protected health
information, to restrict access to authorized users.
To ensure the safe operation of the system and the confidentiality of patient data, operators
working with the Sonalleve console must observe the following rules:

CAUTION   
To protect your Sonalleve MR-HIFU system against viruses, malware and unauthorized
access:

Never use the Sonalleve console for browsing intranets or the Internet.

Never download or install any unauthorized software, including Windows security
updates and virus scanner updates.

Use only blank DVDs for data archiving and transfer.

Never use any unauthorized removable media, such as USB flash drives or external USB
hard drives.

Never alter any Windows settings.

Always keep your Sonalleve console password (Windows user account password)
confidential. Never disable password protection.

Log off from the Sonalleve console (from the Windows user account) each time the
system is not used for therapy.

CAUTION   
To protect the confidentiality of patient data:

Never enter any personal data (of patients, operators, physicians, etc.) in data fields that
are not specifically intended for such data. Personal data entered in other, unexpected
places, such as comment fields, scan names, file or folder names, etc., can become
disclosed even when you take protective measures (such as using the Export De-
identified tool).

The system does not automatically clear the screen, which may contain patient data. To prevent
unauthorized personnel from casually or deliberately viewing patient data, do not leave the system
unattended during therapy. To protect the confidentiality of patient data, position displays to face
away from doorways, hallways, and other public areas.
You can temporarily blank the screen of the Sonalleve console to keep patient data confidential
from onlookers.

To blank the screen and lock the console, press the L key while keeping the Windows key
pressed.

To unlock the console, press any key, then enter the password of the Windows user account.

WARNING   
Never blank the screen or lock the device during therapy.
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1. 
2. 
3. 

Patient safety requires that the user can view the screen of the Sonalleve console any time during
the therapy. For the same reason the system does not automatically blank or lock the screen
during therapy, even when the user does not use the Sonalleve console for a while.
The intended use of the system prohibits automatic logoff during therapy. At the default level of
user access, automatic logoff takes place on exit from the Sonalleve application.
To log off when operating the system as a power user (see 10.7.1 About accounts):

Exit the Sonalleve application, if it is running.
Simultaneously press the Ctrl, Alt and Delete keys.
Select Sign out.

2.15.1 Malware detection

The Sonalleve console is equipped with antivirus software that is designed to detect viruses on
your system and to deny access to infected files before the files can damage your system.
Profound Medical makes available Sonalleve security updates that contain security-related updates
to the Windows operating system and to the anti-virus software. The security updates are validated
by Profound Medical and must be controlled for this product. The updates are distributed by the
Profound Medical service organization. Remote installation of security updates is not supported
because it could involve risk to patient safety.
If the antivirus software has detected malware infection, do not use automatic repair utilities
because the integrity of the repaired software cannot be guaranteed. Contact the Profound Medical
service organization to assess and repair the system. You should adhere to local malware policies,
which may include disconnecting from the network until the situation is resolved.

2.16 Reporting of incidents

Any accident and/or injury to a patient, operator, or maintenance personnel that has occurred while
using the equipment should be reported to Profound Medical. Please contact your local Profound
Medical representative.
Any serious incident that has occurred in relation to the device should be reported to Profound
Medical and the competent authority of the Member State in which the user is established.

2.17 Safety improvements

Safety improvements to the equipment must be installed only by Profound Medical personnel.
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2.18 Symbols and labels on the equipment

Symbols that appear on Sonalleve MR-HIFU equipment are listed in the following table. Refer to
the MR scanner’s Instructions for Use for a complete list of symbols on the MR system.
The system label of the Sonalleve MR-HIFU system is located on the side of the Sonalleve Patient
Table.

Tab. 4: Symbols on the equipment.

Symbol Location Meaning

The front end of
the trolley of the
Sonalleve
Patient Table

Warning: crushing hazard: hands
Your fingers may get crushed if caught between the Table
Top and the spacer when pulling the Table Top back from
the imaging position.

Next to the
System label

The
Sonalleve QA
phantom

DISCfill tool

Follow instructions for use

You must read the Instructions for Use before using the
Sonalleve MR-HIFU system.

You must read the Instructions for Use and/or a
separately supplied Instructions for Use of the QA
phantom before using the QA phantom.

Sonalleve
Generator
Cabinet, DC
voltage
supply switch

Safety Device
Stop button

OFF

Indicates the OFF state of a switch.

On the Safety Device, indicates that the button is used
to stop sonication.

Sonalleve
Generator
Cabinet, DC
voltage supply
switch

ON
Indicates the ON state of a switch.

Safety Device
Enable button

ON/Enable
Indicates that the button is used to toggle between the
enabled and standby states of the ultrasound generators.
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On the frame
beside the brake
pedal of the
trolley

The movement of the trolley is locked when the marked
end of the brake pedal is pressed.

On the frame
beside the brake
pedal of the
trolley

The movement of the trolley is released when the brake
pedal is in the middle position.

On the frame
beside the brake
pedal of the
trolley

The movement of the trolley is released but the direction of
the center wheel is locked when the marked end of the
brake pedal is pressed.

Sonalleve
Generator
Cabinet

Protective earth
Indicates the terminal for protective earth (ground)
electrode.

Sonalleve
Generator
Cabinet product
label on the roof
of the generator
cabinet

Three-phase alternating current
The generator cabinet requires three-phase alternating
current.

HIFU Coil
product label

Patient
Emergency
Stop Button
(PESB)

Table
Top connector
panel on the
side of the
Sonalleve
Patient Table

Type BF Applied Part
Regarding protection against electrical shock, the parts of
the Sonalleve Patient Table, the HIFU Coil and the PESB
that come into physical contact with the patient in normal
use are classified as Type BF (Body Floating) Applied Parts
as defined in the standard IEC 60601-1.

HIFU Coil MR Conditional
Indicates an item with demonstrated safety in the MR
environment within defined conditions.
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Product labels Indicates that the medical device or other item is only for
use with a 1.5 T MR scanner.

Product labels Indicates that the medical device or other item is only for
use with a 3 T MR scanner.

System label

Patient Table

Generator
Cabinet label
on the roof of
the cabinet

DISCFILL tool

Indicates the manufacturer of the medical device or other
item.

System label

QA phantom

Planning
console

Patient Table

Generator
Cabinet label
on the roof of
the cabinet

DISCFILL tool

Filter Panel

Patient trolley

Date of manufacture
Indicates the date when the medical device or other item
was manufactured.

System label Indicates the country of manufacture of the medical
device or other item.
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System label

QA phantom

Planning
console

Patient Table

Generator
Cabinet label
on the roof of
the cabinet

DISCFILL tool

Filter Panel

Patient trolley

Indicates the manufacturer's catalogue number for the
medical device or other item.

System label

QA phantom

Planning
console

Patient Table

Generator
Cabinet label
on the roof of
the cabinet

DISCFILL tool

Filter Panel

Patient trolley

Indicates the manufacturer's serial number for the specific
medical device.

Packages of
gel pads

Packages of
QuickCover
Ultrasound
Protective
Covers

Indicates the production batch code or lot number of the
item.

System label Indicates the Unique Device Identifier information.

System label Indicates that the item is a medical device.
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Packages of
gel pads

Packages of
QuickCover
Ultrasound
Protective
Covers

Use by date
Indicates the date after which the item is not to be used.

Packages of
gel pads

Packages of
QuickCover
Ultrasound
Protective
Covers

Do not re-use
Indicates a single use item intended for a single procedure
or patient.

Packages of
gel pads

Packages of
QuickCover
Ultrasound
Protective
Covers

System label

Consult instructions for use

System package
labels

Fragile, handle with care
Indicates a medical device that can be broken or damaged
if not handled carefully.

System package
labels

Keep dry
Indicates a medical device that needs to be protected from
moisture.

System package
labels

Temperature limit
Indicates the temperature limits to which the medical device
can be safely exposed. The upper and lower limits of
temperature are indicated adjacent to the upper and lower
horizontal lines.
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System package
labels

Humidity limitation
Indicates the range of humidity to which the medical device
can be safely exposed. The upper and lower limits of
humidity are indicated adjacent to the upper and lower
horizontal lines.

System package
labels

Atmospheric pressure limitation
Indicates the range of atmospheric pressure to which the
medical device can be safely exposed.

The
Sonalleve QA
phantom

System
packages

This way up
Indicates the correct upright orientation of the QA phantom.
Keep the phantom so that the arrows point upwards.

Next to the
system label
on the side of
the Sonalleve
Patient Table

DISCfill

Indicates that the device is to be disposed of according to
local regulations. In the European Union the device is to be
handled as Waste Electrical and Electronic Equipment
(WEEE).
See 9 Product disposal.

Packages of
gel pads

Packages of
QuickCover
Ultrasound
Protective
Covers

The manufacturer of the item declares that the item
conforms to the applicable European Union directives.

System label The manufacturer of the medical device declares that the
medical device conforms to the European Medical Device
Directive 93/42 EEC. The number identifies the Notified
Body that has been involved in the conformity assessment
procedure.

System label

Generator
Cabinet label
on the roof of
the cabinet

Packages of
gel pads

Authorized Representative in the European Community

System label In the United States of America:
CAUTION: Federal law restricts this device to sale by or on
the order of a physician
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Next to the
system label on
the side of the
Sonalleve
Patient Table

Marking for the restricted use of hazardous substances in
electronic and electrical products as defined in the Chinese
standard SJ/T 11364—2014.

Next to the
system label

Label indicating the total mass of the Patient Table
including safe working load.
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3 System overview
The Sonalleve MR-HIFU system is designed to be used with Philips MR scanners (see 1.1 About
Sonalleve MR-HIFU).
The Sonalleve Patient Table can be easily removed to enable normal, diagnostic use of the MR
scanner.

3.1 Main system components

The Sonalleve MR-HIFU system consists of the following main components:

Sonalleve Patient Table assembly.

Sonalleve Generator Cabinet.

Sonalleve Console.

Fig. 3: Sonalleve Patient Table docked to the scanner.
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Fig. 4: Patient step and accessory cart (optional).

Cables for the Sonalleve MR-HIFU system enter the examination room through a dedicated HIFU
Filter Panel on the examination room wall. When the Sonalleve MR-HIFU system is not in use, the
cables are disconnected and stored in the accessory cart, if available.

3.1.1 Patient Table assembly

Fig. 5: The Sonalleve Patient Table.
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The Sonalleve Table Top is brought in and out of the examination room on a dedicated trolley.
When docked, the Sonalleve Table Top lies somewhat higher than the standard tabletop and
protrudes more at the back of the magnet.
The Sonalleve Patient Table includes:

Ultrasound transducer.

Positioning mechanics.

Table Top connector panel.

HIFU Coil.

Patient Emergency Stop Button (PESB).

Pads, mattresses and straps for patient positioning.

Direct Skin Cooling (DISC) device.

Direct Skin Cooling (DISC) device

The Direct Skin Cooling (DISC) device cools down the skin of the patient during HIFU treatment by 
circulating cooled water inside the DISC patient contact. The device keeps the water temperature 
at a configured target value.
Water circulation behavior differs depending on the software release. The following describes 
functionality for R3.7 up to L3 and for R3.7 L4 and newer.
For software versions from R3.7 up to L3, water circulation in the DISC starts when the Sonalleve 
Application is in the Therapy mode and a remotely controllable scan, such as 
TemperatureMapping, is started on the MR scanner (the message "Under Remote Control" is 
shown on the MR scanner console).Water circulation stops when remote control ends. Water 
circulates during sonications but may be automatically switched off when scanning other protocols.
Starting with R3.7 L4 and newer, water circulation in the DISC starts when the Sonalleve 
Application is in Therapy mode. The user is provided with the option to manually enable or disable 
water circulation. Prior to the initiation of sonication, water circulation is expected to be activated by 
user, if it has been manually deactivated.
The Sonalleve MR-HIFU systems are delivered with the DISC installed. The DISC can also be 
installed as an upgrade.
To see if a Sonalleve Patient Table is equipped with the DISC, look for a pair of connectors for the 
DISC hoses as shown in the following figures.

When the DISC is pre-installed at the factory, the hose connectors are located in the Table Top
connector panel.

When the DISC is installed as an upgrade, the hose connectors are located in the accessory
box at the front end of the Patient Table.
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Fig. 6: When DISC is pre-installed at the factory, the hose connectors are
located in the Table Top connector panel.

Fig. 7: When DISC is installed as an upgrade, the hose connectors are
located in the accessory box at the front end of the Patient Table.

The operational status of DISC is displayed in the System Status Display (see 5.10.1 System
Status Display).
For sufficient cooling of the patient's skin, DISC must be filled with water and water circulation in
DISC must be ensured. Water slowly evaporates from DISC. If there is not enough water
between the two membranes of DISC, the cooling effect is insufficient, which can lead to skin
burns.
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Brake pedal

Fig. 8: The brake pedal of the trolley of the Sonalleve Patient Table.

The symbols on the frame of the trolley beside the brake pedal indicate the brake function as
follows:

Tab. 5: Brake function symbols.

Symbol Function

LOCKED

LEFT side of brake pedal pressed

All the four outer wheels are locked (brakes on)

FREE

Brake pedal in CENTER position

All the five wheels are free (brakes off)
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SWIVEL

RIGHT side of brake pedal pressed

All the five wheels are free (brakes off)

The direction of the center wheel is locked, which makes it
easier to turn the trolley

Table Top release

To release the Table Top when pushing the Table Top into the magnet and when pulling the Table
Top back out, lift either of the two Table Top release handles located on both sides of the Patient
Table (see the figure below).

NOTICE   
In addition to the two Table Top release handles located on both sides of the Table Top, there is an
emergency Table Top release button located in the accessory box (see the figure below). If a
detachable handle has been installed to the Table Top, the emergency Table Top release handle is
on the side of the accessory box.

Fig. 9: Left: Table Top release handle. Middle: The emergency Table Top
release button located in the accessory box. Right: The emergency Table
Top release handle located on the side of the accessory box.
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3.1.2 Sonalleve Console

The Sonalleve Console is used for transferring the planning images from the MR scanner, planning
of the sonication treatment, and the actual therapy sonication. The Sonalleve Console is located in
the control room, with direct visibility to the examination room. A monitor and safety device are
included with the Sonalleve Console.

Fig. 10: Sonalleve Console Operator's workstation. At left, the MR scanner
console; at right, the Sonalleve Console.

Fig. 11: The Safety Device.

3.1.3 Sonalleve Generator Cabinet

The Sonalleve MR-HIFU system requires a separate cabinet for power distribution and the
electronics. The Sonalleve Generator Cabinet is located in the technical room. The main power
switch for the Sonalleve MR-HIFU system is located in the power distribution unit (PDU) in the
Sonalleve Generator Cabinet.

3.2 Positioning aids

The following positioning aids are provided with the Sonalleve MR-HIFU system:

Patient Table mattress set.

Vacuum cushion.

MR-compatible air pump.

Foot rest.

HIFU Coil pad and strap.

Various types of pads for patient comfort.

3 System overview > 3.2 Positioning aids

Instructions for Use  
109011C / 2025-12

41 (206)



Disposable (single use) gel pads for the ultrasound window.

Gel pad holder, to prevent the gel pad from slipping horizontally.

IV Stand (optional).

Headphones.

Table Top Plate.

Ultrasound Window Cover.

Table Top Extension Plate (only in Bone application).

NOTICE   
The vacuum cushion provided with the Sonalleve MR-HIFU system is only intended for use in MR-
HIFU, not in diagnostic clinical imaging.

To order additional consumables (such as gel pads) or replacements for positioning aids that are
provided with the Sonalleve MR-HIFU system, contact your local Profound Medical representative. 
The hospital must provide the following items required in HIFU treatment:

Depilation equipment.

IV tubes.

Foley catheter, urine bag with a 2 m extension hose.

Ear plugs.

Patient sheet or blanket.

Thermometer. The accuracy of electronic rectal thermometers is usually better than ±0.2 °C,
which is sufficient for this purpose. Oral or ear thermometers are often less reliable and are
therefore not recommended.

Disposable absorbing sheets for use under the mattress and under the patient.

Compression stockings to reduce the risk of blood clots and Deep Vein Thrombosis (DVT) due
to prolonged immobilization of the patient are optional but highly recommended.

Degassed acoustic contact liquid (see below).

3.2.1 Acoustic contact liquid

Pure water or a mixture of ultrasound gel and water is used as a coupling medium to close any air
gaps between the patient contact and the patient.
The water in the acoustic contact liquid used in MR-HIFU treatments must meet the following
requirements:

Pure water, preferably distilled.

Hard water (with high mineral content) should be avoided.

Microbiologically clean.

Contains no chemicals or particles that can cause degradation of the MR signal, susceptibility
effects or localized heating of skin or the inner margin of the subcutaneous fat layer in the MR
scanner's RF field or in the ultrasound field.
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As air bubbles in the ultrasound beam path may cause undesirable effects, such as reflections or
local heating, the acoustic contact liquid must be degassed before use to prevent bubble formation.
The amount of dissolved oxygen must be below 4 mg/l (ppm, parts per million).
See 7.4 Making degassed acoustic contact liquid for instructions for preparing degassed water or
water-ultrasound gel mixture.

NOTICE   
A specially designed EasyWater Degasser is available from the manufacturer for producing
degassed water. For a description, see EasyWater Degasser Instructions for Use.

Fig. 12: EasyWater Degasser.

3.3 Other tools

The following tools used in the Sonalleve MR-HIFU system quality assurance are provided with the
system:

Ultrasound window cover.

Sonalleve QA phantom.

QA phantom plate.

SPT (System Performance Testing) phantom holder.

DISCfill tool

NOTICE   
The SPT phantom is a part of the MR system and not provided with the Sonalleve MR-HIFU
system.

If you need replacements for tools, contact your local Profound Medical representative.
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3.3.1 The DISCfill tool

The DISCfill tool is provided for the possible need to refill DISC between planned maintenance.
DISCfill is a container, from which DISC can be filled. There is an indicator on DISCfill for when a
refill of DISC is required.
Always use DISCfill before a HIFU treatment to check the water level in DISC and refill DISC
if the water level is too low.
For connecting DISCfill to DISC, a filling hose is supplied with DISCfill. There is a hose connector
at both ends of the filling hose. There is also a draining hose, with one end open.

Fig. 13: DISCfill (1), The filling hose (2), The draining hose (3)

3.4 Technical specifications

Tab. 6: Key treatment-related technical specifications for the Sonalleve MR-HIFU system.

Feature Specification

Temperature measurement update
interval

3.5 seconds or less

Temperature change measurement
accuracy

±5 °C or better, relative accuracy (standard deviation) is
±1 °C or better

Treatment point positioning
accuracy

3 mm or better
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3.4.1 Ultrasound field distributions

The ultrasound field distribution was characterized by performing hydrophone measurements with
a Sonalleve system at the nominal focus with 20W acoustic power. Hydrophone needle was moved
in order to measure pressures in both coronal and axial planes. Y-axis is parallel to the beam axis.
Typical values for the dimensions of the focal spot are shown in the table below. Typical temporal-
average intensities are shown in figures below.

Frequency (MHz) 6dB x-axis (mm) 6dB y-axis (mm) 6dB z-axis (mm)

0.85 2.3 17.5 2.3

1.0 1.9 14.7 1.9

1.2 1.6 12.3 1.6

1.45 1.3 10.0 1.3

Fig. 14: Typical temporal-average intensities ITA (x=0, y, z=0) at 0.85 MHz
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Fig. 15: Typical temporal-average intensities ITA (x=0, y, z=0) at 1.0 MHz

Fig. 16: Typical temporal-average intensities ITA (x=0, y, z=0) at 1.2 MHz
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Fig. 17: Typical temporal-average intensities ITA (x=0, y, z=0) at 1.45 MHz

Beam width at focus or beam width at beam maximum W6m is the greatest distance between two
points on a specified axis, perpendicular to the beam axis and ZSPTA where the pulse-pressure-
squared integral falls 6 dB below its maximum on the specified axis.
Distance ZSPTA is the distance along the beam axis between the plane containing the spatial-peak
temporal-average intensity and the transducer output face.
Focal depth or beam maximum depth L6 is the greatest distance between two points on the beam
axis, where the pulse-pressure-squared integral falls 6 dB below its maximum on the beam axis.
In Sonalleve system, the beam width, beam area at focus and focal depth vary according to the
ultrasound frequency.

Frequency
(MHz)

Beam width at focus
(mm)

Focal depth
(mm)

–6 dB beam area Ab6 at Z =
ZSPTA (mm2)

0.85 2.3 17.5 2.3

1.0 1.9 14.7 1.9

1.2 1.6 12.3 1.6

1.45 1.3 10.0 1.3
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Fig. 18: Beam width at focus or beam width at beam maximum W
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4 Treatment methods
This chapter explains the terms and concepts necessary for understanding the Sonalleve MR-HIFU
treatment workflow.

4.1 Basic concepts

In High Intensity Focused Ultrasound (HIFU) treatment, an ultrasound beam is focused on a small
volume within the target tissue. This is called a sonication, and it causes the temperature to rise
which coagulates the tissue. With this technique, unwanted tissue can be destroyed without
invasive surgery.
MR-guided HIFU (MR-HIFU) treatment, also known as MR-guided focused ultrasound therapy
(MRgFUS), is based on monitoring the relative temperature change during the sonication treatment
using MRI.

Fig. 19: The basic principles of HIFU: MR scanner (1), MR coil (2), Uterus
(3), Fibroid (4), Focused ultrasound waves (5)

The MR images are used to calculate relative temperature maps, which are monitored on the
Sonalleve console. These temperature maps are used to visualize the progress of the treatment,
and they also can be used to control the duration of the sonication. The following table explains the
basic terms and concepts that you need to be familiar with when working with the Sonalleve MR-
HIFU system.

Tab. 7: Sonalleve MR-HIFU key terms and definitions.

Term Definition

Autopopulation Automated treatment cell planning. The action of automatically filling a
defined region with treatment cells.

Available
Target Area
(ATA)

The area which is within reach of the ultrasound beam and within which
treatment cells can be positioned.
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Beam Shaping A Sonalleve software feature that allows the user to selectively limit the
maximum acoustic intensity in a part of the transducer beam that goes
through a sensitive organ.

Cavitation Interaction between ultrasound and microbubbles in water or within tissue,
which may affect the treatment outcome at high ultrasound power densities.

Cooling time The minimum time required for the patient to cool down in between
sonications. Cooling is necessary to prevent tissue burns in the near field.

Direct Skin
Cooling
(DISC) device

A device used to cool down the skin of the patient during HIFU treatment.
See 3.1.1.1 Direct Skin Cooling (DISC) device.

Far field The volume through which the acoustic waves traverse after the treatment
cell.

Far-field safety
margin

The far-field safety margin visualizes the advised minimum distance of a
treatment cell from sensitive tissues in the far field. It is displayed as the
depth wise limit up to which the far field extends.

Feedback cell A treatment cell for which the required sonication time is calculated based
on the temperature rise in the treatment cell.

Misregistration The distance between the observed heating and the planned treatment cell
center.

Misregistration
correction

Correction for the misregistration.
The correction is applied to all the treatment cells in a treatment cell cluster.

Monitor slices The slices used in temperature monitoring during the sonication stage.

Near field The volume through which the ultrasound beam traverses towards the
treatment cell.

Organ
avoidance
region (OAR)

A region of interest (ROI) that the user uses to mark a sensitive organ for
Beam Shaping.

Planning
images

The images scanned and used for therapy planning. The planning images
are scanned on the MR console and transferred to the Sonalleve console.

Planning
safety margin

The distance that must be left between treatment cells and areas in which
heating should be avoided.

Planning
Target Volume
(PTV)

The volume used for planning the sonication. The PTV is defined by drawing
it on the planning images. Treatment cells are placed within the PTV.

Preparing
electronics

A hardware initialization procedure of the transducer electronics. Electrically
matches the transducer driving electronics to the transducer channels.

Region of
Interest (ROI)

An area or volume for a specific purpose that can be graphically defined by
the user, or automatically by the software.

Registration A Sonalleve software feature that lets the user to indicate how the patient
has moved during the treatment. Registration defines a spatial offset
between image sets.
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1. 

2. 

Sonication An event during which the transducer is emitting ultrasound energy at a
treatment cell.

Temperature
curve

A plot of the temperature in a selected part of the heated region as a
function of time.

Temperature
map

A colored overlay on top of an anatomical image showing the temperature
rise in the tissue.

Test sonication A procedure in which low power is directed at a treatment cell to verify that
heating occurs in the correct location.

Therapy The activity targeting the delivery of energy to the patient for therapeutic
purpose. Therapy is a subset of a treatment. In the therapy stage of
treatment the user executes and performs sonications on the Sonalleve
console.

Thermal dose A measure of the effect of heating on the tissue.

Thermal dose
contours

Contours overlaid on top of an anatomical image showing the thermal dose
of the tissue as isodose contours.

Thermal dose
map

A colored overlay on top of an anatomical image showing the thermal dose
of the tissue.

Tissue
boundary

User defined tissue boundary between the skin and fat-muscle boundary in
the Uterine application.

Total
Treatment
Volume (TTV)

The total volume of the treatment cells in all Planning Target Volumes to be
treated during a single therapy session.

Trajectory The path formed by successive treatment points during sonication.

Transducer
beam

The volume through which the acoustic waves travel from the transducer.
Also called the ultrasound beam path.

Transducer
beam
centerline

A line from the center of the transducer aperture to the treatment point.

Transducer
homing

A hardware initialization procedure for bringing the transducer to its center
(home) position.

Treatment The whole procedure involving the patient care and the use of the
Sonalleve MR-HIFU System for therapy and pre and post-therapy activities.

Within the context of the Sonalleve console: The entire process required
to treat the patient including the planning, preparation, therapy and reporting
stages.

Treatment cell A small volume of tissue which is planned to be destroyed as a result of a
single sonication.

Treatment cell
cluster

A group of treatment cells in the same treatment plane.
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Treatment cell
safety margin

Lines displayed around a treatment cell to visualize its advised minimum
distance from sensitive tissues.

Treatment
plane

The plane on which the treatment cells in a cluster are located. The center of
each treatment cell is in this plane.

Treatment
point

The point where ultrasound heating is centered at a specific moment of time.

Ultrasound
beam path

The volume through which the acoustic waves travel from the transducer.
Also called the transducer beam.

4.2 Patient selection

Patients with any of the following conditions are not suitable for treatment with the Sonalleve MR-
HIFU system:

MRI contrast agent contraindications.

Pregnancy or positive pregnancy test.

Scars that cannot be protected or surgical clips, implants, or prosthesis in the planned path of
the ultrasound beam (for more information on protection methods, see 6.6.7 Beam shaping).

Calcifications around the periphery of the fibroid or within the fibroid in the Uterine application.

Calcifications around or within the adenomyosis in the Uterine application.

The patient weighs more than 140 kg (308 lbs).

NOTICE   
If a patient has a history of liposuction, they may have scars in the abdomen that are not visible
outside. In such cases, the patient’s eligibility for treatment must be assessed clinically by a
medical professional.

NOTICE   
General or local clinical protocols may present patient selection and exclusion criteria differing
from, and overriding the criteria listed above. Always consult the relevant protocols when making
decisions related to patient selection.

4.3 Treatment cell types and clusters

A treatment cell is the tissue volume to be destroyed within a Planning Target Volume during a
single sonication. There are two types of treatment cells:

Regular cells: sonication time is normally constant. In the Uterine application, sonication time
may be adjustable for small regular cells.

Feedback cells: required sonication time is calculated based on the temperature rise in the
treatment cell. Feedback cells are only available in the Uterine application.

In the Uterine application, regular cells and feedback cells can be 4, 8, 12, 14, or 16 mm in size. In
the Bone application, regular cells can be 2, 4, 8, 12, 14 or 16 mm in size.
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The size of treatment cell can be selected in the user interface. The optimal treatment cell size
depends on the Planning Target Volume. As a general rule, you should use the largest treatment
cells possible. Larger treatment cells cover the volume better and shorten the treatment time since
fewer cooling intervals are required.
The following table presents the treatment times for the regular cells according to cell size.

Tab. 8: Treatment times for different regular treatment cell sizes.

Cell size (mm) Application Approximate treatment time (seconds)

2 Bone 16

4 Uterine, Bone 16

8 Uterine, Bone 20

12 Uterine, Bone 36

14 Uterine, Bone 45

16 Uterine, Bone 56

Ablation of adenomyosis tissue may require higher power levels and longer sonication times
compared to the ablation of uterine fibroid tissue.
The maximum treatment time for feedback cells is 20 seconds longer than for the corresponding
regular cell. If the maximum treatment time of the feedback cell is reached, the system aborts
sonication.
A treatment cell cluster is a group of treatment cells on the same treatment plane, typically located
next to each other. You can define multiple treatment cell clusters on the same treatment plane. In
the Bone application the Sonalleve application treats all the treatment cells on the treatment plane
as a single treatment cell cluster.
General clinical treatment protocols may limit the targeted treatment volume. The Sonalleve User
Interface provides tools for measuring the approximate volumes or dimensions.

4.4 Sonication method

In the regular sonication method, the ultrasound beam treatment point sonicates points along its
path with a constant power level for a predefined time.
The feedback sonication method aims to minimize the time used per treatment cell. This method
divides the trajectory of the treatment point into several smaller areas, or sub-trajectories, which
are sonicated one-by-one at a constant power. When a sub-trajectory reaches a certain predefined
temperature and/or thermal dose, the treatment point moves onto the next sub-trajectory.
The feedback sonication method is only available in the Uterine application.
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4.5 Electronic deflection

The Sonalleve MR-HIFU system is able to steer electronically the position of the treatment point
within a limited range around the natural focus of the transducer. This method is called electronic
deflection. The system automatically uses electronic deflection to extend the reach of sonications
depth wise along the transducer's X coordinate axis. With positive electronic X deflection it
becomes possible to place treatment cells deeper than what the mechanical movement range of
the transducer allows. Negative electronic X deflection makes it possible to place treatment cells
closer to the patient's skin. The system automatically chooses electronic deflection based on the
user-selected cell location. Electronic X deflection is possible with 2, 4, 8, 12 and 14 mm cells, but
not with 16 mm cells.

4.6 Temperature monitoring

The Sonalleve console shows the temperature increase of the tissue during sonication, improving
the safety and predictability of the treatment.
Temperature measurements are based on MR signal phase changes. This is called the PRF
(Proton Resonance Frequency) shift method. The temperature is calculated from the phase
difference of two subsequent dynamic images (Δφ, in radians) and the MR protocol echo time TE
(tE, in seconds) as:

ΔT =
Δφ

α γ B₀ t  2 πE

where α = 0.0094 ppm/°C, γ = 42.58 MHz/T, B0 = 1.5 T or 3.0 T.

This technique measures relative changes in temperature with respect to the initial temperature. In
the beginning of each sonication, the temperature calculation assumes that the initial temperature
of the tissue is the body reference temperature. Sufficient cooling time is necessary to avoid
unwanted heat buildup.
Unexpected temperature changes may occur when there is a change in the measured signal
phase. Such changes can be caused by patient movement or by magnetic field changes due to
external or internal disturbances. The Sonalleve Software can detect and correct slow changes
(drift), but sudden changes may compromise the temperature information. Sonalleve Software will
issue a warning at the onset of a sudden change.

4.6.1 Thermal dose limits

The Sonalleve Software calculates the thermal dose from temperature maps using the formula:
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where:

CT = 1 °C, a constant to render the exponent dimensionless

T(t) = temperature (which may vary in time)

t = time

t’ = time required to produce the bio effect at temperature T

R = thermal normalization constant, equal to 4,0 if T ≤ 43 °C

R = thermal normalization constant, equal to 2,0 if T > 43 °C

These parameters approximate human soft tissue.
Thermal dose is a measure of the biological effect of tissue heating. Thermal dose depends on the
temperature and the duration of the heating. Thermal dose is expressed in equivalent minutes
(EM) at 43 °C (109.4 °F). For example, a dose of 240 EM means that you would need to keep the
tissue at 43 °C for 240 minutes to cause similar damage.
Thermal dose gives an estimate of the expected tissue damage. Tissue receiving a dose of 30 EM
or less can be expected to avoid having any permanent damage. Tissue receiving a dose between
30 EM and 240 EM might become oedematic, or have some broken cell membranes, damage to
vasculature and other kinds of damage. This damage may or may not be reversible. A thermal
dose of 240 EM or more can be expected to cause irreversible coagulative necrosis in the tissue.

4.6.2 Thermal dose and temperature monitoring

Temperature maps graphically depict temperature rises in the tissue while thermal dose shows the
resulting tissue destruction. Both can be shown on the Sonalleve console as colored overlays on
top of the anatomical images. If a treatment cell cluster is selected, the cumulative thermal dose is
displayed for that cluster.
The Sonalleve MR-HIFU system records temperature in all the imaging planes. The system
automatically positions some stacks at the location of the expected maximum heating. Some
stacks are freely adjustable by the user, to be placed in locations where heating is not expected to
occur.
Temperatures below reference body temperature are not shown in the temperature monitoring
images: the color coding scale starts at 40 °C (104 °F). The colors in the temperature map are
more transparent outside the ultrasound beam path and the transparency increases with distance
from the beam.
There are two abrupt transitions in the color scale of the temperature maps to emphasize the
increasing physiological effect of heating:

Tab. 9: The temperature map color scale.

Color Temperature Physiological effect

Blue below 47 °C
(116.6 °F)

A few minutes of exposure at this level is not likely to cause
necrosis.

Yellow 47 °C to 56 °C
 (116.6 °F to 132.8 °F)

Continued exposure at this level will cause necrosis within
seconds.

Red 56 °C (132.8 °F) or
above

Necrosis is immediate.
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Fig. 20: Example of a temperature map.

If the temperature increases significantly at regions other than the intended heating volume (plus
margin), the system issues warnings. The warnings may be caused by movement or other artifacts
and their reason and safety consequences should be understood before continuing with the
treatment.
The Sonalleve Software can only calculate temperatures at points where the signal-to-noise ratio
(SNR) is sufficient. Pixels where SNR is low will be masked out from the display. Low SNR at the
intended heating location will trigger a warning.

NOTICE   
Temperature measurement is done with fat suppression. This results in low SNR where fat is
present. The PRF method does not detect heating in fat. When ultrasound travels through fat
tissue, heating always takes place. The heating of fat can be deduced only from the heating of the
surrounding tissues.

NOTICE   
Cortical bone inherently has a low SNR. The heating of cortical bone can be deduced only from the
heating of the surrounding tissue.

The Sonalleve Software calculates the thermal dose from temperature maps. As the volume
outside the intended heating location is not expected to warm up, thermal dose is not calculated
there. Therefore, any potential temperature artefacts outside the intended heating location will not
produce any graphical depiction of dose.
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Thermal dose is not calculated for scans started from the Scan tab. Thermal dose is only
calculated for sonications, including temperature maps acquired before and after the actual
sonication.
Thermal dose gives an estimate of expected tissue damage. It does not measure the actual
outcome of the treatment. Use other methods to evaluate whether the treatment was successful.
In uterine therapy, the typical method to determine the outcome of the treatment is to observe non-
perfused volumes, using non-contrast and contrast MR images of the treated volumes after the
Sonalleve treatment. See 10.3 Comparing thermal dose volumes and non-perfused volumes.
In bone therapy, non-perfused volume does not directly predict the clinical outcome. Rather, clinical
effect is evaluated by following the patient-reported pain levels after the treatment.

4.6.3 Monitoring near-field heating

When a target volume is sonicated, some heating occurs in all the tissue layers through which the
ultrasound beam travels, both in the near field and in the far field. This is a property of all
ultrasound therapy systems and cannot be avoided. The amount of heating in the near field
tissues, such as the skin and the subcutaneous fat layer, is considerably lower than the heating at
the target. The deposited heat energy is carried away by the active cooling mechanisms of the
body (blood flow) and passive diffusion to surrounding tissues and to the Patient Table. A cool-
down period is needed between sonications to avoid dangerous temperature build-up (cumulative
heating).
Cumulative heating is a particular concern in the patient's skin and subcutaneous fat layer, and
may potentially lead to severe skin burns. To assist the user in preventing skin burns, Sonalleve
Software uses information about sonication parameters and data from post-sonication fat-
monitoring scans (if available) to estimate the temperature at the patient's skin and subcutaneous
fat layer. The software estimates the heat that has been produced in near-field tissue during the
entire treatment and displays these estimated skin and fat temperatures to the user. If the estimate
suggests that the currently selected sonication would cause the temperature of the near-field
tissues to rise too high, the software does not allow sonication to start. If the sonication is
estimated to induce heat close to the risk level, the software displays a warning (see the following
figure), and the user is asked to confirm the start of the sonication.
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Fig. 21: If the sonication is estimated to induce heat close to the risk level,
the software displays one of the above warnings (depending on risk level),
and the user is asked to confirm the start of the sonication.

NOTICE   
Variations in the patient’s anatomy and physiology, environmental conditions, etc., affect the
heating and cooling of the tissue. The system will not be able to detect all the possible cases in
which there is a risk of skin burn. Treatment decisions need to be made based on clinical
consideration of the potentially contributing factors.

4.6.4 Cooling time

Each sonication is followed by a cooling time. Cooling is necessary to prevent tissue burns in the
near field. Cooling time depends on the currently chosen parameters for the next sonication,
including cell size, type, power, frequency, etc. It is also affected by the sonication history and post-
sonication fat-monitoring scans, when available. Cooling time increases when the planned cell size
increases, when power increases, when energy increases, or when the cell is placed closer to the
skin.

The system enforces a mandatory cooling time that cannot be overridden, to prevent immediate
burn due to a single sonication or due to the next few sonications.

The recommended cooling time can be overridden by the user, because the treating physician
may have additional clinical information about the treatment or the patient that convinces the
physician that treatment speed can be increased without compromising patient safety.

A high-risk warning is displayed for aggressive overrides that involve a high risk of burns due to
a single sonication or due to the next few sonications.

It is not recommended to start the next sonication until the entire system-recommended cooling
time has passed.

The post-sonication temperature scan cannot be stopped from the Sonalleve console, only from
the MR scanner console. Stopping the scan is not advisable.

After the post-sonication temperature monitoring scan, the system may start a fat-monitoring
scan to collect information for improving the cooling time estimates. This scan cannot be
stopped from the Sonalleve console, only from the MR scanner console. Stopping or preventing
the scan is not advisable.

Use of the beam shaping feature or electronic deflection increases near-field heating. In these
situations it may be necessary to use longer cooling times than recommended by the Sonalleve
system.
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WARNING   
Always leave sufficient cooling intervals between sonications.
Failure to do so may cause heat buildup in the near field or far field, leading to skin burn or
other unwanted tissue damage.

A diminishing progress bar labeled Cooling and a count-down timer in the System Status Display
indicate the system-recommended cooling time. The part of cooling time that cannot be overridden
is displayed in red. The recommended cooling time is displayed in two shades of orange, with the
brighter color corresponding to higher risk.

Fig. 22: Three examples of cooling time in the System Status Display. Left:
Almost one third of the remaining system-recommended cooling time is
mandatory and cannot be overridden. Middle: The cooling period can be
overridden because there is no mandatory cooling time, but the system
indicates a high risk of internal burn. Right: Recommended cooling time still
remaining, but it is possible to use the override and start sonication.

4.6.5 Temperature limits

The Sonalleve MR-HIFU system imposes the following temperature limits to prevent overheating of
tissue:

Warning zone heating limit: 47 °C (116.6 °F). If the system detects this temperature inside the
beam path in the near-field monitor slice or inside a user-defined Freehand Warning ROI, it
generates a warning message and the user must decide whether to continue or stop the
sonication.

System safety limit: The highest temperature that is allowed in a treatment cell during
sonication is 85 °C (185 °F). If this temperature is reached within the treatment cell, the system
issues a warning and automatically stops the sonication.

4.7 Motion detection

Patient motion may result in misplaced heating. Observe carefully that vulnerable structures such
as neurovascular bundles and bowel loops have not moved into the beam path.
As a safety measure, the system detects unintended patient movement during treatment and
issues a warning if it is detected. If the movement is significant, the system issues a more severe
warning.
If the patient moves during treatment, a spatial variation of the measured temperature outside the
heated region occurs. Carefully monitor the temperature maps during therapy.
Additionally, if you suspect the patient has moved, scan a fast scan with markers and compare the
images. If you see significant movement in the images, scan the planning images again and verify
the validity of the treatment planning. An alternative is to use registration tool. Registration is a
feature that can perform the necessary corrections if any patient or organ movement is observed
during the treatment. See 6.8.8 Registration.
In addition, the Sonalleve software provides graphical tools, such as markers, that can be used for
detecting movement of visible anatomical landmarks. For more information, see 6.6.6.1 How to use
markers and why ?.
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4.7.1 Misplaced heating or motion artefact?

If the temperature increases significantly outside the intended heating volume, the system issues
warnings. The warnings may be caused by movement or other artifacts and their reason and safety
consequences should be understood before continuing with the treatment.
Breathing or bowel movements may produce artefacts which look like heating in the temperature
images and trigger motion detection warnings.
The figures below show temperature images where sonication is in progress but bowel motion
interferes with the temperature imaging.

Fig. 23: Motion artefacts in temperature mapping images

If there is any doubt about the cause of the perceived heating, immediately abort the sonication
using the software abort button and run a temperature scan without any heating. If the temperature
does not seem to decrease, the perceived heated region may be caused by an artefact and
treatment can resume with caution.
Ways to distinguish motion artefacts from heating:

Run temperature mapping scans before the Therapy stage and in between sonications.

Use the transducer beam overlay to check the location of the colored areas. If they are outside
the beam path, they are most likely artefacts caused by motion.

Scroll the time series to determine whether the perceived heating occurred during sonication.

In the following example image actual heating has taken place at the heated area at the ultrasound
beam focus. The areas colored yellow or red far from the transducer beam are motion artefacts.

Fig. 24: Heating and artefacts in temperature map
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5 User interface
5.1 Overview

The Sonalleve MR-HIFU user interface is used for planning, performing and monitoring the
treatment using images obtained from the MR scanner.
The user interface provides versatile tools for viewing the images in all imaging planes. The way in
which the images are viewed can be optimized for each treatment stage.
The target to be treated and other areas of interest can be defined and visualized as overlays on
top of the images.
The user interface also enables constant monitoring of the treatment for patient safety throughout
the treatment.

5.2 Starting the Sonalleve MR-HIFU application

5.2.1 Selecting the configuration

The Sonalleve MR-HIFU application can be started in two different modes regarding which
configuration the application uses.

Therapy is for clinical use. The application starts with the Site Default Configuration (see
5.2.1.1 Site Default Configuration). For normal users, the Sonalleve console is set to start the
application in Therapy mode when the user logs in.

Research is for experimental use by researchers and other qualified advanced users. The
application starts with the current configuration, without first loading the Site Default
Configuration. Research mode is only available to HIFU Power Users (see 10.7 Hospital
administrator and user accounts).

On the Windows desktop of HIFU Power Users, there is a shortcut to start the application in
Therapy mode. Shortcuts for both starting modes appear in the Windows Start menu.
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Fig. 25: Application start shortcuts. Left: desktop shortcut. Right: Start menu
shortcuts.

To change between the Therapy and Research modes, restart the application.

Site Default Configuration

The Site Default Configuration is the configuration that is always taken into use when the Sonalleve
Application is started from the Sonalleve Therapy shortcut. It is intended to be a safe default
configuration that always works with the Sonalleve hardware and ensures that the user always has
a valid configuration for use, even if the last configuration has been modified by researchers or
advanced users. Any changes that advanced users make in the current configuration do not
overwrite the Site Default Configuration unless they are explicitly saved as the Site Default
Configuration.
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5.2.2 Selecting between the Therapy and Standalone mode

To select between Therapy mode and Standalone mode, select the mode in the Mode list in the
start page of the Sonalleve MR-HIFU application:

Fig. 26: The Mode list in the start page of the application

The text in the application selection button for the therapy session changes according to the mode
that the Sonalleve MR-HIFU application is in:

Fig. 27: The application selection buttons when the Sonalleve MR-HIFU
application has been started in the mode and Therapy is selected in the
start page. To start therapy with the Site Default Configuration, click
Therapy.
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Fig. 28: The application selection buttons when the Sonalleve MR-HIFU
application has been started in the mode and Therapy is selected in the
start page. To start therapy with the current configuration, click Research.

Fig. 29: The application selection buttons when is selected in the start page
of the Sonalleve MR-HIFU application. To start in the Standalone mode,
click Standalone.

5.3 Exiting Therapy

To exit Therapy mode and return to the start page of the Sonalleve MR-HIFU application, either
click the Therapy application button or select End Therapy in the File menu.

Fig. 30: File menu during Therapy.

To exit the Therapy mode and close the Sonalleve MR-HIFU application, select Exit in the File
menu.

Saving unsaved data
When you exit a therapy session, in which there is unsaved therapy data, the system displays the
following Save State dialog:

Fig. 31: The Save State dialog.
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You can select one of the following three alternatives:

Fill in a name and a comment for the saved state, then click Save and Exit to save the therapy
data and exit the session.
Click Cancel to cancel the exit and to return to the therapy session.
Click the Abort without Saving button (the button with the trashcan icon) to abort the session
without saving therapy data.

If you select Abort without Saving, you need to confirm the exit in a follow-up dialog:

Fig. 32: The Abort without Saving confirmation dialog.

To abort the session without saving therapy data, check the checkbox Enable aborting without
saving and click OK. Alternatively, to keep the data and return, click Cancel.

NOTICE   
When you click OK in the Abort without Saving confirmation dialog, the therapy data is discarded
and cannot be recovered. It is not possible to create a Clinical Summary Report after the session
has been aborted without saving therapy data.

For more information on saving therapy data, see 5.12 Saving and recovering your work.

5.4 MR User Account Name

NOTICE: This section applies to software version R3.7 L4 and newer.

Fig. 33: Tools Menu.

The MR User Name selection dialog can be accessed from the Tools menu. For Philips R12, the
user name used to log in to the MR console must be identified. The name can either be selected
from the list or entered manually. Manual entry of the user name is not required when using the
Philips R5.8 (XTC) protocol. Selection is not needed when using the default configured user name.
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Fig. 34: MR User Name Selection Dialog.

5.5 Exiting the Sonalleve MR-HIFU application

To close the Sonalleve MR-HIFU application, select Exit in the File menu.

5.6 Therapy application screen layout

The Sonalleve MR-HIFU Therapy application screen is divided into three main areas: Therapy
Wizard (1), Image Area (2) and Hardware Status Area (3).

Fig. 35: Sonalleve MR-HIFU Therapy application screen layout.
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5.7 Therapy Wizard

In the Therapy application the Therapy Wizard will guide you through the following successive
stages:

Tab. 10: Therapy stages.

Stage Navigation button Stage name

1 Patient Information Entry

2 Imageset Retrieval

3 PTV Delineation

4 Treatment Cell Planning

5 Hardware Initialization

6 Therapy

Complete all mandatory actions in each stage. Otherwise, you cannot move on to the next stage.
However, you can always return to a previous stage using the appropriate navigation buttons.
The visual appearance of each navigation button indicates if you can move to that stage:
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Blue color indicates
the current stage.

Strong orange color indicates a
stage that you can move to.

Dull color indicates a stage that
you cannot move to.

For more information on the treatment stages, refer to 6 Workflow.

5.8 Viewing images

The Image Area shows the planning and monitoring images produced by the MR console in four
separate windows. The protocol name and the date and time of the image, as well as the currently
displayed image plane are shown on the upper edge of each window. For the image in the lower
right corner, you can freely select the plane by right-clicking on image plane name in the upper
right corner of that image.

Fig. 36: Selecting the viewing plane: Plane (1), Time (2), Scan protocol (3),
 Right-click on plane name (4), Select a plane (5).

Click on an image in the Image Area to select it for viewing.
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You can view the images in various sequences and directions using the three groups of buttons on
the toolbar:

Basic viewing tools.

Advanced viewing tools.

Overlay tools.

The viewing tools available may vary between the treatment stages.

5.8.1 Basic viewing tools

Tab. 11: Basic viewing tools.

Button Tool Function/Use

Zoom Used for Zooming in/out on an image. Can also be activated by mouse
right + left/scroll buttons. Right clicking the button gives you an option to
cancel any modifications.

Pan Used for viewing an area of (a zoomed) image. Can also be activated
by mouse left + scroll button. Right clicking gives you an option to
cancel any modifications.

Browse
Images

Used for browsing the slices of an image. To browse, activate the
browse button and left click and drag or scroll on an image. Right
clicking gives you an option to cancel any modifications.

Navigation
Wizard

Automatically finds the location you click on the other two image
orientations. Reduces the need for browsing the slices.

Window Used for adjusting the brightness and contrast of the images. Left-click
and drag left to see a narrower range of intensity levels, right to see a
wider range of intensity levels, up to darken the image or down to
lighten the image. Right-clicking gives you an option to cancel any
modifications.

Measure Used for measuring, for example, the size of or the distance between
objects. Left-click and drag to measure.

Scroll Used for viewing a timeline of the image.

The following tool buttons are hidden by default. To add these tool buttons to the toolbar, select
them in the Tools → Toolbar Options menu.

Tab. 12: Additional basic viewing tools.

Button Tool Function/Use

Profile
Line

Used for viewing the heating along a line instead of in a treatment cell. Only
available in the Analysis tab of the Therapy stage. Drawing a line on top of
the image defines the line, the heating along which is displayed in the
Temperature Curve window of the Analysis tab.

Pixel
Info

Pixel Info allows you to see the coordinates, the maximum temperature and
the heating dose for a selected pixel on a temperature map. This allows for
detailed analysis of the sonication results
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5.8.2 Advanced viewing tools

It is often necessary to view the images differently in different stages of the treatment. The
advanced viewing tools allow you to change the way in which the images are displayed in the
image area. A view can be customized by selecting the desired viewing tools. The Sonalleve MR-
HIFU application will remember the selected views when the user returns to a specific treatment
stage and to a tab page within the stage.

Tab. 13: Advanced viewing tools.

Button Tool Function/Use

Orthogonal
view

Shows the axial, sagittal and coronal planes and the image
stack. This view is “patient oriented”, meaning that it is useful
for viewing the anatomy, but not for all planning operations.

Transducer
view

Shows the planes aligned with the transducer X, Y and Z
axes.The recommended view that allows adjusting the
transducer position in all three dimensions. Operations are
possible on all planes.

Monitor
view

Shows the monitor stacks used in temperature monitoring
during sonication.

PTV view Shows selected planes aligned according to the Planning
Target Volume (PTV) X, Y and Z axis. The only view in which
the PTV can be adjusted in all three dimensions. Operations
are possible on all planes.

The tool buttons of the following views are hidden by default. To add these tool buttons to the
toolbar, select them in the Tools → Toolbar Options menu. 

Tab. 14: Additional advanced viewing tools.

Button Tool Function/Use

Comparison
view

Shows two images of the same plane side by side. Useful for
e.g. comparing the images from two protocols.

Single view Shows a single large image.
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5.8.3 Overlay tools

The overlay tools assist you during the planning and monitoring of the treatment. They allow the
display of objects related to treatment planning and monitoring, such as cells, transducer positions,
or temperature maps on top of a planning image. Some overlays also allow adjustment graphically.
Several overlays can be displayed simultaneously.

Tab. 15: Overlay tools.

Button Tool Function/Use

Hide all
overlays

Hides all overlays.

PTV overlay Shows the Planning Target Volume (PTV) and allows you to
graphically adjust it.

Transducer
beam
overlay

Shows the transducer beam path. Visualizing the beam path helps in
avoiding organs in the near and far field. The position of the
transducer can be graphically adjusted by dragging from the handles
on the transducer beam centerline.

ATA overlay Shows the Available Target Area (ATA), i.e. the area within reach of
the transducer beam. The ATA is displayed for the treatment plane of
the current transducer position.

View slice
overlay

Shows the slice position in the imaging volume.

Temperature
map

Shows the temperature rise as a colored overlay and the color-coded
temperature scale on the right side of the image window. The tool
button has a context menu, in which you can choose between filtered
and raw data temperature maps.

Dose
contours
overlay

Shows the dose as two contours around the heated area. The white
contour shows the area in which the heating was sufficient to produce
necrosis. The orange contour shows the area that was heated but not
enough to produce necrosis.

ROI overlay Shows the Region of Interest (ROI) outlines and the 3D markers
added in the planning phase. Also shows the measurements made
with the Measure tool.

Treatment
cell visibility

With cell visibility, you can select how the treatment cells are shown.
Display all cells, no cells, the cells on the active level, the cells in the
current target volume, current transducer position, or current cluster,
or display only the sonicated or pristine treatment cells.
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Fig. 37: Treatment cell visibility drop-down menu.

The tool buttons of the following overlays are hidden by default. To add these tool buttons to the
toolbar, select them in the Tools → Toolbar Options menu.

Tab. 16: Additional overlay tools.

Button Tool Function/Use

Transducer
overlay

Shows the physical position of the transducer.

Thermal
dose map

Shows the thermal dose as a colored overlay and the color-coded dose
scale on the left side of the image window. Cannot be used together
with temperature map overlay.
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Fig. 38: Overlays on top of the transducer view: Transducer overlay (1),
Transducer beam overlay (2), PTV overlay (3), View slice overlay (4)

Transducer beam overlay

The transducer beam overlay displays the estimated shape of the transducer beam. The shape of
the near field close to the transducer is calculated in real time. This calculation is an approximation
that takes into account OARs, the distribution of transducer elements at the surface of the
transducer, and the position and angulation of the transducer. The shape of the near field close to
the treatment cell and the shape of the far field depend only on treatment cell size and the use of
electronic deflection. Transducer beam shape calculation is not able to model the possible effects
from anatomical variation in tissue. The displayed beam shape does not observe changes due to
different sonication powers, either.
When the system uses depthwise electronic deflection to position a treatment cell closer to the
transducer (negative electronic X deflection), the position of the narrowest part of the beam can be
different from the position of the treatment cell, as shown in the first of the the following example
images. This displacement is intentional, to give you a better approximation of the transducer beam
shape.
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Tab. 17: Examples of the transducer beam overlay with different amounts of electronic
X deflection.

Electronic X deflection Displayed beam shape

−10 mm

0 mm

+10 mm

+20 mm
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The transducer beam overlay visualizes the treatment cell safety margin and the far-field safety
margin:

Fig. 39: The transducer beam overlay visualizes the treatment cell safety
margin (1) and the far-field safety margin (2).

Treatment cell visualization

The status of each treatment cell is indicated with different colors and markings.

Tab. 18: Treatment cell color codes and markings.

Cell
appearance

Cell state

A pristine, correctly positioned cell. Not marked checked with the Toggle Cell
Checked tool.

A pristine, safety checked cell. Marked checked with the Toggle Cell
Checked tool.

The currently active (selected) cell.
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A test sonicated cell.

A sonicated cell.

An incorrectly positioned cell. The cell is outside the Available Target Area
(ATA) and must be repositioned.

Fig. 40: Treatment cells
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5.9 Adding, selecting and removing objects

With this group of tools you can add, select and remove objects. The buttons are active only in
those stages in which they can be used.

Button Tool Function/Use

Add Adds an object (PTV, treatment cell, marker, freehand ROI, freehand
Warning ROI, OAR, or Critical OAR).

PTVs and treatment cells can only be added in their respective
stages. Markers and ROIs can be added at any stage.

Freehand Warning ROIs can only be added during the Therapy
stage, and only to images displayed in the Monitor view.

OARs are ROI regions that can be drawn to protect sensitive regions
in the near-field beam path.

In some stages, it is possible to add several types of objects. By
default, the object that is added is of a type that is necessary before
proceeding to the next stage. To select another type of object, click on
the down arrow next to the Add button to open a drop-down menu.

Select Selects an object so that it can be moved or adjusted. PTVs and
treatment cells can only be selected with this tool in their respective
stages. Markers and ROIs can be selected at any stage.

Move
Treatment
Cell
Cluster

Selects a treatment cell cluster so that it can be moved and angled.

If a cluster contains sonicated cells, those cells will not be moved.

If all the cells in a cluster are sonicated a new cluster is created
instead.

Remove
Current

Removes the selected object.

Toggle
Cell
Checked

Marks the selected treatment cell as safety checked, or removes the
mark.
The cells that are marked safety checked are shown in green (see
5.8.3.2 Treatment cell visualization).

Cell type Opens the drop-down list from which the cell size and type can be
selected. If you do not select a cell from the list, the cells added will be 4
mm feedback cells in the Uterine application and 2 mm regular cells in
the Bone application.

Additional tools are available in the Treatment Cell Planning stage of the Therapy Wizard.
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Tab. 19: Tools available in the Treatment Cell Planning stage.

Button Tool Function/Use

Add Empty
Treatment Cell
Cluster

Adds a new, empty treatment cell cluster.

Copy Treatment
Cell Cluster

Copies the selected treatment cell cluster.

Remove
Subitems

Removes the subitems of the selected object.

Define
Autopopulation
Area

Used for drawing an area around an area to be automatically filled
with treatment cells.

Autopopulate Fills the autopopulation area with treatment cells of the selected
type. Eligible cell sizes depend on the size of the autopopulation
area.

5.10 Controlling and monitoring the sonication

The Hardware Status Area at the bottom of the screen is used for controlling the Sonalleve MR-
HIFU system during the sonication phase and for monitoring the status of the system and the
treatment.
The Hardware Status Area includes the following functions:

System Status Display.

Sonication buttons.

Message area.

Information on the progress of the sonication is also displayed as:

Temperature and thermal dose overlays.

Temperature curve in the Sonicate and Analysis tabs.

5.10.1 System Status Display

The System Status Display shows the modes of the Sonalleve MR-HIFU system. The display
includes the following icons:

Tab. 20: The System Status Display icons.

Icon Meaning

Scanner status (scanning/inactive).
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Transducer positioner status (moving/idle).

Sonicator status (sonicating/idle).

Direct Skin Cooling (DISC) device status (water circulation on/off) for versions
R3.7 to L3.

Direct Skin Cooling (DISC) device status (water circulation on/off) for versions
R3.7 L4 and newer.

The following colors and graphically overlaid symbols are used in the icons:

Tab. 21: Colors of the System Status Display icons.

Color Status Example Meaning

Green OK, Idle

Yellow Active

Red Error For versions R3.7 to L3.

Red Error For versions R3.7 L4 and newer.

Gray Disabled The option has not been installed or configured
for use for versions R3.7 to L3.

5 User interface > 5.10 Controlling and monitoring the sonication

Instructions for Use  
109011C / 2025-12

79 (206)



Gray Disabled The option has not been installed or configured
for use for versions R3.7 L4 and newer.

Gray with 
yellow 
information 
icon

Pending on
user action

Waiting for user to do action.

Tab. 22: Overlays on the System Status Display icons.

Overlaid symbol Example Meaning

Rotating gears
over a yellow
icon

The system is making preparations: for example, installing
embedded software or changing the MR scan protocol.

Other animations
in yellow icons

The system is active: for example, scanning or sonicating.

Small arrows in
the blue DISC
icon

Water circulation is on. (For versions R3.7 to L3)

Small arrows in
the blue DISC
icon with current
temperature

Water circulation is on. (For versions R3.7 and newer)

Yellow warning
triangle over the
blue DISC icon

There is a problem with the Direct Skin Cooling device. (For
versions R3.7 to L3)

Yellow warning
triangle over the
blue DISC icon

There is a problem with the Direct Skin Cooling device
while Water circulation is off (for versions R3.7 and newer).

Yellow warning
triangle over the
blue DISC icon

There is a problem with the Direct Skin Cooling device
while Water circulation is on (for versions R3.7 and newer).

DISC
temperature
adjustment

Displays the current temperature of the DISC and, by
clicking the icon, allows setting of the DISC target
temperature (for versions R3.7 to L3).

DISC control and
temperature
adjustment

Displays the current temperature of the DISC. Clicking the
icon allows setting of the DISC target temperature and
provides manual ON/OFF control for the DISC for versions
R3.7 and newer. (Top to bottom: cooling, stable, not
cooling)

Fat monitoring
status indicator

Is displayed if the fat monitoring scan was not successful.
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A progress bar below the icons shows the progress of the currently active mode (pre-sonication
scanning, sonication, post-sonication scanning or cooling). The timers show the remaining
sonication time, scanning time, or cooling time. Tool tips over the timers also show the time from
the first sonication and the time from the start of the therapy. When the system is not sonicating,
the temperature display shows the estimated temperatures of skin and fat tissue, both current
values and the predicted maximum temperatures for the next planned sonication. The system also
alerts the user to any issues with the fat monitoring scan that prevent the calculation of the cooling
time. Clicking the Fat monitoring status icon displays more information about the issue.

Fig. 41: System Status Display: while sonicating (above) and while idle
(below). (For versions R3.7 to L3).

Fig. 42: System Status Display: while sonicating (above) and while idle
(below). (For versions R3.7 and newer).

Fig. 43: The Fat Monitoring dialog shows the position of the T2 fat
monitoring scan with respect to tissue boundaries. It also provides more
information on why the fat monitoring data could not be used. The image
can be windowed using the standard tools.
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For versions R3.7 to L3: You can set the DISC target temperature by clicking the DISC temperature
icon, as shown below.

Fig. 44: Setting the DISC target temperature. (For versions R3.7 to L3).

For versions R3.7 L4 and newer: The DISC target temperature is adjusted using the temperature
slider, which appears after clicking the DISC temperature icon, as shown below. The DISC ON/OFF
control appears directly below the temperature setting. Sonication is disabled when DISC is in off
state and can only be enabled when DISC is turned on and fully operational.
When DISC is on:

The temperature slider is active and can be adjusted.

Arrows on the line around the DISC icon and temperature indicate active water circulation.

Sonication is available.

When DISC is off:

The temperature slider is displayed in gray color and cannot be adjusted.

No arrows are shown, indicating that water circulation is inactive.

Sonication is disabled.

Fig. 45: Setting the DISC control and target temperature for versions R3.7
L4 and newer (DISC is on/off).
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5.10.2 Sonication buttons

Start Sonication

Abort Sonication

The Start Sonication and Abort Sonication buttons are used for starting and aborting sonication.
The buttons are active only in those stages where sonication is possible, i.e. during test sonication
and therapy.
The Abort Sonication button should be used to stop the treatment only in situations in which there
is no risk to the patient. In all other cases, use the stop button on the Safety Device.

Override allowed

High-risk sonication, override not recommended

A warning symbol is displayed on top of the Start Sonication button when the user is allowed to
override the remaining part of the system-recommended cooling time (see 4.6.4 Cooling time). An
orange warning indicates a very high-risk sonication Generally, it is not recommended to start the
next sonication until the entire system-recommended cooling time has passed.
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5.10.3 Temperature and thermal dose

When pressing the Start Sonication button, the Sonalleve application scans a few reference
images before starting the actual sonication. As the sonication starts, the calculated temperature
and thermal dose are shown as overlays. Temperature and thermal dose are best shown
simultaneously if the thermal dose contour overlay is used.

Fig. 46: An example of the temperature map and thermal dose contours of
a sonication of a single cell.

 The dose contours and the dose map correspond to the selected item. To see the dose from a
sonicated treatment cell, select the cell.
To see the cumulative dose of all the sonicated cells in a treatment cell cluster, select the cluster.
When several sonications have been done, the cumulative dose calculation might take some time.
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Fig. 47: Cumulative dose contour of a treatment cell cluster.

WARNING   
Always rely on the original dose map when making decisions about the treatment
completeness. The cumulative dose map may differ from the original dose map.

5.10.4 Temperature curve

You can monitor the heating of a treatment cell during and after sonication with the temperature
curve in the Sonicate and Analysis tabs of the Therapy stage.

The yellow curve shows the temperature and the red curve the thermal dose in the middle of the
treatment cell.

Vertical green lines mark the start and stop points of sonication.

A vertical dotted line shows when the maximum temperature was reached.

The time scale starts from the start of sonication.

White dotted lines show the time and temperature. Point to the temperature curve and left-click
to read out the time and temperature at that point.
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Fig. 48: Temperature curve.

Positioning a treatment cell inside the bone in the Bone application limits heating and temperature
monitoring, and may result in a flat temperature curve.

Additionally, you can also choose to display the temperature and thermal dose along a line that you
draw using the Profile Line tool. The tool button is hidden by default, but you can add it to the
toolbar from the Tools → Toolbar Options menu. The heating profile can only be seen in the
Analysis tab post-sonication.

The yellow curve shows the temperature and the red curve the heating dose in each voxel
along the line.

Fig. 49: Heating profile (Profile Line).
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5.10.5 Message area

The message area in the middle of the Hardware Status Area shows the warnings and error
messages of the system.

Fig. 50: Message area.

Double-clicking a message opens a notification window with more details on the message and
instructions on how to clear it. For more information on error and warning messages, see 8 System
Error and Warning messages.

5.11 Reporting and logging

5.11.1 Generating reports

You should generate a Clinical Summary Report and store it where it can be conveniently
retrieved later. The Clinical Summary Report is a document in Portable Document Format (PDF)
that includes the patient data, treatment data and possible errors during the treatment. Additionally,
the post treatment images should be stored as part of the treatment results.
You can add comments and select snapshot images to be included in the report.

5.11.2 Taking snapshots

With the snapshot tool, you can take snapshots of the images in the image area. Clicking on the
button opens a comment dialog over the area where the snapshot will be taken and saves a
snapshot of the active window in the image area into the Clinical Summary Report. In addition to
the image area, the snapshot tool also enables you to take snapshots of the Temperature Curve
area, which is visible in the Sonicate and Analysis tabs.
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Fig. 51: Snapshot Comment dialog.

5.11.3 Viewing and exporting logs

The Tools menu contains the Log Viewer, through which you can:

View system events.

Filter the log to display events according to their:

Severity level (unknown, Debug, Info, Warning, Error).
Time period (last 1 hour, last 24 hours or within another specified time range).
Originator (software components on the HIFU Controller or the Sonalleve Console).

Export the log for use in troubleshooting, for example.

Fig. 52: Exporting the log.

Store logs in an archive that allows opening the stored data with the Log Viewer.

-
-
-
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Fig. 53: Storing logs in an archive

5.12 Saving and recovering your work

To save your work, you should:

Create a Clinical Summary Report as described in 5.11.1 Generating reports.

Create a Saved State file. A Saved State file is a .tar file containing a snapshot of the current
treatment situation.

Save pre- and post-therapy images in the MR console.

A Saved State file should be created for research and backup purposes.
A Saved State is useful when making significant changes in the planning process and later wishing
to revert to the previous plan. If the software crashes, the system will automatically create a Saved
State file of the current situation.
When clicking the Save State menu item, a dialog box opens where the state can be named and
additional comments made. If the name field is left empty, the software generates a name based on
the current time and date.

Storage of Saved States
Saved States are stored in an internal database that has limited storage capabilities. The system
does not provide persistent storage for Saved States. Always export the required Saved States to a
permanent storage medium, such as a network drive, a USB disc, or a DVD after a treatment
session.

NOTICE   
The front USB ports are disabled for cybersecurity reasons. Access for the rear panel USB ports
and the DVD require administrative privileges (e.g. Hospital Administrator account). In some cases
it may be necessary to restart the computer to gain access to a connected USB drive.

NOTICE   
The Saved States are only held in the internal database for 7 days or until its memory is full. As
new Saved States are added, the oldest ones will be removed from the database. If you wish to
permanently keep the Saved States, ensure that information is exported to a secure storage
system as soon as possible. Use the Export button to save the .tar file to an external storage
device or to DVD.
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Patient data (Saved States) written to removable media, such as DVDs, is identifiable. Treat
removable media containing patient data as confidential and store the media in a secure
environment.
Writing patient data to an external storage device or to DVD is considered temporary storage only,
not a long term backup solution. To ensure patient data security, send patient data to a dedicated
DICOM storage device that is intended to be used as an archive.
Create and implement policies ensuring that data backups occur and that data backups protect
patient data.
A risk of losing patient data exists when storing patient data on backup media. Storage media may
become:

Lost

Obsolete

Unreadable

No longer supported.

Ensuring sufficient free disk space
Each Saved State in the database consumes disk space on the workstation. For unhindered
operation of the Sonalleve MR-HIFU application and the Sonalleve console in general, sufficient
disk space must always be available.
The Sonalleve MR-HIFU application monitors the amount of available disk space. When the
available disk space is getting too low, the following warning appears in the start page of the
application.

Fig. 54: Warning for low available disk space.

When the available disk space is no longer sufficient, the following error message appears in the
start page of the application. This error prevents the user from entering the Therapy mode and
loading Saved States.

Fig. 55: Error for too low available disk space.

Click on the warning or error message to open a restricted Session Manager dialog, in which you
can export and delete old Saved States. Importing Saved States is disabled in the restricted
Session Manager. The amount of available disk space is shown in the footer of the dialog window.

NOTICE   
The Session Manager only shows the Saved States that are stored in the internal database. If the
disk is filled with other files, a system administrator has to clean the system by using normal
Windows tools.

Session Manager
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In the Session Manager dialog, you can view the contents of the internal database and import,
export and delete Saved States. Select Manage States in File menu to open the Session
Manager.

Fig. 56: Session Manager.

Tab. 23: Session Manager tool buttons.

Button Tool Function/Use

Import Used for retrieving previously exported .tar files (Saved State files).

Export Used for exporting a session into a separate .tar file (Saved State file).

Export
De-
identified

Used for exporting a session into a separate .tar file (Saved State file).
Patient Name and ID will be anonymous in this Saved State.

Delete Used for deleting a session.

Rename Used for changing the description of a session. Note that renaming a
session can be quite slow if a lot of data has been stored in the session.

Show All Used for showing sessions that have been saved using other versions of
Sonalleve software. This tool is only available to HIFU Power Users,
Service and administrators.

Loading a Saved State

Select Manage States in File menu. The Session Manager dialog box opens.
Select the Saved State from the list.
Click Load Therapy to load the saved state in Therapy mode, or click Load Standalone to load

the saved state in Standalone mode.
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NOTICE   
Saved State can only be used for a single treatment session. If you reposition the patient on the
table, you cannot continue planning using an existing Saved State but must scan new images and
replan the treatment.

Exporting a Saved State

Select Manage States in File menu. The Session Manager dialog box opens.
Select the Saved State from the list.
Click Export.
Select the directory and file name to save to. The system can also export directly to a CD/DVD.

For instructions on burning Saved States to a DVD, see 10.5 Copying Sonalleve MR-HIFU
treatment data to DVD.
If a Saved State file is needed without identifying personal data, use the Export De-identified tool
instead of Export. Before you use Export De-identified, ensure that the name and comment field
of the session do not include the name of the patient or any other identifying personal data. Use
the Rename tool to edit the name and comment if necessary. When exporting, give the .tar file a
name that does not contain personal data.

Importing a Saved State

Select Manage States in File menu. The Session Manager dialog box opens.
Click Import.
Select the file to import.

5.13 Language settings

To set language and measurement display preferences, select the Set Language menu item in the
Tools menu.

Fig. 57: Select Language dialog box.
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5.14 Keyboard shortcuts

The following keyboard shortcuts are active when you have clicked on the Image Area to select it
for viewing. The tools available may vary between the treatment stages and tab pages within a
stage.

Tab. 24: Keyboard shortcuts in the Image Area.

Key Action

Page Up Scroll dynamics backward in all windows

Page Down Scroll dynamics forward in all windows

B Browse images

P Pan

Z Zoom

W Window (contrast/brightness)

S Scroll dynamics

L Add PTV

C Add treatment cell

M Measure

F Add Freehand ROI

A Add autopopulation area

X Add marker

R Image text layout with additional information on/off
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6 Workflow
6.1 Overview

The Sonalleve MR-HIFU workflow can be divided into the following main stages:

Preparing the equipment.
Preparing the patient.
Positioning the patient.
Scanning the planning images.
Therapy.
Post treatment.

All the MR-HIFU Therapy applications follow the same main stages, but there may be application-
specific differences in patient preparation, positioning, treatment cell types and sizes, and power
levels. Always refer to the Application Guide for application-specific details.

6.2 Preparing the equipment

The Sonalleve MR-HIFU system is typically only used periodically, alternating with normal MR
scanning. One person can switch between the standard tabletop and the Sonalleve Table Top in 5
to 10 minutes.

6.2.1 Connecting the Sonalleve Table Top

Inspect the Sonalleve Table Top for any signs of leaks.
Remove all coils, pads and positioning aids from the standard tabletop.
With some Ingenia MR scanners (see the following figure): Remove the thin tabletop used for

diagnostic imaging.

Fig. 58: Left: This type of Ingenia thin tabletop needs to be removed before
the Sonalleve Table Top can be placed in position. Right: The narrower end
in this type of Ingenia thin tabletop allows the Sonalleve Table Top to be
placed in position without removing the Ingenia thin tabletop.

Set the MR patient support to the lowest position.

6 Workflow > 6.1 Overview

Instructions for Use  
109011C / 2025-12

94 (206)



5. 

6. 

7. 

CAUTION   
The patient support must remain at the lowest position. Do not raise the support height after
the Sonalleve Table Top is placed in position.

Bring in the Sonalleve Patient Table. Position the trolley over the top of the lifting unit until the
lateral stops are correctly inline with the buffer blocks on the patient support.

CAUTION   
Take extra care not to damage the Patient Interface Control Unit (PICU) when maneuvering
the trolley into position.

NOTICE   
The lateral stops must touch the buffer blocks on the patient support.

Press the left side of the brake pedal down to lock all the wheels (brake LOCKED). The Patient
Table is now docked.

 

WARNING   
When docking the Patient Table to the MR system patient support, always press the brake
pedal to lock all the wheels. This is to avoid accidental movement of the tabletop which may
lead to misplaced heating and tissue damage.

Connect the Sonalleve Control Cable and the Ultrasound Cable to the sockets at the side of the
Patient Table. The cables are stored in the accessory cart, if available.
Make sure that the cables are not lying in the way when the patient enters or exits. Cables lying on
the floor are a potential tripping hazard.
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Fig. 59: Table Top connector panel. The Sonalleve Control Cable is in the
middle with the large pull-down handle. Ultrasound Cable is on the right side
connected with the large screw in the middle. DISC hoses are connected
to the left.

Unhook the Sonalleve Coil Cables from their holders on the Patient Table and connect them to
their sockets.

Remove the ultrasound window cover from the top of the ultrasound window. The ultrasound
window cover is used for protecting the membrane on top of the ultrasound window when the
Patient Table is not in use.

Check that there are no visible leaks around the ultrasound window.

Fig. 60: Ultrasound window cover.

For the Direct Skin Cooling (DISC) device:
Check that the water level in the DISC device is correct: the surface of the patient contact
should be flat.
Check that there are no obvious leaks from DISC.
Check that there are no large air bubbles visible through the DISC patient contact.
Connect the two connectors in DISC hoses to the connectors in the Sonalleve Patient Table.
Male and female connectors are provided to ensure correct connections.
Make sure that the hoses are not lying in the way when the patient enters or exits. Hoses
lying on the floor are a potential tripping hazard.

-

-
-
-

-
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Fig. 61: Connect the two connectors in DISC hoses to the connectors in the
Sonalleve Patient Table.

Connect the HIFU Coil cable to the Patient Table coil connector.

6.2.2 Connecting Table Top Extension Plate (only in Bone
application)

Sonalleve Extension Plate is designed to be used when the Sonalleve Table Top needs extension
for the optimal treatment position.

Remove the detachable handle by pressing the release buttons.

Fig. 62: Detachable handle

Release the Table Top by pressing the release button and push it towards the magnet bore so
that the Extension Plate will fit.

Take out the PESB and headphones from the accessory box.
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Fig. 63: PSB and headphones

Place the Extension plate on the Sonalleve Table Top and lock the Extension plate to the correct
place.

Fig. 64: Extension plate

Pull the Table Top with the Extension plate back until it is locked.
Place the mattress on the Extension plate.

6.2.3 Preparing the Patient Table for the patient

NOTICE   
Before preparing the Patient Table for the patient, check that the Quality Assurance (QA)
procedure has been carried out. For more information on QA, see 7.2 Sonalleve MR-HIFU Quality
Assurance (QA) procedure.

Preparing the Patient Table for use with a gel pad
To prepare the Sonalleve Patient Table for the treatment session, when using a gel pad:
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Open a gel pad package and visually check that the gel pad is not damaged.

Fig. 65: Gel pad.

Pour a small amount of degassed acoustic contact liquid onto the ultrasound window until the
membrane is fully submerged. Try to disturb the liquid as little as possible to avoid creating air
bubbles. Never shake the bottle used to store the liquid.

Visually check that there are no air bubbles in the contact liquid. If any bubbles are visible, move
them to the edges of the ultrasound window.

Place the gel pad on top of the ultrasound window, start with one edge then carefully “roll” the
pad into position ensuring no air gets trapped beneath it.

Place an absorbing cloth on the Patient Table around the ultrasound window to absorb spilled
contact liquid. Secure the cloth in place with adhesive tape.

Place the gel pad holder around the gel pad.
Place the appropriate mattresses, such as the footrest and other pads on the Patient Table.

If your Sonalleve MR-HIFU system is equipped with DISC that has been installed as an upgrade,
always use a mattress so that there is no skin contact to DISC connectors and hoses.

Protect the mattresses with disposable sheets.
Test that the PESB works before starting the procedure.
Run the membrane bubble detection scan (start a new exam and select Sonalleve ExamCard

“Verifications prior to the patient”). Verify that there are no air bubbles in between the membrane
and gel pad; remove air bubbles if detected.

Preparing the Patient Table using DISC without a gel pad
To prepare the Sonalleve Patient Table for the treatment session, when using DISC without a gel
pad:
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Pour a small amount of degassed acoustic contact liquid onto the DISC window membrane until
the membrane is fully submerged. Try to disturb the liquid as little as possible to avoid creating air
bubbles. Never shake the bottle used to store the liquid.

Visually check that there are no air bubbles in the contact liquid. If any bubbles are visible, move
them to the edges of the DISC Patient Table window.

Place an absorbing cloth on the Patient Table around the DISC Patient Table window to absorb
spilled contact liquid. Secure the cloth in place with adhesive tape.

Place the appropriate mattresses, such as the footrest and other pads on the Patient Table.
If your Sonalleve MR-HIFU system is equipped with DISC that has been installed as an upgrade,
always use a mattress so that there is no skin contact to DISC connectors and hoses.

Protect the mattresses with disposable sheets.
Test that the PESB works before starting the procedure.

6.3 Preparing the patient

Patient preparation generally includes depilation, catheterization, and mild pain medication. For
detailed instructions, refer to the Application Guide.

WARNING   
Check whether the patient has received medications, contrast agents, or has any
contraindications for MR. Check if the patient is receiving medications for any underlying
medical condition.

NOTICE   
The rationale for this check should be explained to the patient.

WARNING   
Only liquid is allowed in the catheter. Never fill the catheter with air as it may deflect the
ultrasound beam.

6.3.1 Positioning the patient on the table

The Sonalleve Patient Table may be used for transporting the patient short distances only, such as
from the preparation room to the RF room. For longer distances, use a standard hospital bed.

WARNING   
Falling from the height of the Sonalleve Patient Table may be dangerous. Support the
patient and/or use straps, and be prepared to prevent him/her from falling. Make sure that
the patient's limbs are within the edges of the Patient Table so that they are not pinched.
Instruct the patient to lie still when being transported on the Sonalleve MR-HIFU Patient
Table. Pay particular attention to thresholds.

NOTICE   
The reasons for these precautions should be explained to the patient.
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Show the patient how to safely climb on and off the Sonalleve Patient Table. Falling from the height
of the Sonalleve Patient Table may be dangerous. Support the patient and be prepared to prevent
him/her from falling. Never allow the patient to put weight with their hands or knees on the
ultrasound window as applying excessive force in this area may damage the ultrasound assembly.

Position the patient on the Patient Table with the area of interest over the center of the treatment
window. The patient can be in the prone, supine or oblique orientation depending on the application
and the area of interest.

Try to keep as good skin contact as possible. Check that there is no clothing or absorbing
material between the patient and the gel pad or DISC.

WARNING   
Never leave an unconnected coil in contact with the patient.

Attach the infusion bag and IV tubes and secure the possible urine catheter bag in its place.
Assist the patient in finding a comfortable position for his or her head and arms.
You can use air bags, vacuum cushions, straps, and other similar MR-compatible supporting

aids to make the patient's position more stable and make the patient feel more comfortable.
Position the HIFU Coil on top of the patient. The Flex coil can be bent over the target anatomy.

Do not bring the Flex coil edges closer than 15 cm apart from each other.
Secure the coil in place with the straps. Isolate the coil cable from the patient.

Fig. 66: Flex coil

WARNING   
Never leave the coil cable in contact with the skin, as localized RF heating may cause skin
burns. Use pads between the skin and the coil cable.

Give the patient the PESB and instruct them how to use it. See 2.5.1 Patient Emergency Stop
Button (PESB).

Give the patient ear plugs and a headset.
Release the Table Top by pressing the release button and push it into the magnet bore until you

hear a "click" sound and a short audio signal.
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WARNING   
Make sure that no pulling force is exerted on the catheters or IV tubes when you are
pushing the patient into the magnet.
Failure to follow this instruction may cause the patient pain and tissue damage.

Fig. 67: Patient positioning.

6.3.2 Verifying the patient positioning

Instructions for R12.2 and R5.8 software releases:
Philips R12.2 and after: Prior to MR-HIFU treatment, the Local Disk space shall be checked.

Philips R12.2 and after: Check Local Disk space of MR imaging device by entering to Patient
Directory and view the Local Disk space.

Fig. 68: Open Patient Directory (R12.2.)

Philips R12.2 and after: Review Local Disk space.

Fig. 69: Review Local Disk space (R12.2.)

Philips R12.2 and after: In case local disk space is less than 25%, delete the data that is not
required to be stored locally. This procedure shall be performed prior to Sonalleve MR-HIFU
treatment to avoid a situation where local disk space runs out during MR-HIFU treatment.

6 Workflow > 6.3 Preparing the patient

Instructions for Use  
109011C / 2025-12

102 (206)



1. 
2. 
3. 

4. 

5. 

4. 

Fig. 70: Select the patient data that can be deleted from MR Local Disk
database. (R12.2.)

Philips R12.2 and after: Start a new examination on the MR console.
Fill in the mandatory patient data.
Autopush images to Sonalleve.
Navigate to Auto-export settings.

Fig. 71: Navigate to Auto-export settings.

Select Marked series for Sonalleve MR-HIFU after navigating to Auto export settings.

Fig. 72: Select Marked Series.

Select the Sonalleve folder and the Therapy ExamCard that corresponds to the chosen
patient position and orientation.
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Fig. 73: Therapy ExamCard in Philips MR SW R12.2.

Philips R5.8 and before: Start a new examination on the MR console.
Fill in the mandatory patient data.
Autopush images to Sonalleve.
Select the Sonalleve folder and the Therapy ExamCard that corresponds to the chosen

patient position and orientation.
Select the patient position.
Turn on Autopush.
Autopush will automatically send all images to the Sonalleve console.
Go to the Scan context menu and select Push to Workstation.
Select Yes to Sonalleve in the ExamCard Push node.

Fig. 74: ExamCard Push setting.

Fig. 75: Therapy ExamCard in Philips MR SW R5.8.
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Scan Survey.
Activate the Offset scan.
Open the Offsets page (offc/ang).

Fig. 76: The Offsets page in Philips MR SW R12.2.

Fig. 77: The Offsets page in Philips MR SW R5.8.

Position the center of the slice to the center of the treatment area.

Fig. 78: Positioning images.

Check the offsets to see how much the patient needs to be moved in each direction.

Direction + / - Move the patient

R-L + Right

- Left

H-F + Into the scanner

- Out of the scanner
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Fig. 79: An example of offsets. R12.2.

Fig. 80: An example of offsets. R5.8.

To move the patient according to the measurements:
Release the Table Top and pull it out of the magnet bore.
Loosen or remove the Sonalleve coil and ask the patient to move according to the

measurements, assisting them if necessary.
Tighten the upper coil again, push the table back in. Reset the Offsets to 0. Scan a new

survey and analyze it again. Repeat until the treatment area is in the center of the ultrasound
window.
Scan skin bubble, and optionally, scar verification scans. The Autopush setting will

automatically send all images to the Sonalleve console. Scars or skin folds (see the following
images for examples) that cannot be protected, surgical clips, or air bubbles should not be in the
treatment area.

Fig. 81: Scars in the treatment area.
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Fig. 82: An artefact caused by a surgical clip (1), an air bubble (2) and a
skin fold (3).

If needed, pull the Table Top out and reposition the patient. Push the Table Top back in and
scan the survey and bubble/scar verification scans again.

WARNING   
The system displays the message "Push Table Top into Place and Check Patient
Positioning" if the Table Top is not locked in position. Carefully verify that the Table Top  is
properly locked in its intended position. Failure to detect unintended Table Top movement
may eventually lead to misplaced heating and tissue damage.

6.4 Scanning the planning images

WARNING   
Pay attention to patient orientation selections in MR and Sonalleve consoles. Failure to do
so may result in heating of wrong location and painful experience or injury.

NOTICE   
To prevent unexpected changes in image quality, always test all protocol changes that may affect
image quality before using them.

Scan the planning image set.
Position the slices over the treatment area as instructed in the Application Guide.
When ready, send the images to the Sonalleve console using Autopush or DICOM network

export. Select Patient → Administration, select the images and click Export.

6.5 Preparing the monitor scan

WARNING   
If you are using REST slabs, position them outside the intended heating volume so that they
do not saturate the signal from structures (near or far field) intended for temperature
monitoring.
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WARNING   
Always use the pre-determined and tested temperature measurement ExamCards and
protocols for temperature mapping.
The use of other protocols may lead to unexpected image quality or inefficient temperature
detection, which may then lead to overheating of tissue, insufficient treatment, unintended
heating locations and tissue damage.

WARNING   
Use the predetermined and tested coil combinations for temperature mapping.
The use of other coils may lead to unexpected image quality, excessive SAR or inefficient
temperature detection, which may lead to e.g. overheating of tissue, insufficient treatment,
misplaced heating and tissue damage.

NOTICE   
If the near-field monitor slice is positioned within the subcutaneous fat layer, the monitoring scan
may not properly detect temperature changes in the near field. This may lead to:

Temperature maps showing lower than actual temperatures in the near field.

Thermal dose calculations showing smaller than the actual dose in the near field.

No or delayed warnings about heating in the near field warning zone.

Erroneous stack positioning increases the risk of burns, as the skin or the muscle behind the
subcutaneous fat layer could then be heated without noticing.

NOTICE   
In the Uterine application, you can place a Freehand ROI in the far-field stack.

NOTICE   
You should repeat the test sonication if the temperature mapping scan protocol is modified in any
way, e.g., if a REST slab is moved or resized.

NOTICE   
On the MR SW 5.8 scanner and earlier, Push to Workstation must be active to ensure that the
images are transferred to the Sonalleve console. Also make sure that the Enable Automatic Start
Scan or, with MR software R3 or R4, Automatically Start Scan setting is off to ensure that the
slices are positioned correctly.

MR SW R12
In Philips MR SW R12.2, images can be pushed to Sonalleve by enabling “Auto Export” for each of
the scans.
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Fig. 83: Auto sending to Sonalleve done by selecting “Mark for archive” for
each of the selected scans. The setting is available starting from MR SW
R12.2.

MR SW R5.8 push to workstation
In Philips MR SW R5.8 images are pushed by enabling a Enable Autopush setting for each of the
scans.

Fig. 84: Push to Workstation must be active to ensure that the images are
transferred to the Sonalleve console. Left: In MR software R5 the setting is
in Advanced Properties, accessible through the right-click drop-down menu.
Right: The setting in MR software R3 and R4.
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Fig. 85: Automatic start of scan must be disabled to ensure that the slices
are positioned correctly. Left: The Enable Automatic Start Scan setting
disabled in the Examination menu of MR software R5. Right: The
Automatically Start Scan setting disabled in MR software R3 and R4.

Fig. 86: Automatic start of scan must be disabled to ensure that the slices
are positioned correctly. With the right mouse click, select Pause before
scan to disable automatic start of the scan. R12.

You must enter the patient information and position the temperature mapping slices on the MR
console before starting the temperature mapping scan on the MR scanner.

Select the predefined temperature mapping protocol.
Position the monitor slices.

In the Uterine application:
Stack C to the abdominal muscle behind subcutaneous fat layer.
Stack D to the nearest far-field structure to be avoided.

In the Bone application:
Stack D to the muscle in the near field.

-
-

-
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Fig. 87: An example of positioning the monitor slices in the Uterine
application.

Fig. 88: An example of positioning the monitor slices in the Bone
application.
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NOTICE   
For more details, refer to the Application Guides.

Check that CLEAR=yes. This enables temperature map calculation.
Select the fat-monitoring protocol.
Position the center of the slice stack over the subcutaneous fat layer in coronal plane. Do not

angulate. When the fat layer is thick, position the slices to that location within the fat where you
want to monitor fat temperature. When the fat-monitoring protocol is prepared for scanning, it will
be automatically acquired after the post-sonication temperature map scan. The scan is, however,
not run after low energy sonications, such as test sonications. The system alerts to any issues with
the fat monitoring scan that prevent the calculation of the cooling time.

Fig. 89: Clicking the Fat monitoring status indicator icon displays more
information about the issue.

Fig. 90: An example of positioning the fat-monitor slices in the Uterine
application.
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6. For Philips MR SW R5.8 and earlier: Start the temperature mapping scan. The scanner is now
under remote control.

WARNING   
Always enable the remote control mode of the MR console as early as possible to allow a
minimum of 5 minutes of water circulation in DISC system before the first therapy
sonication. Failure to do so may increase risk of bubble formation in the ultrasound contact.
See air bubble related warnings and instructions.

Fig. 91: Scanner under remote control.

Fig. 92: Scanner under remote control (MR SW R12).
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6.6 Therapy planning

6.6.1 Starting Therapy in the Sonalleve MR-HIFU application

Fig. 93: Starting Therapy.

In the start page of the Sonalleve MR-HIFU application, select the appropriate clinical application
in the Application list.

Select Therapy in the Mode list.
Click the Therapy application selection button.

NOTICE   
The Application list only displays those clinical applications that have been installed and
configured for use.

NOTICE   
For ablation of adenomyosis tissue, select Uterine in the Application list.

6.6.2 Entering patient information

Fill in the patient’s body temperature and select the correct gel pad thickness from the drop down
menu. Then proceed to the next page.
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It is essential that the patient’s actual body temperature is used as a temperature reference. Check
the patient's body temperature with a reliable thermometer immediately before the therapy and, if
necessary, re-check it at regular intervals.

WARNING   
Incorrect body temperature may affect the success of the treatment. Always use the actual
body temperature as a reference value.

WARNING   
Always set the gel pad thickness in Sonalleve user interface to match the actual gel pad
thickness that is used in the treatment. Failure to do so may increase risk of burns in skin
and other near-field tissues.

If you are using DISC without a gel pad, select No gel pad.

Fig. 94: Patient information entry window.

NOTICE   
The available choices for Gel pad thickness may be different in different applications and for
different system hardware.

6.6.3 Retrieving the image sets

Retrieve the planning images from the MR console.
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Fig. 95: Image set retrieval window for versions R3.7 to L3.

For versions R3.7 to L3:

To display recently exported image sets, click Query. The images are filtered according to the
patient ID, i.e. only the images of the patient that is currently being treated are retrieved.

Double-click an image set or select multiple image sets, and click Retrieve. The most
recent images are automatically shown. Proceed to the next page.

To select another image set right click on any of the four windows on the image area to display
the desired images.
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Fig. 96: Image set retrieval window for versions R3.7 L4 and newer.

For versions R3.7 L4 and newer:

Images are automatically queried in the background and displayed as soon as they become
available from the MR scanner. The images are filtered according to the patient ID, i.e. only the
images of the patient that is currently being treated are retrieved.

Double-click an image set or select image set, and click Retrieve. The most recent images are
automatically shown. The current selection is indicated with bold text. Retrieved images are shown
with a green check mark icon. Proceed to the next page.

To select another image set right click on any of the four windows on the image area to display
the desired images. Alternatively, double-clicking an image set will also display the selected
images.

NOTICE   
You can return to the image set retrieval stage at any time.

NOTICE   
Retrieving phantom or patient images before the patient is positioned on the table may cause
inaccuracy in the system-recommended cooling times.
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6.6.4 Defining the Planning Target Volume

Define the Planning Target Volume (PTV) by drawing it on the planning images.

Fig. 97: Planning Target Volume delineation.

Add PTV by clicking the Add button.
 

Draw the Planning Target Volume on top of the images. If you are using several PTVs, you can
give them descriptive names.

Scroll the images to view the Planning Target Volume on all slices.
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6.6.5 Defining the Tissue Boundary

Go to the Tissue Boundary tab and define the Tissue Boundary by moving the first line to match the
skin position and the second line to match the fat-muscle boundary.

Fig. 98: Defining the Tissue Boundary

Start editing the tissue boundaries by selecting one of the lines.
Move the tissue boundaries by moving the lines or handles. If needed, add or remove handles

by double-clicking the line. To return the tissue boundary lines to the default position, click Reset.
Check that there is enough water in the DISC. A curved skin/membrane boundary may indicate

that the water level is too low.
The tissue boundary lines should be long enough that the transducer beam is contained within

the contoured area in all of the future sonications. If necessary, change the length of the line by
dragging the end handle.

NOTICE   
Tissue boundaries are not allowed to intersect and there are also some restrictions on positioning
them. A red cross mark indicates invalid position for the boundary while editing lines.

Fig. 99: Indication of invalid position for tissue boundary

Scroll the images to view the skin position and the fat-muscle boundary on all slices. Current
image slice is shown in bottom right corner.
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Fig. 100: Slice navigation view

Center the view to all PTVs to check all boundaries.
Confirm the boundaries by accepting.

WARNING   
Make sure to scroll through all images to find any non-uniformities in the tissues.
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6.6.6 Positioning the treatment volume

WARNING   
Positioning:

Always leave sufficient safety margins to sensitive organs or other sensitive structures
when drawing Planning Target Volumes or cells.

Avoid placing treatment cells any closer to the spine or other sensitive structures than
indicated by the far-field safety margin. If this is not possible due to anatomic
constraints, monitor the sonication carefully and be prepared to stop it if needed.

Avoid placing treatment cells any closer to the uterine serosa or any other tissue to be
spared than indicated by the cell safety margin. For example, heating of the uterine
endometrium may need to be avoided for patients who might wish to become pregnant in
the future. If this is not possible due to anatomic constraints, monitor the sonication
carefully and be prepared to stop it if needed.

Pay special attention to objects directly in the transducer beam area, not forgetting the
far field.

Air-filled structures and bones might cause unexpected reflections.
Bowel should never be in the near the field beam path. Heating the bowel may lead
to bowel perforation.
Heating in the far field might lead to sciatic nerve damage / peritonitis.
Some structures absorb the ultrasound waves completely, leading to more efficient
heating. Bone, bowel, clips, scars or any other rigid structure or air interface are
such structures.

Sonication through scar tissue, skin folds or navel should be avoided to prevent
damage. The beam shaping feature may be used to protect these. QuickCover
Ultrasound Protective Covers may be used to protect scars.

The planning graphics show the main part of the 3D focused transducer beam, but keep
in mind that boundaries such as air-filled structures and bones may cause unexpected
reflections.

WARNING   
The displayed transducer beam does not take sonication power or duration into account. At
the highest sonication energies (large cells and high powers), you should leave at least a
few millimeters margin between the displayed transducer beam and any vital organs, with or
without beam shaping.

NOTICE   
During actual therapy sonications, the 30 EM thermal dose contour should be used as another
measure of the probably affected area.

Sonication with electronic X deflection requires higher power levels and thus also larger safety
margins.

NOTICE   
The orientation of the image on the screen is not always according to the radiological convention
used in the MR console. The image orientation can be seen in the anatomical orientation
indicators.

-
-

-
-
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Do not expose the tip of the Foley catheter to ultrasound, if the tip is touching the bladder wall.
Such exposure could lead to local heating, irritation, pain, hematuria, or damage of the bladder
wall.

WARNING   
In the Bone application, position the treatment cells so that the transducer beam is
perpendicular to the bone surface. Otherwise unintended heating of adjacent tissues due to
ultrasound reflections may occur. Carefully observe such situations in the temperature map
during sonications.

Position treatment cells within the Planning Target Volume (PTV).

Graphically select a transducer position. The cells are placed on a Treatment Plane created by
the transducer position. When the first cell is positioned, the transducer position is locked and a
cluster is created. The transducer position is visible as a tool tip when you move the pointer over
the cluster.

Fig. 101: When the first cell is positioned, the transducer position is locked
and a cluster is created.

Select the treatment cell type and size from the drop-down list.
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If you wish to add more than one cluster for a single transducer position, click the Add Empty
Treatment Cell Cluster button.

 

If you do not add any clusters, all cells will be added to the same cluster.

Fig. 102: Treatment cell selection.

Check the beam of each of the cells. The beam must not travel through air or sensitive
structures, and there must not be unprotected scars in the ultrasound beam path. Verify that safety
margins are observed. See the following figure.

-

-
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Fig. 103: Checking the transducer beam positions.

You can move cells in a cluster using the Select button.

You can move the treatment cluster with cells with the Move Treatment Cell Cluster button.

For hints and tips on placing the cells optimally, see the Application Guide.
If the cell you have placed is not treatable with the current transducer position, it will be marked
with a cross and the system issues a warning message. Select the cell and move it to another
location.

How to use markers and why ?

Add graphical markers to anatomy landmarks in planning images.

You can add markers at the Transducer Positioning stage and at any time after that. Select
Marker from the drop-down menu of the Add tool button.

Compare the location of the markers and the anatomical landmarks to detect patient movement
and image distortions.

The markers are visible in all planes.

Choose landmarks that you can also recognize in temperature map images.

In the following figure, the markers have been placed around the fibroid to be treated.
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Fig. 104: Markers in sagittal and coronal images.

6.6.7 Beam shaping

The beam shaping feature enables the user to reduce the intensity of the ultrasound field in
selected regions in the near field. These regions should be located close to the patient's skin, and
may include e.g. air bubbles, scar tissue, and skin folds. Identify the region where reduced
ultrasound intensity is desired by drawing an organ avoidance region (OAR) object around it. All
drawn OARs are shown in the Regions of Interest list in the Treatment Cell Planning page and
on the Replanning tab of the Therapy page.
The following figure shows how an OAR ROI is drawn to prevent heating of a scar.

Fig. 105: An OAR ROI drawn to prevent heating of a scar.

Reduction of the ultrasound intensity is achieved by disabling some of those transducer elements
that contribute to the ultrasound field in the OAR region. To ensure that ultrasound intensity at the
treatment cell is not affected, ultrasound intensity delivered by the remaining active elements is
increased accordingly. This compensation leads to a corresponding ultrasound intensity increase in
those areas which are not protected by an OAR.
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Use of the beam shaping feature or electronic deflection increases near-field heating. In these
situations it may be necessary to use longer cooling times than recommended by the Sonalleve
system.
OARs should be drawn which accurately reflect the shape of the region where intensity reduction is
desired. In order to ensure sufficient protection, they should always extend at least 2 mm outside
the edges of the region where protection is desired. Several OARs may be drawn to protect e.g. 3D
objects. However, software calculation speed suffers as the number or size of OARs increase, so it
is not advisable to draw more or larger OARs than needed.

Fig. 106: The visualization of the beam path and the ATA affected by an
OAR.

Only use beam shaping in the near-field side of the transducer beam.
OARs should be drawn in the coronal plane. After drawing OARs, always check the resulting
shape of the transducer beam visually in a sagittal or transverse slice set. Make sure that the
displayed transducer beam does not penetrate the OAR anywhere. When using an OAR to protect
a region with scar tissue, also verify that the scar tissue lying deeper is excluded from the beam. If
the transducer beam overlaps with any of the regions where protection is desired, do not start the
sonication. Position the treatment cells so that OARs remain outside the treatment cell safety
margin.
If higher than normal tissue protection level is desired, a critical OAR should be used. It reduces
the ultrasound intensity more than regular OAR, but otherwise has same functionality.

QuickCover Ultrasound Protective Cover
Scars and other superficial objects can be protected from acoustic energy also by placing a
QuickCover Ultrasound Protective Cover on top of the object that is to be protected. These
protective cover strips are water-resistant and visible in MR images. The back of the strip is self-
adhesive to ensure that the cover does not move during the treatment.
Whenever feasible, use beam shaping together with the QuickCover Ultrasound Protective Cover
to ensure maximal protection of the scar tissue.
QuickCover Ultrasound Protective Covers may not be available in all countries.
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Fig. 107: The correct use of QuickCover.

WARNING   

QuickCover only provides protection for the superficial tissue layer immediately behind
the cover strip.

Using protective cover strips side-by-side may lead to distorted heating due to the large
area of blocked ultrasound beam.

Using protective cover strips side-by-side may lead to transducer damage due to the
large intensity of reflected ultrasound.

Air bubbles trapped on the skin at an edge of a protective cover strip may lead to a local
skin burn. This risk is especially pronounced if protective cover strips are used so that
they overlap with each other.

Storing QuickCover strips under a weight may lead to compression and a permanent
loss of protective capabilities.

6.7 Preparing the system for sonication

6.7.1 Hardware Initialization

The treatment cannot be started until the hardware initialization is successful. Planning is possible
during hardware initialization.

NOTICE   
The MR scanner cannot export images to the hospital network once Network Isolation is in
progress. Before starting the Hardware Initialization, make sure that there are no image export
tasks running or queued on the MR workstation.

Press the green Enable button on the Safety Device to enable the ultrasound generators.
Perform the hardware tests. If any of the tests fail, check the message log for problems in the

system. Retry until the tests succeed.
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Fig. 108: Hardware initialization.

WARNING   
If the system detects a transducer movement failure, it stops the treatment and issues an
error message. You must rerun the Hardware Initialization.

6.7.2 Scanning Temperature Mapping

Scan the temperature mapping protocol:

To see the image quality and any possible artefacts.

To verify the position of REST slab, if used.

To place Freehand Warning ROIs.

To verify the visibility of markers.

To verify the positioning of near-field (and far-field) monitor slice stacks.

Go to the Scan tab of Therapy stage.
Select the predefined temperature mapping protocol from the drop-down list of scan protocols.
Start the scan.
Stop the scan when multiple temperature maps have been acquired.
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Fig. 109: The Scan tab.

6.7.3 Test sonication

WARNING   
If the couch has been unlocked for any reason, always perform a test sonication once the
Table Top has been pushed back to the treatment position.

It is recommended to repeat test sonication always when the Table Top lock or the trolley brake
lock is re-engaged after being released. A test sonication is a short, low power sonication which
usually heats the tissue by only a few degrees. Test sonication is automatically done with the 4 mm
regular cell type.
You must perform a test sonication in each treatment cell cluster before you can start the actual
therapy sonications in that cluster.
It is recommended to perform a test sonication also when the sonication frequency is changed. The
purpose of the test sonication is to correct the actual heating location to match the planned cell
position. The actual heating location is indicated with an offset marker (a green cross). The test
sonication also helps you in determining the correct power level for the treatment cell size. It
provides information you need for selecting the correct power level.

NOTICE   
In the Bone application, the test sonication is not used to correct the offsets. In the Bone
application, the user should verify that the heating takes place in the expected location.
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Fig. 110: Selecting the cell and power level for a test sonication (the GUI
appearance and parameter values may vary according to application device
version).

Select a cluster and a treatment cell. No matter which size and type of cell you choose, the test
sonication treats it as a regular 4 mm cell.

Select Test Sonication.
Using the Power slider, select a power level that is low enough to not cause thermal dose in the

tissue. For additional tips, see the Application Guide.
Click the Start Sonication button to start the test sonication.

 

The temperature scan starts automatically.
View the temperature maps in the Decisions tab to verify that the heating occurred in the

intended location. The offset marker (a green cross) should automatically appear at the center of
the heating both in coronal and sagittal planes. In those rare cases when it does not, drag the
offset marker to the center of the heating manually. Correct the offset in RL and HF directions in the
coronal image and in AP direction in the sagittal image.

Fig. 111: Test sonication.

6 Workflow > 6.7 Preparing the system for sonication

Instructions for Use  
109011C / 2025-12

130 (206)



6. 

7. 

8. 

Fig. 112: If the offset marker does not appear at the center of the heating,
drag the offset marker to the center of the heating manually.

Fig. 113: When you move the offset marker, another marker appears at
where the system-calculated estimate was.

Accept the offset correction by checking the Proceed to Therapy Sonications box.

Fig. 114: Accepting the offset correction.

If the offset exceeds 5 mm (over 2 pixels) in any direction, repeat the test sonication after
accepting the offset correction.

Repeat until the offset is acceptable, then proceed to therapy sonications.

NOTICE   
If necessary, you can perform test sonications at any time during the Therapy stage. To test
sonicate, choose Test Sonication and a low power level. You can also correct the offset after a
therapy sonication by dragging the offset marker or by clicking the button Use System-calculated
Estimate.
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If the test sonication fails

Therapy sonications cannot be started before the test sonication is successful. If the software fails
to locate the center of the heating due to insufficient heating (the maximum temperature is less
than 42 °C (107.6 °F)), you will see the following warning in the Decisions tab:

Fig. 115: Not enough heating to detect the heating location.

In such a case, repeat the test sonication with higher power. Alternatively, drag the green offset
marker to the center of the observed heating manually, and then perform a new test sonication to
verify the correction. If the test sonication does not succeed, take the following steps to determine
the reason for the failure:

If you do not see any heating within 2 cm (0.8 inch) of the intended location, check that you have
the latest image. This will rule out possible problems with updating the images.

To make sure that the scanner table is completely down, check the scanner table height.
If you do not see any heating in the intended location, look at heating outside the intended

location. If you can see some heating, drag the offset marker to the center of the observed heating.
If you have the latest image and you can see some heated pixels in the heated area, repeat the

test sonication with a higher power level. Increase the power level by the smallest step available.
Stop before using a power level that could cause thermal dose in the tissue. If no heating takes
place at safe test sonication power levels, stop the treatment and remove the patient from the
table. Use a phantom and troubleshoot the reason for the power loss.

6.8 Therapy

 The Therapy stage includes five tabs for carrying out different actions during the treatment:
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The Replanning tab allows you to select, add or remove treatment cells and add markers to aid
in monitoring.

On the Sonicate tab, you can start, stop and monitor the progress of the sonication.

On the Decisions tab, you can accept or adjust the heating location.

The Analysis tab displays the temperature curve for a cell or a profile and sonication statistics of
the selected treatment cell.

On the Scan tab, you can start intermediate scan protocols to monitor the progress of the
treatment.

In addition, you must plan the sonication order and determine the power level to be used for each
treatment cell type.

6.8.1 Replanning

This stage is not mandatory but can be performed before starting the sonication treatment.

If necessary, you can add, move or remove treatment cells.

You can also add graphical markers around anatomies to monitor patient movement. See
6.6.6.1 How to use markers and why ?.

You can add a freehand Warning ROI to monitor slices. Mark anatomical structures where
temperature rise is not wanted. The warning temperature level can be edited.

You can add OARs.

6.8.2 Planning the sonication order

The Sonalleve MR-HIFU system allows you to sonicate the treatment cells in any order. However,
the following general guidelines apply to the sonication order:

To avoid unnecessary heating in the near field (skin or the inner margin of the subcutaneous fat
layer, abdomen), start the sonications from the cells on the treatment plane deepest within the
body.

Treat all the cells on a treatment plane before moving on to the next plane.

Clusters can be used as an aid in planning the sonication order.

To minimize the risk of heating the skin or the inner margin of the subcutaneous fat layer, avoid
successive sonications in the same cluster. Instead, move between clusters/target volumes in
different parts of the Total Treatment Volume. This allows for better cooling and more even
heating in the volume.

6.8.3 Determining the correct frequency level for a treatment cell

Ultrasound attenuation is a function of ultrasound frequency in biological tissues.

Use the lower frequencies when near field heating is to be avoided.

Also use the lower frequencies when higher ultrasound penetration into the bone is required.

Use the higher frequencies when near field heating is not an issue but far field heating is to be
avoided.
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6.8.4 Determining the correct power level for a treatment cell

To ensure that the treatment volume heats sufficiently, but not excessively, you must determine a
suitable initial power level for each treatment cell size. When you have sonicated the first few cells
with this power level, you should evaluate the results and adjust the power level based on them.

WARNING   
Start therapy with low energies and observe carefully temperature changes during the first
sonications. Failure to do so may cause heat spreading outside of the intended region
causing unintended tissue damage and pain.

WARNING   
Use the high powers above 250 W in the Uterine application only if lower powers do not
produce temperature elevation high enough for ablation. Consider the risk of unintended
damage to nearby sensitive organs and structures when using the high powers. Carefully
monitor the heating in the near field, far field and near sensitive organs and be prepared to
stop the sonication immediately if needed.

The power levels in the following tables guide you in selecting the correct power level based on the
temperature rise in test sonication (in the Uterine application).

Fig. 116: Sonication power for a 4 mm treatment cell with nominal
duration (assuming the body temperature is 37 °C).

For cells larger than 4 mm, longer sonication durations increase the risk of near-field heating, so a
higher power level is recommended for feedback cells than for regular treatment cells.
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Fig. 117: Sonication power for 8, 12, 14 and 16 mm treatment cells
(assuming the body temperature is 37 °C).

In the Bone application, for cells in different locations than the test sonication, the power level to be
used must be adjusted proportionally to the area of the heated surface. For example, if the
diameter of the heated surface were twice the diameter of the heated surface in the test sonication,
the power level would need to be multiplied by four. For this reason it is recommended to use a
similar heated surface for all cells. Start at lower power values and progressively increase the
power until the temperature measured at the bone surface meets the target temperature.

WARNING   
Use the high powers in Bone application only if the lower powers do not produce high
enough temperature elevation and when there are no major safety concerns (e.g., excessive
near field heating).

6.8.5 Adjusting the sonication duration for a regular treatment cell

The sonication duration of 4 mm, 8 mm and 12 mm regular cells can be adjusted in the Uterine
application. Increasing the duration may help in situations where the nominal duration does not
deposit sufficient amount of energy to the target tissue. Note that increasing duration will
significantly increase the near field heating and thus also the cooling time.

WARNING   
Increased durations should only be used on highly perfused or vascular tissue, where
nominal duration is not sufficient to produce sufficient ablation volume. If duration is
increased on non-perfused tissue, the safety margins may be insufficient/compromised.

6.8.6 Sonicating

Inform the patient that you are about to start the treatment.
Select the cell to be sonicated on the Replanning tab. Start from the cells on the treatment

plane deepest within the body.
Go to the Sonicate tab and select Therapy.
Select the sonication frequency and the power from the Power slider.
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Fig. 118: Replanning and Sonicate tabs (the GUI appearance and
parameter values may vary according to application and device version).

Select the sonication duration from the Duration slider (duration adjustment is available for
some regular cells in the Uterine application).

Click the Start Sonication button to start the sonication.
 

The temperature monitoring scan will start automatically.
The sonication will stop automatically when the sonication duration for the cell has been reached.
You can stop the sonication manually by clicking the Abort Sonication button.

 

Monitor the temperature curve and temperature maps throughout the sonication. If you observe
any sudden temperature changes, stop the sonication immediately. Especially observe any
unintended significant temperature increase close to the treated area. For a description of the
displays and graphs, see 5.10 Controlling and monitoring the sonication.
After the sonication stops, a post-sonication temperature monitoring scan follows automatically.
The system may also automatically start a fat-monitoring scan after the post-sonication
temperature monitoring scan.

Analyze the sonication (see 6.8.7 Reviewing the sonication results during the cooling time) and
move on to the next treatment cell.
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WARNING   
Visually monitor the temperature maps in the monitor slices during the sonication. If you
see a sudden change in temperature, stop the sonication immediately using the Stop button
on the Safety Device or the software abort button. Do not continue treatment until you have
discovered a cause for the change. A sudden change in temperature can be caused by:

Excessive heating due to failure in the US device or US coupling.

An artefact caused by patient movement.

An external or internal magnetic field change.

WARNING   
Patient movement during the treatment may result in misplaced heating and tissue damage.
Continuously monitor visible anatomical landmarks to rule out movement.

The Sonalleve Software provides graphical tools, such as markers, that can be used for detecting
movement of visible anatomical landmarks.

WARNING   
Stop the sonication if you do not observe any heating in the heating curve and temperature
maps. This could indicate presence of coarse positioning errors or a problem with updating
of the images or significant reflections at the tissue interfaces. Check the timestamps of the
displayed images. Make sure that the ultrasound coupling is acceptable starting with low
power test sonications. Failure to follow this instruction may lead to unintended heating of
tissue, tissue damage or painful experience.

WARNING   
Unintended heating of healthy bone marrow cannot be observed due to its high fat content.
Use sufficient safety margins when planning sonications of those areas that need to be
protected from excessive heating. Failure to do so may cause tissue damage in unintended
regions.

WARNING   
When treating bone metastasis, heating may take place in an unintended location if the
bone is damaged to the extent that it does not completely absorb the ultrasound beam.

WARNING   
Multiple treatments of the same volume may increase the risk of heat buildup, potentially
resulting in unpredictable tissue damage outside the planned cell. It is not recommended to
sonicate the same volume of tissue more than once.

6.8.7 Reviewing the sonication results during the cooling time

On the Analysis tab, check that the sonication time and the maximum temperature were at an
acceptable level. After a successful sonication also check the recommended power to optimize the
power for the next sonication.

Review the temperature maps to check that no unwanted heat buildup occurred in the near field
or far field. Usually you can see some colored pixels outside the heated area. For more
information, see 4.7.1 Misplaced heating or motion artefact?.
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If you want to analyze signs of near-field heating in more detail, use either of:
The Pixel Info tool.

 

The Profile Line tool, to display a temperature profile in the Temperature Curve on the
Analysis tab.

 

The temperature should not exceed 47 °C (117 °F) in the near-field monitor slice. If you repeatedly
observe high temperatures in the abdominal muscle, do not continue the treatment.
The tool buttons for Pixel Info and Profile Line are hidden by default, but you can add them to the
toolbar from the Tools → Toolbar Options menu.

Fig. 119: Temperature profile.

With the Analysis tab still selected, check if there are sonication-related warnings (in the
message area in the middle of the Hardware Status Area). If there are warnings, analyze if they
affect the next sonication(s).

WARNING   
Always leave sufficient cooling intervals between sonications.
Failure to do so may cause heat buildup in the near field or far field, leading to skin burn or
other unwanted tissue damage.

6.8.8 Registration

Registration is a feature that can perform the necessary corrections if any patient or organ
movement is observed during the treatment. For this, user has to identify correct positioning of the
PTV in two different image sets, one taken before the movement and another taken after the
movement.
When patient movement has occurred:

Scan a new planning image set.
Select the PTV Delineation tab.

 

-

-
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Fig. 120: PTV Delineation stage (the GUI appearance and parameter
values may vary according to application).

Select the PTV that you want to use for registration.
Select the new image set.
Select the Registration tab. A new empty Registration is created. The selected PTV is

highlighted in yellow.
Click inside the highlighted PTV in any viewport, and drag the PTV so that it is again in the

anatomically correct positioning. The registration appears on the list, with the image set's time
stamp.
After releasing the mouse button, the locations of all graphical objects (cells, PTVs, ROIs, OARs,
markers, etc.) are updated accordingly, and the displacement value is updated to registration item
on the list.

Fig. 121: Highlighted PTV moved.
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8. 

Verify that the OARs, markers, and other graphical objects are positioned correctly before
continuing the treatment. If necessary, correct the locations of misplaced OARs and other graphical
objects manually. Remember to use the latest, up-to-date image sets!

Fig. 122: Warning to check OAR and ROI positions.

On the Uterine Fibroid application the Tissue Boundary must be confirmed after registration.
Adjust the lines and confirm the boundaries by accepting. Make sure to scroll all of the images to
find any non-uniformities in the tissues.

WARNING   
Comparing OARs with images acquired before the registration may leave the OARs
misplaced. If OARs are not positioned correctly, there is a risk of skin burn.

Registration can be readjusted as needed, until the tab or stage is changed. Changing the tab or
stage confirms the location of the added registration. Afterwards, it is possible to modify the
registration by returning to the Registration tab and pressing the Modify button. The registration
selected on the list can be removed using the Delete button and edited using the Modify button.
Pressing the Delete button moves all objects back to their locations before the registration. Only
the latest registration on the list can be edited or removed.
If the registration exceeds a predefined limit, a new test sonication is required. The system will
immediately inform the user in the registration list whenever the movement in the added
registration exceeds the configured limit.

Fig. 123: Excessive movement indicating a test sonication is required.
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6.8.9 Scanning other protocols from the Sonalleve console

It is possible to scan other protocols from the Sonalleve console. These scans must be ready to run
on the MR console, and the Sonalleve specific parameters must be implemented.
To scan a protocol:

Go to the Scan tab.
Select the protocol from the drop-down list of scan protocols.
Start the scan.

The scan is automatically prepared and the scan starts after that. A yellow scanner status icon is
displayed while the scan is being prepared.

 

When the desired amount of dynamics have been acquired, stop the scan.

6.8.10 Saving the treatment data

Click the Report application button to create a Clinical Summary Report. The Clinical Summary
Report is a record of the actions taken during the treatment. It should be archived in the patient
records, along with records that verify the treatment outcome (such as post-treatment MR images).
In the File menu, you can select Save State to save the full treatment history.

NOTICE   
To export Saved States without patient data, use the Export De-identified tool available in the
Session Manager (menu item Manage States in the File menu).

Power users (see 10.7 Hospital administrator and user accounts) can also select Export Data in
the File menu to export numerical data from the treatment into a .csv (comma-separated values)
file.

6.9 Post treatment

Press the red Stop button on the Safety Device to disable the ultrasound generators.
Exit from Under Remote Control.

Make sure to stop the temperature mapping scan on the MR console.
Select and scan the post-treatment pre-contrast scans on the Therapy ExamCard if required.
Administer MR contrast agent to the patient.
Scan the desired post-contrast scans.
Retrieve the post-treatment images to the Sonalleve Console and make a saved state.
Release the Table Top and pull the Table Top out from the magnet. Help the patient down.
Interview the patient for pain and any other adverse effects of the treatment.

-
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6.10 Error recovery

The system automatically saves the current stage of the treatment as a Saved State file.

WARNING   
If the Saved State cannot be loaded, wait until the tissue has cooled before continuing the
treatment. Without the Saved State data, the system cannot estimate the effect of earlier
accumulated heating when recommending cooling times to prevent burns.

If the software crashes, take the following steps to recover:

Restart the Therapy application.
The Save State recovery dialog appears, asking you if you want to load the data from the

previous session. Answer Yes.

Fig. 124: Save State recovery dialog.

If the dialog does not appear automatically, select Manage States from the main menu and
select the last state from the Session Manager.

Perform a test sonication with low power before continuing the therapy after crash recovery.

If the Saved State cannot be loaded, wait until the tissue has cooled before continuing the
treatment. Without the Saved State data, the system cannot estimate the effect of earlier
accumulated heating when recommending cooling times to prevent burns.
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6.11 Removing the Sonalleve Table Top

Before using the MR system for diagnostic imaging, replace the Sonalleve Table Top with the
standard tabletop.

Press the red Stop button on the Safety Device to disable the generators.
If the Table Top Extension Plate is in use, unlock the plate by pressing the release buttons and

remove it. Put the detachable handle back in place. Ensure that  the handle is properly locked.
Unplug the Sonalleve Coil Cable(s) and the headphone cable from their sockets. Hang the

cables on their holders on the Sonalleve Patient Table.
Unplug the HIFU Coil cable. If your Sonalleve MR-HIFU system is equipped with an accessory

cart, place the coil and its cable in the holder on the accessory cart.
Disconnect the Sonalleve Control Cable and Ultrasound Cable. Place the cables in their holders

on the accessory cart. Wrap the cables around the accessory cart.
Disconnect the DISC hoses.
Release the brake pedal and move the trolley to its storage area.
Remove all pads and positioning aids from the Table Top, and clean the Table Top. For

recommended cleaning agents, see 7.3 Cleaning and disinfection.
Place the ultrasound window cover on the ultrasound window to protect the membrane from

damage.
With Ingenia MR scanners: Replace the thin Table Top used for diagnostic imaging, if it was

removed in order to position the Sonalleve Table Top.
Connect the MR Nurse Call Button and check that it functions.

Fig. 125: MR Nurse Call Button.

6.12 Sonalleve Patient Table storage

The Sonalleve Patient Table, gel pads and the QA phantom used with the Sonalleve MR-HIFU V2
system must be maintained above freezing temperatures to prevent any damage caused by the
formation of, and/or the expansion of ice.

Tab. 25: Storage requirements

Storage conditions

Temperature +5°C to +50°C

Humidity 5% to 95% relative humidity, non-condensing
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7 Maintenance
7.1 Routine maintenance

This product requires proper operation, routine checks and planned maintenance, to keep the
product operating safely, effectively, and reliably.

7.1.1 Planned Maintenance Program

Planned maintenance may only be carried out by qualified and authorized personnel, and is
comprehensively described in the service documentation. Profound Medical provides a full planned
maintenance and repair service on both a call basis and a contract basis. Full details are available
from your Profound Medical service organization.

7.1.2 User Routine Checks Program

The user of the product must institute a User Routine Checks Program as detailed in the table
below. The user of the product shall ensure that all checks and actions have been satisfactorily
completed before using the product for its intended purpose.

Tab. 26: User Routine Checks Program.

Check  Frequency

Daily Before every
procedure

Check that there are no visible leaks from the Sonalleve Patient
Table

✓

Quality Assurance procedure with the QA phantom ✓

Visually check that the cables, hoses, connectors and sockets are
undamaged

✓

Check that there are no visible cracks or other defects in the
ultrasound window

✓

Test that the PESB works ✓

Check that the water level in DISC is correct: read the gauge on
DISCfill

✓

Check that there are no large air bubbles visible through the DISC
patient contact

✓

Check that the water level in DISC is correct: the surface of the
patient contact should be flat

✓

Check that there are no obvious leaks from DISC ✓
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1. 

WARNING   
Daily inspect the Sonalleve MR-HIFU system and the magnet for leaks. The Sonalleve
Patient Table houses a liquid container. Do not connect the Sonalleve System Cables if you
find a leak. If a leak occurs during treatment:

  
• Terminate the sonication immediately using the Stop button of the Safety Device.

 • Remove the patient from the Patient Table.
 • Identify the reason for the leak.

 • To prevent further damage, remove the leaking part from the RF room.
 • Do not continue scanning or treatment until a qualified service engineer or equivalent has

examined the scanner and the Sonalleve MR-HIFU system.
  

A failure to follow these instructions may expose the patient or an operator to a risk of an
electric shock.

The system automatically monitors the humidity sensors in the transducer. The sensor readings are
automatically logged and the system generates warnings if excessive humidity is detected. If the
humidity continues to rise, contact the Profound Medical service organization.
If the humidity reaches a critical level, the system issues an error message and the sonication
stops. The transducer must be replaced. Contact the Profound Medical service organization.
If the device has been unused for two months, humidity will accumulate inside the transducer.
Connect the Sonalleve Patient Table, activate the Safety Device and leave active overnight to dry
the transducer.

DISC routine maintenance by the user

Checking the water level in DISC

If DISCfill is not yet placed on top of the ultrasound window, place it there. Ensure that DISCfill
leans evenly on the edge of the ultrasound window frame.
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2. 

NOTICE   
Do not leave any non-fluid material between DISCfill, the ultrasound window, and the ultrasound
window frame. Mattresses, disposable sheets, or a gel pad, for example, can prevent DISCfill from
settling in its intended position and make checking the water level in DISC unreliable.

Read the gauge on DISCfill.
When the indicator needle is within the white zone, there is enough water in DISC.
When the indicator needle reaches the red zone, refill DISC with water before the next HIFU
treatment.

Fig. 126: (1) When the indicator needle is within the white zone, there is
enough water in DISC. (2) When the indicator needle reaches the red zone,
refill DISC with water before the next HIFU treatment.

NOTICE   
When you lift DISCfill away from the ultrasound window, the indicator needle should drop to the
bottom of the scale. If the indicator needle does not move, contact Service.

-
-
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Adding water to DISC

Check the water level in DISC as instructed in the previous chapter. Leave DISCfill on top of the
ultrasound window.

If the DISC hoses are connected to the Sonalleve Patient Table, disconnect the hoses from the
Patient Table.

Connect the filling hose to DISCfill.

Connect the other end of the filling hose to the female hose connector in the Sonalleve Patient
Table.

Fig. 127: (1) When DISC is pre-installed at the factory, the hose connectors
are located in the Table Top connector panel. (2) When DISC is installed as
an upgrade, the hose connectors are located in the accessory box at the
front end of the Patient Table.

After the filling hose is connected, DISC filling starts automatically. Follow the indicator needle.
If filling does not start within 1 minute:
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7. 

Ensure that DISCfill is properly positioned on top of the ultrasound window.
Ensure that the filling hose is fully plugged in at both ends.
Ensure that there is water in DISCfill. If necessary, fill DISCfill with distilled water as
instructed in 10.9.1 Adding water to DISCfill.

If still no filling takes place, there may be air in the filling hose that prevents the water flow. Remove
the air as instructed in 10.9.2 Removing air from the filling hose, then try again.

Filling stops automatically when DISC is full. Filling typically takes less than 3 minutes. Check
that the indicator needle is within the white zone. Disconnect the filling hose from the Sonalleve
Patient Table after filling DISC.

When preparing the Sonalleve Patient Table for HIFU treatment, remove DISCfill from the top of
the ultrasound window and reconnect the DISC hoses. Follow the instructions in 6.2.1 Connecting
the Sonalleve Table Top.

If DISC is inadvertently overfilled, contact Service.

Handling of DISCfill tool

DISCfill is intended and recommended to be stored on top of the ultrasound window always when
the Sonalleve Patient Table is not in use. When placed on top of the ultrasound window, DISCfill
protects the membrane from damage and prevents light from affecting the water in DISC.
The filling hose may be stored either attached to or detached from DISCfill.
Correct:

If the mattress is stored on top of the Sonalleve Patient Table, DISCfill must be placed under the
mattress. Make sure that the edges of the mattress are on top of the base of DISCfill.

If attached to DISCfill, the filling hose goes under the mattress.

Incorrect:

-
-
-
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The edges of the mattress are under the base of DISCfill.

If attached to DISCfill, the filling hose goes on top of the mattress.

To carry DISCfill, lift it by the pair of handgrips as shown in the following picture.

7.2 Sonalleve MR-HIFU Quality Assurance (QA)
procedure

NOTICE   
If the Direct Skin Cooling (DISC) device is installed: Before performing the QA, check the DISC
water level using the DISCfill tool.
For more information, see 7.1.2.1.1 Checking the water level in DISC.
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The purpose of the QA procedure is to ensure that the Sonalleve MR-HIFU system’s accuracy and
power levels are normal.
Perform the QA procedure before the first patient of the day. You need the following items for the
procedure:

Sonalleve QA phantom

QA Phantom Plate

Degassed water

The QA procedure shall be carried out with the application that will be used in treatment.
Do not scan phantom images with the patient’s identification.
Connect the Patient Table as instructed in 6.2.1 Connecting the Sonalleve Table Top.
The properties of the phantom affect the result. Therefore, follow the handling and storage
instructions of the phantom carefully. If the phantom becomes damaged, order a new phantom.

WARNING   
Usage of a damaged QA Phantom is not allowed.

 The Sonalleve QA Phantom, model 4510 000 82232, contains residues of acrylamide (CAS
nr.: 79-06-1) in a hermetically sealed container. If the container is damaged or the contents
come out of the container, dispose of the phantom and the liquids that have been in contact
with the exposed contents. Use nitrile rubber gloves when disposing of the material and the
liquids. Follow the disposal instructions.
Failure to follow this instruction may expose the operator, other personnel and patients to
poisonous chemicals and result in damage to the environment.

The Sonalleve QA Phantom, model 4510 000 82232, is classified as hazardous waste based on
the classification and the concentration of acrylamide used in its filling mixture.
The QA Phantom must be disposed of according to the instructions laid out for hazardous waste
handling. See 9.5 Disposal of the Sonalleve QA Phantom.
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7.2.1 Preparing the QA phantom for use

Remove the ultrasound window cover.
Fill the space between the ultrasound window membrane and the QA Phantom Plate with

degassed water. Use a large syringe and hold the syringe near the membrane to minimize air
bubbles. Be careful not to puncture the membrane.

Fig. 128: Preparing the Sonalleve Patient Table with degassed water for
phantom.

With degassed water on the membrane, place the QA Phantom Plate on the Patient Table at an
angle to minimize trapping bubbles underneath the plate.

Fig. 129: The QA Phantom Plate.
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5. 

6. 

Fig. 130: Placing the QA Phantom Plate over the ultrasound window.

Place one edge of the QA phantom on the phantom plate. The membrane end of the phantom
should point down.

Gently lower the QA phantom onto the phantom plate to minimize air bubbles. The QA Phantom
Plate centers the QA phantom on the ultrasound window.

Fig. 131: Place one edge of the QA phantom on the phantom plate. Gently
lower the QA phantom onto the phantom plate.

Once the QA phantom is placed onto the phantom plate, use a syringe to fill any remaining air
pockets under the phantom with degassed water.
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8. 
9. 

Fig. 132: Fill any remaining air pockets under the phantom with degassed
water.

Secure the QA phantom in place with the HIFU Coil.

Fig. 133: QA phantom ready for sonication.

Push the Sonalleve Table Top into the magnet bore until it locks in place.
Using the bubble detection scan on the MR console, verify that there are no bubbles in between

the transducer and the phantom before proceeding with the QA Test. If you find large bubbles,
check and reposition the QA phantom and re-check for bubbles.
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Fig. 134: Bubble detection with the MR scan: Large air bubbles that prevent
the sonication are indicated by arrows.

Fig. 135: Bubble detection with the MR scan: Acceptable.
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7.2.2 Performing the QA Test

NOTICE   
Before performing a QA Test Sonication, check the DISC water level using the DISCfill tool.

Select the "Automatic QA Sonication" ExamCard.
Scan the Survey Scan, position the membrane bubble scan slices on the membrane-phantom

layer.
Scan the membrane bubble scan and verify that there are no large air bubbles. If there are,

remove them and repeat the procedure.
Prepare the temperature mapping scan.
Select Maintenance → Calibration Tests.

If the DISC system water level has not recently been checked, the check must be performed
first. For instructions, see 7.1.2.1.1 Checking the water level in DISC. To confirm that the check
was completed successfully, check the The DISC system water level is acceptable checkbox. To
complete this step, click Finish.
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Click Start to start the QA Test.

A small arrow indicates the phase of the QA Test that is in progress. The symbol is replaced by a
green checkmark when the phase is successfully completed. If the test fails, the symbol of the
failed phase is replaced by a red circular error symbol (see the following figures).
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To see details about a phase of the QA test, click the small down-pointing arrowhead (at right).

Fig. 136: Automatic QA Test has successfully passed the first three phases
and is now performing System Time Synchronization (for versions R3.7 to
L3).

Fig. 137: Automatic QA Test has successfully passed the first phase and is
now performing System Time Synchronization (for versions R3.7 L4 and
newer).
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For versions R3.7 to L3: The system checks first MR Scanner Connection. After that, Start
Temperature Mapping is checked. If the Temperature Mapping scan has not been started on the
scanner, start it to proceed.

For versions R3.7 to L3: When the temperature mapping scan is under remote control, HIFU
Controller Initialization starts.

For versions R3.7 to L3: System Time Synchronization sets the time on the Sonalleve
console and in the Sonalleve Generator Cabinet from the time on the MR scanner. It also disables
Windows's Network Time Protocol (NTP) service to prevent any mismatches between the clocks.

For versions R3.7 L4 and newer: The system checks first MR Scanner Connection. After that,
System Time Synchronization sets the time on the Sonalleve console and in the Sonalleve
Generator Cabinet from the time on the MR scanner. It also disables Windows's Network Time
Protocol (NTP) service to prevent any mismatches between the clocks.

For versions R3.7 L4 and newer: When the clocks have been synced with MR scanner, HIFU
Controller Initialization starts. This ensures that MR scanner, Sonalleve console and HIFU
Controller clocks are in sync.

For versions R3.7 L4 and newer: Next Start Temperature Mapping is checked. Make sure
to prepare Temperature Mapping scan on the scanner, for this step to proceed.

Lock the Table Top checks the location of the Table Top. To proceed, the Table Top needs to
be locked to the isocenter.

After the arrow moves to Enable Safety Device, press the green Enable button on the Safety
Device.

Hardware Initialization also checks the status of the Direct Skin Cooling device.
Wait while the system performs test sonications. Select a cell to view the QA Test results.

The following are analyzed during QA Test:
Correct positioning of the QA phantom
Cross-sectional shape of the heating pattern
Maximum temperature
Heating diameter
Heating length
Location of the heating

Fig. 138: QA test passed. Viewing the results from cell 1.

-
-
-
-
-
-
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Fig. 139: QA Test failed: test sonication failed in cell 1.

Network Isolation Check checks that the Sonalleve system can be isolated from the hospital
network.

It is recommended to record sonication results in the QA Test result table provided in 10.4 QA
Test result table.

Click Finish to end the QA Test.

After the QA procedure has been successfully carried out, the Sonalleve MR-HIFU system is ready
for the treatment.
Put the ultrasound window cover back in place when you remove the QA phantom.

CAUTION   
Always remove the QA phantom at the end of QA or testing period. Do not leave the QA
phantom on the Patient Table overnight. Water between the phantom and the membrane will
evaporate over time. A phantom placed on the Patient Table may lead personnel to believe
that it is ready for use. If there is not enough water, a sonication may cause a reflection of
acoustic energy that may damage the transducer.

7.2.3 QA Test troubleshooting

Tab. 27: QA Test troubleshooting.

Problem Troubleshooting steps

The QA Test fails during the MR Scanner
Connection phase Check that the Sonalleve Generator Cabinet is

switched on.
Check that the cables are connected.
Restart the MR application software on the MR

scanner console.
Repeat the QA Test.

The HIFU Controller Initialization phase
fails with the message “HIFU Controller
initialization timed out”

There is no connection between the Sonalleve
console and the Sonalleve Generator Cabinet.
Ensure that the cables are connected and that
the Sonalleve Generator Cabinet is powered up.
If the problem persists, contact Service.

The QA Test stops in the Lock the Table
Top phase

Ensure that the Table Top is locked.

The QA Test stops in the Start
Temperature Mapping phase

Ensure that the temperature mapping scan is
prepared on the MR scanner console. And the
temperature mapping scan is accepted.
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The QA Test fails during the Hardware
Initialization phase Check that the Sonalleve Generator Cabinet is

switched on.
Check that the Sonalleve Patient Table cables

are connected.

The QA Test fails with the message
"Problem with QA Phantom" Check that the phantom is a sonication

phantom provided by Profound Medical.
Check that the QA phantom is located

correctly on the QA Phantom Plate.
Check that the MR scanner's couch lifting unit

is fully lowered.
Check that there are no sonication holes inside

the QA phantom. If the phantom is damaged,
replace it.

Repeat the QA Test.

The QA Test fails due to: “Heating
location check failed”, “Maximum
temperature check failed”, “Heating shape
check failed”, “Heat increase check
failed”, some other reason, or an
unknown reason

Repeat the QA Test.

The QA fails during Network Isolation
Check phase

Call Customer Service to enable hospital network
isolation.

If repeating the QA Test does not help, or if the test fails constantly/repeatedly, contact Service.

WARNING   
Do not treat patients unless the reason for a QA Test failure is clear and it is certain that
there is no increased risk to the patient.

7.2.4 Storing the QA phantom

The properties of the QA phantom affect the test results. If the phantom is damaged the results
may be unreliable. Therefore, follow the handling and storage instructions of the phantom and if
necessary order a new phantom.
The QA Phantom Plate serves as a storage platform for the QA phantom. The QA Phantom Plate
elevates the QA phantom so that the membrane does not rest on any surface. This is to avoid
damaging the sensitive membrane.

Place the QA Phantom Plate on a hard flat level surface. Make sure that within the opening of
the plate there are no objects that could puncture the membrane of the phantom.

Place QA phantom on the QA Phantom Plate with the membrane facing down.
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Fig. 140: Store the QA phantom on the QA Phantom Plate with the
membrane facing down.

Whenever the QA phantom needs to be removed from the QA Phantom Plate, make sure that the
QA phantom is placed so that the membrane does not make contact with any surface.
Store the QA phantom at normal room temperature.

7.3 Cleaning and disinfection

WARNING   
Clean, dry and disinfect the parts that come into contact with the patient after each
treatment according to the instructions below. Discard any single-use accessories such as
gel pads. Failure to follow this instruction may increase the risk of infection or serious
illness for the patient, operator or the service personnel.

Cleaning and disinfection techniques for both the product and the room must comply with all
applicable local laws and regulations.
Use the following cleaning/disinfecting agents for cleaning the system:

A mild washing agent mixed with water for cleaning all surfaces

Ethanol 70%, water 30% for cleaning all surfaces

Isopropanol 70%, water 30% for cleaning all surfaces

0.1% hypochlorite in water for cleaning all surfaces

The membrane and membrane rings can be cleaned with stronger liquids:

100% Ethanol

100% Isopropanol.

CAUTION   
Only use the cleaning agents listed above. Other cleaning agents may damage the system.

If you are not sure about the properties of a cleaning/disinfecting agent, do not use it.

WARNING   
Do not use flammable or potentially explosive disinfecting sprays.
Such sprays create vapors, which can ignite, causing fatal or other serious personal injury.
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CAUTION   
Disinfecting a medical product room by means of sprays is not recommended, since the
vapor could penetrate the product, causing electrical short-circuits, metal corrosion or
other damage to the product.

If non-flammable, non-explosive sprays are to be used, the product must first be switched off and
allowed to cool down. This prevents convection currents drawing spray mist into the product.
Plastic sheeting must be used to cover the product thoroughly, after which spraying can begin.
Once all traces of the vapor have dispersed, the plastic sheeting can be removed and the product
itself can be disinfected or sterilized in the way recommended above.
If a spray was used, you must be satisfied that all traces of the vapor have dispersed before
switching the product on again.

7.3.1 Cleaning the system

Wipe off water from the ultrasound window with an absorbent cloth.
Wipe the membrane (and the grooves) of the ultrasound window with a strong cleaning agent.
Clean the system covers with a mild washing agent to prevent staining or fading of the surfaces.

Staining is a visual problem only and does not cause any other problems.
Clean the mattresses with a washing agent mixed with water.
Dry the mattresses with cloth.
Regularly inspect the ultrasound window for cracks and other defects that may compromise the

efficiency of disinfection. Make sure that the grooves and corners are sufficiently cleaned.

7.3.2 Cleaning the vacuum cushion

The covers of the vacuum formed positioning aids such as cushions are made of polyurethane
coated fabric. Wipe the cushion with water and soap, or some other common detergent not
containing biologically active ingredients. Do not bleach. Let the fabric dry completely before
storage.

7.3.3 Cleaning the DISCfill tool

DISCfill can be cleaned in the same way as the top surface of the Sonalleve Patient Table, using
cleaning agents that are permitted for cleaning all surfaces.

7.4 Making degassed acoustic contact liquid

Degassed water or a degassed mixture of ultrasound gel and water is used as acoustic contact
liquid in MR-HIFU. As air bubbles in the ultrasound beam path may cause undesirable effects, such
as reflections or local heating, the acoustic contact liquid must be degassed. The amount of
dissolved oxygen must be below 4 mg/l (ppm, parts per million).

Degassed water

NOTICE   
A specially designed EasyWater Degasser is available from the manufacturer for producing
degassed water. Further details can be found in the EasyWater Degasser Instructions for Use.
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IEC 61161, Annex D mentions boiling as a way of making degassed water. Boiling is a feasible
method for producing small amounts of degassed water if an EasyWater Degasser is not available.
You will need the following items for making degassed water:

distilled water or water deionized by filtering

glass bottles with metallic screw caps

a kettle with a lid, large enough to hold the standing bottles

a funnel

silicon gloves

a plastic apron

safety goggles

Procedure

Pour water into a kettle and boil heavily under a lid for 20 minutes. The amount of water should
be sufficient for both filling and covering the glass bottles.

Protect yourself with a plastic apron, safety goggles and silicon gloves.
Pour the hot water into the glass bottles through a funnel. Leave a little air in the neck of the

bottles.
Bring the remaining water into boil again and place the filled bottles in it without the caps. Boil

under a lid for 15 minutes.
Carefully lift the bottles from the boiling water and immediately screw the caps on.
Let the bottles cool down for a few hours, then refrigerate.
If an oxygen meter is available, measure the oxygen level to verify that the oxygen content is

below 4 ppm.

NOTICE   
To avoid creating air bubbles, never shake the water.

Degassed ultrasound gel – water mixture
Also a mixture of degassed water and ultrasound gel can be used as a coupling medium. Prepare
the mixture by mixing ten parts of degassed water and one part of ultrasound gel. The consistency
of the mixture is correct when any air bubbles will rise to its surface.

7.5 Ultrasound protection

When you practice positioning with volunteers or animals, use an absorption pad or a large
positioning pad on top of the ultrasound window to ensure that ultrasound energy cannot reach
them.
To position the protectively used absorption pad or a positioning pad:

Place the absorption pad or a large positioning pad on top of the ultrasound window membrane,
in the same way as you would place a gel pad.

Place a thin positioning pad, thick towel or cloth on top of the absorption pad or the positioning
pad to prevent skin contact. The pads can become hot when exposed to ultrasound.
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NOTICE   
The absorption pad and the large positioning pad are safety accessory. Do not sonicate the pads
on purpose. Heat will eventually damage the pad and may also damage the transducer. Always
inspect the absorption pad and the large positioning pad before use. Replace the pad if you
observe any damage.

Fig. 141: The absorption pad

The absorption pad (451000082712) is available for Sonalleve MR-HIFU bone application. The
purpose of the pad is to absorb the ultrasound beam in case of accidental exposure during
volunteer imaging.
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Fig. 142: The large positioning pads that you can use for ultrasound
protection.

The pads that you can use for ultrasound protection are labeled with a sticker that identifies the
pad as "Support Pad 2," part number 4510 000 82791. The size of the pad is 32 cm × 40 cm
(12.6 inches × 15.7 inches).

7.6 Lifetime

The expected service lifetime for the Sonalleve MR-HIFU system is 10 years. The lifetime assumes
planned maintenance and service by qualified service personnel and replacement of parts at the
end of their normal life expectancy. Basic safety and essential performance are not expected to
degrade over the expected service life of the equipment.
If the end of the service lifetime approaches, contact Profound Medical or qualified service center
for pre-inspection of the product and availability of spare parts.
Beyond that period, Profound Medical may not be able to guarantee technical support and/or repair
due to obsolescence of subcomponents or because it is no longer feasible to acquire the
technology and/or parts necessary to maintain the equipment. Please consult Profound Medical or
qualified service center for further instructions.
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8 System Error and Warning
messages

The system produces messages to alert you about situations which may cause problems in the
system or the treatment workflow. The messages are visible in the message area of the Hardware
Status Area. Clicking on a message opens a window which provides more information on the
situation and instructions on how to handle it. You can also view the messages through the system
log.
The messages are classified as

Errors

Warnings

Informational messages

The following chapters describe the three message types and the way they are distinguished from
each other in the user interface. A complete list of Error and Warning messages is available in
chapter 10.10 Error and Warning messages.

8.1 Errors

Errors are messages that halt the user interface and stop the current activity. When an error
message is issued, all functions of the User Interface, except for the message display and the
abort button, are locked.
Errors are classified as High, Medium or Low errors according to their priority. The priority depends
on the severity of the harm (to a person, usually the patient) and on how soon the user must react.

Tab. 28: Priority classes of errors according to IEC 60601-1-8.

Consequence of failure to
respond

Onset:
Immediate

Onset:
Prompt

Onset: Delayed

Death or irreversible injury HIGH HIGH MEDIUM

Reversible injury HIGH MEDIUM LOW

Minor injury or discomfort MEDIUM LOW LOW or Not
Applicable

The table below shows how the different types of errors are displayed.
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Tab. 29: Error types.

Icon Error
priority

Display mode Significance

HIGH High (4 Hz) blinking rate
of the icon and the
message area

Forces operation to be aborted.
Considered always to be HIGH in
severity to the patient, even if happens
during planning or maintenance.

MEDIUM Medium (1 Hz) blinking
rate of the icon and high
blinking rate (4 Hz) of the
message area

An error that requires the user to make
a decision on how to proceed. MEDIUM
patient hazard.

LOW Medium (1 Hz) blinking
rate of the icon and high
blinking rate (4 Hz) of the
message area

An error that requires the user to make
a decision on how to proceed or to
confirm the error. LOW patient hazard.

8.2 Warnings

Warnings are messages that alert the user to a failure in the system. Some warnings require action
or confirmation from the user, some do not.

Tab. 30: Warning types.

Icon Display mode Significance

Static icon and medium (1 Hz) blinking
rate of the message area (if no errors are
present).

A warning that requires the user
to make a decision on how to
proceed.
A warning that requires user
confirmation.

Static icon, may disappear automatically
when the error condition is cleared.

A warning that does not require
actions from the user.

Warnings related to a sonication are only visible in the context of that sonication, when the user is
viewing the Analysis or Decisions tab. The user should assess the warnings from previous
sonications before continuing the treatment. Warnings related to a sonication are automatically
cleared when the user starts planning the next sonication.
Warnings related to a scan started from the Scan tab are cleared automatically when the user
switches away from the Scan tab or starts a new scan.
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8.3 Informational messages

Informational messages do not require any actions from the user. They are displayed with the
information icon. They inform the user about the required action and fade out when the task is
done. You can right-click in the message area and select Clear Minor to clear minor messages.
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9 Product disposal
9.1 Introduction

Profound Medical is concerned to help protect the natural environment, and to help ensure
continued safe and effective use of this product, through proper support, maintenance and training.
Therefore, Profound Medical products are designed and manufactured to comply with relevant
guidelines for environmental protection. As long as the product is properly operated and
maintained, it presents no environmental risks. However, the product may contain materials, which
could be harmful to the environment if disposed of incorrectly. Use of such materials is essential to
performing the functions of the product, and to meeting statutory and other requirements.
This section of this Instructions for Use is directed mainly at the user / owner of the product.

9.2 Passing the product on to another user

If this product passes to another user, it must be in its complete state, including all product support
documentation. Make the new user aware of the support services that Profound Medical provides
for installing, commissioning and maintaining the product.
Before passing on the product or taking it out of service, all patient data must be (backed up
elsewhere if necessary, and) unrecoverably deleted from the product.
It must be remembered by all existing users that passing on medical electrical products to new
users may create serious technical, medical and legal (e.g., on privacy) risks. Such risks can arise
even if the product is given away. Existing users are strongly advised to seek advice from their
local Profound Medical representative before committing themselves to passing on any product.
Alternatively, contact the manufacturer.
Once the product has been passed on to a new user, a previous user may still receive important
safety-related information, such as bulletins and field change orders. In many jurisdictions, there is
a clear duty on the previous user to communicate such safety-related information to new users.
Previous users who are not able or prepared to do this should inform Profound Medical about the
new user, so that Profound Medical can provide the new user with safety-related information.

9.3 Final disposal of the product

Final disposal is when the user disposes of the product in such a way that it can no longer be used
for its intended purpose.
Profound Medical supports users in:

Recovering reusable parts

Recycling of useful materials by competent disposal companies

Safe and effective disposal of the product

For advice and information, contact your Profound Medical service organization first, or otherwise
the manufacturer.

NOTICE   
The product contains privacy sensitive information which should be properly removed. It is
advisable to contact your Profound Medical service organization before disposing of the product.
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WARNING   
Do not dispose of any parts of this product with industrial or domestic waste. The product
contains hazardous materials which require special disposal.
Incorrect disposal of any of these materials may lead to serious environmental pollution.

Beryllium
Some components in the transducer assembly inside the Sonalleve Patient Table contain beryllium
copper.

Lead
Some components inside the Sonalleve Patient Table contain lead.

Mercury
This product consists of devices that may contain mercury, which must be recycled or disposed of
in accordance with local, state, or federal laws. (Within this system, the backlight lamps in the
monitor display contain mercury.)

Perchlorate materials
In this product, perchlorate material is present in lithium coin cells and/or batteries. Special
handling may apply for these materials. For more information, go to:
www.dtsc.ca.gov/hazardouswaste/perchlorate.

 There is a lithium coin cell on the CPU board inside the workstation of the Sonalleve Console.

The liquid inside the Patient Table
The liquid inside the Sonalleve Patient Table may require special handling. For information on how
to safely handle the liquid, refer to the Material Safety Data Sheet supplied with the system.

9.4 Disposal of patient positioning aids

The materials used in the patient positioning aids used during HIFU treatment do not require
special handling and can be disposed of with normal hospital waste.
Do not throw gel pads or gel pad fragments in the toilet. Do not put gel pads or gel pad fragments
into biodegradable waste.

9.5 Disposal of the Sonalleve QA Phantom

Check the model number in the device label of the QA phantom to identify the phantom model.

Tab. 31: Disposal of the Sonalleve QA Phantom, by phantom model.

Phantom
model

Disposal

4510 000
82231

The phantom does not require special handling and can be disposed of with
normal hospital waste.

4510 000
82232

The phantom requires special handling and must be disposed of as hazardous
waste. See the next chapter for more information.

Other See instructions supplied with the phantom. If the instructions are missing,
contact your Profound Medical service organization.
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Important   
If the QA phantom cannot be identified, for safety assume that the phantom is hazardous
waste. Follow the disposal instruction for Sonalleve QA Phantom model 4510 000 82232.

Disposal of the Sonalleve QA Phantom, model 4510 000 82232
The Sonalleve QA Phantom, model 4510 000 82232, is a polymethyl metacrylate (PMMA)
container filled with a polymer mixture (Zerdine® filler gel). After filling, the polymeric mixture inside
the phantom becomes a solid and cannot be removed from the container. For this reason, the QA
phantom is disposed of as a single unit. This chapter details how to safely dispose of the QA
phantom.

Fig. 143: Sonalleve QA Phantom model 4510 000 82232 on the QA
Phantom Plate.

WARNING   
The Sonalleve QA Phantom, model 4510 000 82232, contains residues of acrylamide (CAS
nr.: 79-06-1) in a hermetically sealed container. If the container is damaged or the contents
come out of the container, dispose of the phantom and the liquids that have been in contact
with the exposed contents. Use nitrile rubber gloves when disposing of the material and the
liquids. Follow the disposal instructions.
Failure to follow this instruction may expose the operator, other personnel and patients to
poisonous chemicals and result in damage to the environment.

After filling, the polymeric mixture inside the phantom becomes a solid and cannot be removed
from the container. For this reason the QA phantom is disposed of as a single unit. This chapter
details how to safely dispose of the QA phantom.
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The Sonalleve QA Phantom, model 4510 000 82232, is classified as hazardous waste based on
the classification and the concentration of acrylamide used in its filling mixture. The QA phantom
must be disposed of according to the instructions laid out for hazardous waste handling.

NOTICE   
Hazardous waste handling must be performed in accordance with local and national legislation.
Local and national legislation of hazardous waste handling always take precedence over the
following guidelines.

Disposal Guidelines in the United States of America:
DO NOT DUMP INTO ANY SEWERS, ON THE GROUND OR INTO ANY BODY OF WATER. All
disposal practices must be in compliance with all Federal, State/Provincial and local laws and
regulations.

Disposal Guidelines in the European Economic Area (EEA):

The QA phantom must be collected separately (mixing of hazardous waste is banned).

The QA phantom must be delivered to a party who has a legal right to receive and treat
hazardous waste.

The QA phantom waste must be labeled as follows:

R45 May cause cancer
R46 May cause heritable genetic damage
S53 Avoid exposure – obtain special instructions before use
S45 In case of accident or if you feel unwell seek medical advice immediately (show the label
where possible)

A record of QA phantom waste quantities must be kept. The records must be stored for three
years.

Whenever QA phantom waste is transferred within EEA Member States, it shall be
accompanied by an identification document, which may be in electronic format, containing the
appropriate data specified in Annex IB to Regulation (EC) No 1013/2006.
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10 Appendices
10.1 Using the air pump with air bags and vacuum
cushions

The positioning aids include an air pump with two valves for deflating vacuum cushions and
inflating air bags.
Vacuum cushions are soft when inflated. They can be used to simply support the patient in a
comfortable position or to allow oblique positioning when necessary. When deflated, the cushion
turns solid and can be used to immobilize the patient.
Vacuum cushions can be used instead of the normal head rest to provide the patient added support
and comfort. The cushions can be inflated or deflated at any stage during the treatment, as this
does not affect the patient’s position.

Operating the pump

Fig. 144: Air pump. Right: Air hose connected to the Deflate side of the
handle.

Connect the air hose to the handle of the pump.
To deflate a vacuum cushion, connect the hose to the side marked Deflate.
To inflate an air bag, connect the hose to the side marked Inflate.

Ensure that the transparent piece of plastic tube on the vacuum cushion/air bag is securely
attached to the valve. Connect one of the attached nozzles to the end of the air hose and insert it in
the tube, as shown in the following figures.

Fig. 145: Connecting the air hose.

Pump air out of the vacuum cushion, or into the air bag.

-
-
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When the vacuum cushion/air bag is sufficiently deflated/inflated, press the dark button as
indicated by an arrow in the following figure, and pull the transparent piece of plastic tube out of the
valve. The valve is closed when the tube is removed.

Fig. 146: Releasing the tube from the valve.

Disconnect the air hose from the tube.
To inflate the vacuum cushion after the treatment, open the valve by re-inserting the tube. The

cushion starts filling up. You do not normally need to use the air pump. If you use the Inflate side of
the air pump to inflate a vacuum cushion, take care not to pump in too much air.

Operation with another type of valve

Fig. 147: Another type of valve. Left: the valve is open; middle: the air hose
is connected; right: the valve is closed and the air hose has been detached.

Some air bags and vacuum cushions may be equipped with a different type of valve, as shown in
the figures above. With this type of valve:

Connect the air hose to the handle of the pump.
To deflate a vacuum cushion, connect the hose to the side marked Deflate.
To inflate an air bag, connect the hose to the side marked Inflate.

Connect one of the attached nozzles to the end of the air hose and insert it in the plastic tube on
the vacuum cushion/air bag. Ensure that the valve is open.

Pump air out of the vacuum cushion, or into the air bag.
When the vacuum cushion/air bag is sufficiently deflated/inflated, quickly close the valve by

pressing the button fully in.
Disconnect the air hose from the tube on the vacuum cushion/air bag.
To inflate the vacuum cushion after the treatment, open the valve by pressing the other end of

the button. The cushion starts filling up. You do not normally need to use the air pump. If you use
the Inflate side of the air pump to inflate a vacuum cushion, take care not to pump in too much air.

-
-
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10.2 Temperature conversion

The success of a HIFU treatment depends on the correct starting temperature. Conversion
formulas and tables from and to other temperature scales are given here.
Conversion from Fahrenheit scale to Celsius scale:
TC = (TF − 32) × 5 ⁄ 9

Conversion from Celsius scale to Fahrenheit scale:
TF = (TC × 9 ⁄ 5) + 32

Conversion for temperature differences from Fahrenheit to Celsius:
TC2 − TC1 = (TF2 − TF1) × 5 ⁄ 9

Conversion for temperature differences from Celsius to Fahrenheit:
TF2 − TF1 = (TC2 − TC1) × 9 ⁄ 5

Conversion from Kelvin scale to Celsius scale:
TC = TK + 273

The table below shows some temperature limits that are relevant to the HIFU treatment:

Tab. 32: Temperature limits.

Temperature Celsius Fahrenheit Kelvin

Freezing point of water 0 32 273

Normal body temperature 37 99 310

Reversible tissue damage in 1 minute 47 117 320

Necrosis of tissue in less than 3 seconds 55 131 328

Proteins denaturate 70 158 343

Maximum allowed treatment temperature 85 185 358

Boiling point of water 100 212 373

10.3 Comparing thermal dose volumes and non-
perfused volumes

10.3.1 Estimating thermal dose volumes

The software automatically estimates the thermal dose volume and heating dimensions. You can
check the thermal dose volume and the heating dimensions of the single cell from the Analysis
tab.
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10.3.2 Calculating non-perfused volumes (NPV)

A non-perfused volume indicates cells with no blood flow and therefore no contrast agent.

Open the DICOM image set containing the day-0 post-treatment C+ images using the DICOM
viewer on the MR console.

Create difference images with the Image Algebra function using the precontrast and post-
contrast images. If difference images are not available or usable, use the post-contrast images,
analyzing the pre-contrast images to exclude any pre-existing NPV.

To estimate non-perfused volume assuming an ellipsoid shape:
Measure the length a of the NPV using the centermost (longest) SAG (or COR) image.
Measure the two diameters b and c of the NPV (ellipsoid) using the centermost (largest
diameter) COR (or SAG) image.
Calculate volume as

 V = a × b × c × π ⁄ 6.

Tip
If the centermost image is a poor estimate of the NPV due to e.g. an irregular shape of the
NPV, try to fit in multiple ellipsoids and choose the slices that are the most representative.

Alternative step 3: Manual contour segmentation method:

Contour each non-merged NPV using 2D modeling tools and let the tool calculate the total area
in each slice.

The volume is the total area multiplied by the slice thickness.

Repeat steps 2 and 3 for all the NPVs and sum the NPVs together.

-
-

-
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10.3.3 Estimating NPV on Sonalleve console

Go to the PTV Delineation stage.
Right-click in the image area and select the post contrast THRIVE imageset.
Draw a new PTV, or modify the existing PTV around the necrotic area in three planes.

Fig. 148: PTV around the necrotic area in three planes.

The volume of the PTV can be seen in the top row as Total Volume. It gives an estimate of the
NPV.

Fig. 149: Total Volume in PTV Delineation page
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10.4 QA Test result table

10.5 Copying Sonalleve MR-HIFU treatment data to
DVD

10.5.1 Copying DICOM images

For instruction on how to copy treatment-related DICOM images on the MR console, refer to the
MR scanner's Instructions for Use.
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10.5.2 Copying saved state data

To copy saved state data to DVD using the DVD RW drive in the Sonalleve Console, carry out the
following steps on the Sonalleve Console:

Select Manage States... (in the File menu).
Select the saved state to copy.
Click the Export or Export De-identified button.
In the Save As dialog box, select DVD RW Drive (E:).

Note that Export De-identified does not automatically change any potentially identifying text in the
Name and Description of the saved state, or the export filename.

Fig. 150: Save As dialog box.

In the Burn a Disc dialog box, select With a CD/DVD player, then click Next.
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Fig. 151: Burn a Disc dialog box.

In the Save As dialog box, give the saved state a file name, then click Save.
Wait for the export to complete in the Session Manager dialog box, then close the dialog box.
Press the Windows button on the keyboard to see the Windows start menu.
Click Computer. Double-click on the DVD RW Drive (E:).
Click Burn to disc.

Fig. 152: Burn to disc button.

Give the disc a title, then click Next.
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Fig. 153: Burn to Disc dialog box.

Wait for the disc burning to complete. It takes a few minutes.

Saved states can also be copied to network drives and removable media using a similar process.
Note that access to the DVD drive and the rear panel USB ports requires administrative privileges.
The front panel USB ports are disabled for cybersecurity reasons.

10.6 Security and privacy features

It is the policy of Profound Medical to adhere to all required standards and regulations. To assist
the hospital, the following functionality has been added to the system:

10.6.1 Access control

Intended to restrict access to the system to authorized users only:

Customizable on/off, a user log-on/log-off procedure is required to gain access to the system.

Access to the system is granted according to a customizable list of authorized users.

Only username/password authentication is supported. No additional mechanisms, like two-
factor authentication using smartcards, etc., are supported.
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The system does not provide functionality to synchronize with customer central user account
administration systems (LDAP, etc.).

The system supports only single user sessions. It does not provide application functionality to
register multiple simultaneous users or to switch between users other than via log-off / log-on.

The system does not support single sign-on for situations where the system works together with
other (optional) systems or is part of another system, e.g. extra workstations.

NOTICE   
It is not possible to prevent the transfer of data to removable media.

10.6.2 Audit trail

Required to log user activities which are information-security critical:

Applies to logging-on, reading and/or modifying clinical information.

Uses the local Security Event Log which is accessible only to service and system
administrators.

Use of an external standard 'Syslog' server is not supported.

Application specific access information is stored in RFC-3881 format; Logon/Logoff information is
stored using Windows' event format.

Viewing the local audit log
To view the local audit log:

Log on to the Sonalleve console as an administrator.
Open the Windows Start menu.
Select the Windows Administrative Tools folder.
Under Administrative Tools, click Event Viewer.

Log-on, log-off and other security critical events are found in Windows Logs → Security.

10.6.3 Network time synchronization

The Sonalleve MR-HIFU V2 system synchronizes its time to the MR scanner and ensures that its
clock is not affected by other synchronization services. It is possible to configure the MR scanner to
synchronize its system time to an external time standard:

The MR scanner uses a standard Network Time Protocol (NTP) to synchronize system time.

A coupling between the scanner and an external time standard can be configured by Philips
Service during the installation of the MR scanner.

MR-HIFU system disables its own NTP service and synchronizes its time to the system time on the
MR scanner during the QA Test (see 7.2.2 Performing the QA Test).

WARNING   
It is not allowed to deploy any other time synchronization services in Sonalleve console.
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10.6.4 Other Security and Privacy features addressed

HIPAA defines a number of physical and technical safeguards which are either required or
addressable. Some features that could implement these functions are differently or not
implemented for reasons mentioned below.
This section also lists other information related to security features that are not implemented and
that the owner of the systems should be aware of.

System and application hardening
On the Sonalleve Console, unnecessary services have not been removed or disabled.

The HIFU Administrative account is provided for hospital administrative roles, however these
users are prevented from clinical use of the system.

The Sonalleve Console uses Windows default password complexity rules. The hospital
administrative user can change the password settings.

The Sonalleve Console has two logical drives. There is no distinct separation of operating
system, application software and data storage over these drives.

When logging on to the Sonalleve Console as a normal HIFU User the application is
automatically started, however it is possible for a user to switch to the operating system
interface (Windows desktop). When the application is closed, the user is logged off
automatically.

The Autoplay feature is turned off on the Sonalleve Console, so DVDs or USB devices inserted into
the system will not be opened automatically.

Automatic logoff
An auto-logoff feature is not implemented since it contradicts the intended use of the system.
Manual logoff using a 'short-cut' key combination is documented (see 2.15 Network safety, data
security and privacy).

Backup procedure
The system does not provide persistent storage for treatment data. It is not the intended use of the
system to permanently store (sensitive) personal information. Information should be exported to a
secure storage device as soon as possible.
The system does an automatic full system backup nightly to a second internal disk. The system
configuration is saved with the backup and can be retrieved by Service.

Emergency Access Procedure
The system allows the creation of multiple user accounts. You may create a generic user account
for emergency situations. However, to avoid unauthorized access to patient data, ensure that
knowledge of this generic account and access to the system is restricted.
The system does not mark data output as emergency usage, such as on-screen, printed, or
exported data during emergency access operation.
The system does not allow or enforce the users of a generic user account to enter their real
names.

Encryption
The system does not encrypt patient data that is stored on the hard disk or exported to external
media (DVD, USB device, etc.). The system also does not use encryption for transmission of data.

Network firewall configuration
The system is placed behind an external firewall which prevents all access to the ports of the
Sonalleve MR-HIFU system from the hospital network.

Physical access to the system
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Multi-factor authentication for all users is not supported. Control authentication by controlling
physical access to the system. Ensure that only authorized personnel have access to the system.
Some parts of the systems are located in the technical area of a system. Access to these locations
is assumed to be restricted. Usually, the components in the operator or examination room are more
readily accessible and therefore the following characteristics shall be taken into account for system
operation and access control:

The computer case is 'service friendly'; opening and removal of, for example, hard disk may be
possible without use of tools; computer case can be locked (for example, by cable lock); there
are no front side accessible drives, and so on.

The boot order for the system is Hard Disk, USB, DVD. By inserting a bootable CD/DVD or
connecting a bootable USB memory device, the system could be started up from those and thus
access may be gained to the system including information stored in it.

There is no detection of unauthorized physical access into the system e.g. via tamper proof
seals.

The integrity of most of the Profound Medical application software is checked when the systems
starts. Data integrity is not checked on startup.

The system BIOS is not password protected and can be accessed during the startup of the
system if unauthorized access to the system is possible.

Access to the DVD drive and the rear panel USB ports requires administrative privileges. The
front panel USB ports are disabled for cybersecurity reasons.

Security and node authentication
The Sonalleve MR-HIFU system only exchanges clinical data with the (internal) MR system, not
with other external nodes. Therefore, no node authentication mechanism has been implemented.

Security event reporting
The system does not implement automated reporting of security events.

10.7 Hospital administrator and user accounts

10.7.1 About accounts

The default user account “HIFU User” can be used by different system operators, but does not
provide a personified logging of the actions done by each operator. Personified user accounts
providing the logging of the actions done by each individual user may be required by legislation: for
example HIPAA. Each of these individual users has the same permissions and rights as the default
system user, unless the administrator assigns different rights to the user account. It is possible to
define that certain user accounts are power users. Power users have these additional rights:
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1. 

2. 
3. 
4. 
5. 

6. 
7. 

8. 
9. 

Power users can edit the system configuration.

Power users have access to all the maintenance tools in the software.

Power users have access to additional operating modes of the Sonalleve MR-HIFU application,
as described in 10.8.1 Partial standalone modes.

Power users can use the Export Data feature described in 6.8.10 Saving the treatment data.

The hospital IT administrator or Profound Medical service shall define local user accounts for the
Sonalleve console (Windows login). User accounts should be managed by the hospital
administrator. It is also possible to create multiple hospital administrator accounts.
Rename the default accounts. Use strong passwords. Do not share accounts: each user should
have an individual account. If this is not possible, then take appropriate security measures to
manage the accounts, such as changing passwords when users change roles.

10.7.2 Creating a new user/administrator account

Logon with username HospitalAdmin (not case sensitive).
The password of HospitalAdmin is 'Hospital' (case sensitive) on the first logon. You have to change
the password on the first logon.

Right-click the Windows Start menu and select Computer Management.
Select System Tools → Local Users and Groups → Users.
Select Action → New User...
Enter a personal username, a full name, and an account description. Define and confirm a

password of minimum 7 characters for the new user. Click Create and then Close.
Right-click the newly created user in the list and select Properties.
In the Member Of page select Add…

For normal user accounts type “HIFU Users” (without quotation marks) and click Check
Names. The entered text should expand to “HIFUCONSOLE\HIFU Users”. Click OK.
For power user accounts type "HIFU Power Users" (without quotation marks) and click
Check Names. The entered text should expand to "HIFUCONSOLE\HIFU Power Users".
Click OK.
For administrator accounts type “HIFU Administrator Users; Administrators” (without
quotation marks) and click Check Names. The entered text should expand to
“HIFUCONSOLE\HIFU Administrator Users; HIFUCONSOLE\Administrators”. Click OK.

Click OK.
Close the Computer Management window.

NOTICE   
On the first logon the new user or administrator is forced to change his/her password.

-

-

-
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3. 
4. 
5. 

10.7.3 Deleting an account

Open the Windows Start menu, right-click Computer and select Manage.
Select System Tools → Local Users and Groups → Users.
Select the user in the list.
Select Action → Delete.
Select Yes. If you are deleting an administrator account, you must also select OK to confirm the

delete operation.

NOTICE   
The system does not provide the possibility to synchronize with the customer’s central user
account administration systems.

10.8 Features for advanced users and
administrators

10.8.1 Partial standalone modes

In the Therapy mode, the Sonalleve MR-HIFU application requires a connection to both the MR
scanner and the hardware of the Sonalleve MR-HIFU system. In the Standalone mode, both of
these connections are emulated in software.
Power users, Service users and other qualified advanced users can additionally select from two
partial standalone modes:

In the Scanner Emulated mode the connection to the MR scanner is emulated, but the
connection to the hardware of the Sonalleve MR-HIFU system (including the generator cabinet
and the Patient Table) is active.

In the Sonicator Emulated mode the connection to the hardware of the Sonalleve MR-HIFU
system is emulated, but the connection to the MR scanner is active.

Fig. 154: The Mode list in the start page of the application, for advanced
users.

Note that the text in the application selection button for the therapy session only is Standalone in
the full Standalone mode. In the Scanner Emulated and Sonicator Emulated modes, the text in
the button is Therapy or Research, according to which mode the application was started in.
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10.8.2 Changing the Site Default Configuration

NOTICE   
The Site Default Configuration exists to ensure that the normal users of the system always have a
valid, working configuration to use, even when advanced users have modified the current
configuration. Any changes to the Site Default Configuration carries the risk of interfering with the
normal workflow, in addition to the safety risks inherent in modifying the configuration (see 2.1
General safety).

The Configuration Editor tool has menu items in its File menu for loading and saving the Site
Default Configuration.

Fig. 155: Menu items for Site Default Configuration.

Save Site Defaults saves the current configuration as the Site Default Configuration. The software
automatically saves a backup copy of the previous Site Default Configuration, too. Confirm the
change by clicking Yes in the Service Operation dialog box:

Fig. 156: The dialog for confirming the change in Site Default Configuration.

Load Site Defaults... loads a Site Default Configuration into the configuration editor. Use the file
load dialog to select the current Site Default Configuration or a previous version from the backups.
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Fig. 157: Loading a Site Default Configuration from a file.

10.8.3 Automatic backup of configuration changes in Research
mode

When you close the Configuration Editor, the editor automatically saves a backup of the current
configuration into a backups folder. The backup folder is located in

 “C:\ProgramData\Profound
Medical\Hifu\1.1\InstallationData\XX.XX.XX.XX_X\Backups\ResearchConfigurations”,

 in which “XX.XX.XX.XX_X” changes according to the active software build, for example
“3.5.987.654_0”.

10.9 Advanced maintenance procedures

Important   
The following procedures are normally done by Service. Users are advised to do the
following procedures themselves only if Service is not available.
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1. 
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3. 
4. 
5. 
6. 

7. 
8. 

10.9.1 Adding water to DISCfill

Unscrew the white cap from DISCfill.
Fill DISCfill with distilled water. DISCfill holds approximately 1.2 liters (0.3 gallons) of water.
Replace the cap.

Typically, DISCfill does not need filling between planned maintenance. If DISCfill needs to be filled
more frequently, contact Service.

10.9.2 Removing air from the filling hose

If you suspect that there is air in the filling hose that prevents the water flow, remove the air by the
following method. You need the draining hose and a container for water (a washbowl, for example).

Leave DISCfill on top of the ultrasound window.
Disconnect the filling hose from the Sonalleve Patient Table. Leave the filling hose connected to

DISCfill.
Position the container at the side of the Sonalleve Patient Table, below the level of DISC.
Place the open end of the draining hose into the container.
Connect the filling hose into the female hose connector of the draining hose.
Position the hoses so that at no point between DISCfill and the container the water flow needs to

turn upwards.
Let some water flow through the hoses.
Disconnect the filling hose from the draining hose.
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10.10 Error and Warning messages

Tab. 33: Symbols in the list of Error and Warning messages.

Symbol Meaning

 

Error, High priority

 

Error, Medium priority

 

Error, Low priority

 

Warning, requires user intervention

 

Warning, requires user confirmation

Warning, other
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Tab. 34: Error and Warning messages.

Error / Warning Explanation Action

 

Abnormally
Low Table Top
Water
Temperature

The temperature readings from the
Patient Table are abnormally low.

Close the Sonalleve Application, check the
cable connections to the Patient Table, then
restart the Application. If the problem persists,
contact Service.

 

Abnormally
Low
Transducer
Temperature

The temperature readings from the
transducer are abnormally low.

Close the Sonalleve Application, check the
cable connections to the Patient Table, then
restart the Application. If the problem persists,
contact Service.

 

Algorithm Data
Spooler
Unavailable

The software cannot access the
algorithm data store and image data
cannot be processed.

Wait a couple of seconds and retry the
previous operation. If it still fails, restart the
software.

 

Algorithm
Execution
Failed

There is a software error in an algorithm
processing the monitor images. Further
details can be found in the system log.

Restart the Application. If the problem
persists, contact Service to ensure correct
system configuration.

 

Algorithm
Execution
Unsuccessful

There is a software error in an algorithm
processing the monitor images.

Abort sonication and retry the operation. If the
problem persists, restart the Application.

 

Algorithm
Output
Unavailable

The image data cannot be processed
as the software cannot access the
monitor image processing algorithms.

Abort sonication. If the software does not
recover in 30 seconds, restart the Application.

Algorithms
Cannot Be
Prepared for
Scanning

The algorithms are not suitable for
scanning the current scan protocol.
Either the current scan protocol is
unsuitable or the algorithms are in a
faulty state.

Restart the scan protocol on the MR scanner.
If the problem persists, save the system state,
exit the therapy, and reload the state.

 

Angulated Fat-
Monitoring
Scan Not
Allowed

An angulated fat-monitoring scan
cannot be used for cooling time
calculation. This can result in increased
therapy time.

Prepare a new fat-monitoring scan on the MR
scanner. Remove all angulations by setting
the AP, RL, and FH angulations to zero on the
Offc/Ang tab.

 

Application
Busy

The Application is busy. If the situation
continues, there is a risk of data loss.

Wait for a minute before continuing. If the
problem persists, save the state and restart
the Application.

Available
Primary Disk
Space Getting
Low

Available disk space on the primary disk
is low.

Free up disk space by exporting old saved
states to archive media and then deleting
them using the Session Manager.
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Available
Primary Disk
Space Too Low

Available disk space on the primary disk
is too low.

Immediately free up disk space by exporting
old saved states to archive media and then
deleting them using the Session Manager.

Available
Secondary Disk
Space Getting
Low

Available disk space on the secondary
disk is low.

Clean up the secondary disk.

 

Available
Secondary Disk
Space Too Low

Available disk space on the secondary
disk is too low.

Clean up the secondary disk so that there is
enough free disk space.

Cannot Change
Transducer

Another transducer has already been
used to define data.

Clear the planning data first.

Cannot
Remove Patient
Position Data

The patient position data cannot be
removed as scanning or sonication is
still in progress.

Wait for the scan to stop and try again.

Cannot
Remove
Planning Target
Volume

The Planning Target Volume cannot be
removed as scanning or sonication is
still in progress.

Wait for the scan to stop and try again.

Cannot
Remove
Treatment Cell

The treatment cell cannot be removed
as scanning or sonication is still in
progress.

Wait for the scan to stop and try again.

Cannot
Remove
Treatment Cell
Cluster

The treatment cell cluster cannot be
removed as scanning or sonication is
still in progress.

Wait for the scan to stop and try again.

Cannot
Remove
Treatment Cells

Removal of sonicated/scanned
treatment cells is not allowed.

Select 'Cancel' to keep the data. Re-plan if
you wish to resonicate or move treatment
cells.

Cannot
Remove
Treatment
Plane

The treatment plane data cannot be
removed as scanning or sonication is
still in progress.

Wait for the scan to stop and try again.

Check OAR and
ROI Positions

Registration has altered the ultrasound
beam paths. OARs and ROIs may have
moved. Check their positions in the
latest images.

Inspect visually the organ avoidance regions
and warning ROIs.

Communication
Error

A communication error has been
detected.

Restart the Sonalleve console.

 

Component
Query
Mismatch

The QA Test has been performed with
different hardware components than
those currently in use.

Perform the QA Test.

 

Confirm
Discarding of
the Old Patient
Data

The old patient data will be discarded.
Are you sure you want to continue?

Select 'Continue' to discard the old patient
data. Select 'Cancel' to keep the data.
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Confirm
Overwriting Old
Transducer
Data

The selected patient position already
contains transducer related data. Are
you sure you want to continue and
remove the old data?

Select 'Continue' to remove the old data.
Select 'Cancel' to keep the data.

 

Confirm Patient
Position
Removal

You are about to remove the patient
position and the position related data.
Are you sure you want to continue?

Select 'Cancel' to keep the data. Select
'Continue' if you are sure you will not need the
data anymore.

 

Confirm
Planning Target
Volume
Removal

The Planning Target Volume and its
associated data are about to be
removed. Are you sure you want to
continue?

Select 'Continue' to remove the data. Select
'Cancel' to keep the data.

 

Confirm the
Release of a
Degree of
Freedom

Releasing a degree of freedom will
remove existing treatment planes. Are
you sure you want to continue?

Select 'Continue' to release the degree of
freedom and to remove the treatment planes.
Select 'Cancel' to keep the data.

Confirm
Treatment Cell
Cluster
Removal

Removing the treatment cell cluster will
remove all the associated data, such as
treatment cell positions. Are you sure
you want to continue?

Select 'Continue' to remove the data. Select
'Cancel' to keep the data.

 

Confirm
Treatment
Plane Removal

If a treatment plane is removed, the
associated treatment cell clusters are
removed as well. Are you sure you want
to continue?

Select 'Continue' to remove the data. Select
'Cancel' to keep the data.

 

Confirmable
Test Error

This error is for R&D use only. You
should never see this in normal use.

Select 'Continue'. If the problem persists, stop
using the software and contact Service.

Connect Direct
Skin Cooling
Device Hoses

The Direct Skin Cooling device hoses
must be connected before the treatment
can continue.

Ensure that the hoses are properly connected.

 

Connection
Lost. Abort
Sonication
Using Safety
Device

The software cannot access the HIFU
Controller components. Sonication and
transducer movements may be
uncontrolled.

Use the Safety Device to abort any
uncontrolled actions. Wait 30 seconds for the
connection to re-establish. If a connection
does not resume itself, restart the Application.

 

Control Cable
Disconnected

The Sonalleve control cable has been
disconnected from the Patient Table.

Reconnect the control cable to continue
treatment.

 

Control Cable
Reconnected

The Sonalleve control cable has been
reconnected to the Patient Table and
the hardware must be re-initialized.

Restart the Application.

 

Cooler
Waterflow Low

The cooler waterflow is too low. Contact Service.
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Could Not
Correct for
Misregistration

The estimated misregistration could not
be corrected for. It is larger than the
maximum allowed.

Manually correct the misregistration or verify
the ultrasound coupling and hardware
functionality.

Crash
Recovery
Currently
Unavailable

Crash recovery is temporarily
unavailable. Data can be lost or
overwritten.

Wait for 60 seconds. If the problem persists,
restart the software.

Direct Skin
Cooling Device
Failure

The system has detected an error in the
operation of the Direct Skin Cooling
device.

Close the Sonalleve Application, then restart
the Application. If the problem persists,
contact Service.

Direct Skin
Cooling Device
Simulation
Mode in Use

Direct Skin Cooling device operations
are being simulated by the software.
Real skin cooling does not take place.

Use the configuration editor to turn the
simulation mode off.

Direct Skin
Cooling Device
Still Starting

The Direct Skin Cooling device is
establishing correct operating pressure.

Wait for the Direct Skin Cooling device status
to turn active before sonicating.

 

Direct Skin
Cooling
Disabled

Direct Skin Cooling disabled in
configuration but Direct Skin Cooling
controller detected.

Contact Service to ensure correct system
configuration.

 

Disturbance in
Temperature

The temperature has significantly
changed outside the intended treatment
volume. Patient movement or a sudden
change in the magnetic field may have
caused this. The temperature readings
are erroneous.

Abort the sonication and determine the cause
of the problem.

Do Not Power
Off Hardware

System is initializing. Loss of power at
this time may damage hardware.

Do not switch off the power from any
hardware components. Do not restart the
generator cabinet. Wait until the initialization is
ready.

Dynamic Levels
Running Out

The current temperature mapping scan
protocol does not contain enough
dynamic levels to continue much longer.

Stop the current temperature mapping scan
protocol, ensure that it has enough dynamic
levels configured, and restart the protocol.

Elevated Table
Top Water
Temperature

A rise in the Patient Table water
temperature has been detected. It is not
a cause of concern as long as the
temperature does not continue rising.

Check that the power level and sonication
duration are reasonable. Continue monitoring
the water bath temperature.

 

Excessive
Heating in
Treatment Cell
Region

Heating above the maximum safety limit
is detected in the treatment cell region.
Sonication is stopped.

Reduce power or cell size in the following
sonications.

 

Expected
Images Not
Received

Images were not received within the set
time. The MR scanner may have been
busy.

Restart the scan protocol on the MR scanner.

 

Failed to Apply
Calibration
Data

Failed to apply calibration data. The
system is not currently using the correct
calibration data.

Close the Sonalleve Application, check the
cable connections to the Patient Table, then
restart the Application.
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Failed to Install
Software
Components

Failed to install HIFU Controller
software components.

Restart the generator cabinet and wait 60
seconds for the connection to re-establish.
Postpone treatment until the installation is
successful.

 

Failure in
Software
Infrastructure

A system service has failed. This may
lead to application failures and data
loss.

Save the current procedure, exit the
Sonalleve Application and restart the
Sonalleve Console.

 

Field Strength
Incorrectly
Configured

The field strength configured for HIFU
does not match the field strength of the
MR scanner.

Contact Service to configure the field strength
correctly for HIFU. The field strength must be
correctly configured to be able to perform
patient treatments.

Fixed
Sonication
Parameters in
Use

The sonication protocols are currently
fixed. The user is not able to change the
sonication parameters (power, duration,
etc.).

Do not use this R&D system configuration for
therapy. Contact Service.

 

General
Hardware Error

Hardware failure. Further details can be
found in the system log.

Close the Sonalleve Application, check the
cable connections to the Patient Table, then
restart the Application. If the problem persists,
contact Service.

General
Hardware
Failure

Hardware failure. Further details can be
found in the system log.

Close the Sonalleve Application, check the
cable connections to the Patient Table, then
restart the Application. If the problem persists,
contact Service.

 

Generator
Hardware
Failure

Generator Hardware failure. Further
details can be found in the system log.

Determine the reason for the generator
hardware failure. Enable sonication with the
Safety Device and try to repeat the sonication.

 

Generator
Monitoring
Failure

Generator monitoring has failed and the
Safety Device has stopped sonication.

Determine the reason for the generator
monitoring failure. Enable sonication with the
Safety Device and try to repeat the sonication.

 

Hardware Does
Not Match
Configuration

Connected hardware does not match
the active hardware set in the
configuration.

Contact Service to ensure correct system
configuration.

 

Hardware
Initialization
Incomplete

The HIFU Controller reports incomplete
hardware initialization.

Restart the Hardware Initialization.

 

Heating in
Near-Field
Warning Zone

Heating detected in the near-field
warning zone.

Closely follow the temperature readings.
Consider aborting sonication.

10 Appendices > 10.10 Error and Warning messages

Instructions for Use  
109011C / 2025-12

195 (206)



 

Heating in
User-Defined
Warning Zone

Heating detected in the user-defined
warning zone.

Closely follow the temperature readings.
Consider aborting sonication.

 

High Risk of
Internal Burn

Overriding the cooling time can be
unsafe. It is estimated that
subcutaneous fat will suffer thermal
damage during sonication. This will
likely result in a burn injury.

Continue only if further clinical analysis
indicates that it is safe to continue.

Hospital
Network
Isolation Check
Failed

Hospital Network isolation is not
working. This may compromise the
proper functioning of the system.

Restart the Hardware Initialization. If the
problem persists, contact customer service.

Image Data
Input Queue
Full

The image data is received faster than it
can be processed. Some input images
are lost.

Wait for the input queue to be flushed. If
waiting does not help, restart the Application.

Image Data
Input Queue
Warning Length
Exceeded

The image data is received faster than it
can be processed.

Wait for the input queue to be flushed. If
waiting does not help, restart the Application.

Image Series
Retrieval Failed

Failed to retrieve some of the planning
images.

Try to export planning images again from the
MR scanner. Then perform query and attempt
retrieval again.

Inactive
Transducer
Channels

The hardware has deactivated several
transducer channels. There are still a
sufficient number of channels remaining
to guarantee the shape of the treatment
cell.

Monitor the treatment cell shape and check
the acoustic contact. Restart the generator
cabinet after treatment. If the problem
persists, contact Service.

Incomplete
Ultrasound
Frequency
Calibration

Calibration data not found for the
selected sonication frequency.

Select another sonication frequency to
proceed with the treatment. Contact Service
to complete the system calibration.

 

Inconsistent
Configuration
Data

The software detected inconsistent
configuration data that could affect the
system operation. Checksum validation
has failed, further details can be found
in the system log.

Close the Sonalleve Application and restore
the default system configuration. If the
problem persists, contact Service to ensure
correct system configuration.

 

Incorrect Scan
Protocol

The received monitor image attributes
do not match the expected values as
configured.

Select the correct scan protocol at the MR
console.

 

Internal Error in
Software Safety
Model

An internal error was detected in the
safety model of the software. It is
unsafe to continue the treatment.

Reselect the gel pad thickness. If that does
not help, save the state, exit Therapy, reset
any unsafe changes in the configuration
editor, and reload the state. If that does not
help, you will need to restart the therapy.

 

Invalid and
Unsafe
Configuration

The software detected invalid
configuration settings that could affect
the safety of the treatment. Further
details can be found in the system log.

Exit Therapy mode. Do not use the system to
treat patients. Contact Service.
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Invalid
Configuration
Data

The software detected invalid
configuration data that could affect the
system operation. Further details can
be found in the system log.

Close the Sonalleve Application and check
the system configuration. If the problem
persists, contact Service to ensure correct
system configuration.

 

Invalid
ExamCard

Could not find a suitable scan protocol. Ensure that a correct scan protocol has been
selected on the MR scanner.

 

Invalid Gel Pad
Thickness
Selected

The selected gel pad thickness is
invalid.

Select another thickness in the drop-down
menu on the Patient Information page. If all
available thicknesses are invalid, call Service.

Invalid Monitor
Image

Unable to display some of the monitor
images.

Most likely an invalid scan protocol has been
used during scanning or sonication. For
example, images might not contain correct
location/orientation information preventing
them from being displayed.

 

Invalid OAR,
Sonication Not
Allowed

A recently drawn OAR is invalid due to
an irregular line shape. Sonications are
not allowed as the ATA and beam
shape cannot be calculated.

Remove and redraw the invalid OAR.

Invalid Patient
Positioning

The patient position and orientation are
incompatible with the transducer in use.

Correct the patient positioning settings at the
scanner.

 

Invalid Saved
State File

An invalid saved state file has been
loaded - the version or product
configuration of the current system does
not match the loaded data.

Exit the therapy session and load a saved
state file with a correct version.

 

Invalid Scanner
Software
Version

This Sonalleve software version is
incompatible with the software on the
MR console. The installation of the
Sonalleve software has failed. Both the
Sonalleve Console and the MR scanner
software must be upgraded.

Contact Service. Software must be reinstalled.

 

Invalid
Transducer
Positioner
Firmware
Version

Transducer positioner firmware version
is invalid.

Contact Service. Transducer positioner
firmware must be upgraded.

 

Large Motion
Detected

The temperature maps indicate large
motion or localized field drift. Heating in
unintended regions may result. Any
temperature change outside the
intended heated region may have
caused this warning.

Abort the sonication and verify the patient
position.

Malfunction of
the Direct Skin
Cooling Device

The system has detected non-optimal
function of the Direct Skin Cooling
device.

The treatment can be continued, but
treatment time is likely to increase. Call
Service if the problem persists.

 

Missing or
Invalid
Membrane
Calibration

Membrane position calibration data is
either missing or invalid.

Contact Service. The membrane position
needs to be (re-)calibrated.
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Missing
Required
Calibration
Data

The system's calibration data store
does not contain all the required
calibration data instances.

Contact Service. Missing calibration data
instances are written to the log as warnings.

 

Missing
Required
Navigator Data

Missing navigator data required for
multi-baseline temperature mapping.

Use the correct scan protocol with navigators
enabled.

MR Scanner
Start Command
Failed

Failed to send a start command to the
MR scanner.

Restart the scan protocol on the MR scanner.

 

Near-Field
Stack Missing

No monitoring stack has been
positioned in the near field. Near-field
heating cannot be monitored and
cooling time cannot be estimated.
Sonicating without a near-field stack
may be unsafe.

Position a monitoring stack in the near field.

Network Time
Protocol
Service is
Enabled

Network Time Protocol (NTP) service
has been erroneously enabled in the
operating system. The NTP service
must be disabled to prevent
inconsistencies between the system
clocks during treatment. 

Contact customer service.

No Connection
to HIFU
Controller

Connection to the HIFU Controller
cannot be established. This indicates a
problem with the hardware.

Check that the generator cabinet is switched
on and check the cabling. If the problem
persists, contact Service.

No Connection
to MR Scanner

The MR scanner connection is missing.
Image and physiology data updates
cannot be received from the MR
scanner.

Check that the generator cabinet is switched
on and check the cabling. Restart the MR
application software on the MR scanner. If the
connection does not establish itself, contact
Service.

 

No Match to
Temperature
Reference

Could not find a match to temperature
reference data. Temperature images
are inaccurate. Sonication aborted.

Restart the sonication.

Non-default
Scan Protocol

The received monitor image attributes
do not match the expected values as
configured.

Select the correct scan protocol at the MR
console.

 

OAR Too Large One or more OARs are too large. Replace the large OARs with smaller ones.

 

Obsolete QA
Test

The QA Test has not been performed
within the set time.

Perform the QA Test.

 

Patient
Emergency
Stop

The patient has pressed the emergency
stop button.

Determine why the patient has pressed the
emergency stop button, then re-enable the
system using the Safety Device.
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Patient
ID Cannot Be
Changed

The old patient data contains
measurement results and cannot be
discarded.

Exit the current session and start a new one if
a new patient case is needed. To continue
with the current patient, select 'Cancel'.

Patient ID
Mismatch

The patient ID has been changed
during a therapy procedure.

Ensure that the correct patient has been
selected on the MR scanner.

Patient
Information
Cannot Be
Validated

The system configuration is invalid and
does not contain validators in all the
patient information fields.

R&D should add validators to the
configuration data or remove unnecessary
patient information fields.

 

Poor Heating
Efficiency in
Treatment Cell

Temperature is not increasing as
expected for the chosen thermal dose.

Verify that heating is centered on the
treatment cell and try to repeat the sonication,
or then repeat the test sonication.

 

Poor Match to
Temperature
Reference

Could not find a good match to
temperature reference data.
Temperature images may not be
accurate.

Restarting the sonication may be necessary.

Positioning of
Transducer
Aborted

Sonication cannot be started as the
transducer positioning operation was
not successful.

If the problem persists, restart the generator
cabinet.

Potentially
Unsafe
Sonication,
Change
Sonication
Parameters

The chosen combination of cell size,
location and power may result in
overheating at the skin surface or in
subcutaneous fat, and may be unsafe.

Use a smaller cell size, lower power level, or a
cell at a different location. Continue with
current parameters only if further clinical
analysis indicates it is safe to continue.

 

Problem with
QA Phantom

The QA Test detected a problem with
the phantom, or its position.

Change to the QA phantom or correct the
position.

 

Problem with
Transducer
Positioner

There is a problem with the transducer
position. The positioner has detected
limit switch locations that do not match
the configured acceptance limits.

Perform Hardware Initialization. If the problem
persists, contact Service. Check the log for
more detailed information.

Protected HIFU
Protocol
Modified

At least one protected HIFU protocol
has been modified. To ensure patient
safety, protected protocols may not be
modified.

The application log identifies the modified
protocols. Reset the modified protocols to
their default values.

 

QA Test Failed The QA or calibration test has failed. Try again. If the error reoccurs, contact
Service.

 

QA Test Not
Performed

The QA test must be performed to
guarantee the proper functioning of the
system.

Perform the QA Test, either interactively from
the UI or manually (see IfU).
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R&D Feature
Disables Safety
Checks

The built-in safety logic has been
overridden by R&D commands. Data
consistency cannot be guaranteed and
some hardware notifications can be
suppressed.

Save the state before proceeding in the R&D
mode.

R&D System ID
in Use

An R&D System ID is in use. The
correct system ID is set during the
installation procedure. Probably the
installation is incomplete.

The system configuration needs to be
corrected. Contact Service.

 

Reference
Collection
Failed

Could not collect valid temperature
reference during pre-sonication phase.

Restart the sonication.

 

Risk of
Excessive
Heating

It may be unsafe to perform a
sonication with the chosen combination
of cell size, location and power. The
chosen parameters may result in
overheating at the skin surface or in
subcutaneous fat.

Use a smaller cell size, lower power level, or a
cell at a different location. Continue only if
further clinical analysis indicates it is safe to
continue.

 

Risk of
Excessive
Tissue Heating

Overriding the required cooling time
may be unsafe. Skin or subcutaneous
fat may presently be too warm for
sonication.

Continue only if further clinical analysis
indicates it is safe to continue.

 

Risk of Tissue
Burn,
Sonication Not
Allowed

The chosen combination of cell size,
location and power was predicted to
cause overheating at the skin surface or
in subcutaneous fat. Therefore, the
sonication was stopped.

Use a smaller cell size, lower power level, or a
cell at a different location.

 

Safety Device
Abort

The Safety Device stop button has been
pressed to abort sonication.

Enable sonication with the Safety Device to
resume the treatment.

 

Scan Protocol
Aborted

The scan protocol was unexpectedly
aborted. The abort may have been
caused by a failure in the scan protocol
or by a manual abort on the MR
scanner.

Restart the scan protocol on the MR scanner.

 

Scan Protocol
Change Timed
Out

The MR scanner could not change the
current scan protocol. The scan
protocol must be manually changed.

Abort the current scan protocol at the MR
scanner and prepare the desired scan
protocol (e.g. temperature mapping or fat-
monitoring) manually.

Scanner
Connection
Failed, Scan
Prevented

The MR scanner connection was not
available when scanning was
attempted.

Restart the scan protocol on the MR scanner.

 

Scanner
Connection
Unavailable

The software cannot access the
scanner host component, scanning
cannot be controlled or data queried.

If the software does not recover in 30
seconds, restart the Application.
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Scanner Data
Unavailable

The MR scanner could not provide any
examination data. Scanning is not
possible.

Ensure that the ExamCard is prepared and
that a remote controlled scan protocol is
started on the MR scanner.

 

Scanner Host
Emulation
Active

Data from the real scanner received,
but scanner emulator has been
configured as our image data source.

Either configure the scanner not to use the
Sonalleve Console as the data target, or
disable the scanner emulator at the console.

 

Scanner Time
Settings Differ

MR console and Sonalleve Console
time settings differ.

Run the daily QA procedure to re-synchronize
the clocks.

Scanning
Prevents
Transducer
Positioning

The transducer cannot be positioned
while a scan is in progress.

Stop the scan before attempting to sonicate.

 

Serious
Problem with
the Direct Skin
Cooling Device

The system has detected an error in the
operation of the Direct Skin Cooling
device.

Close the Sonalleve Application, then restart
the Application. If the problem persists,
contact Service.

Service Mode
Active

Detected an active service mode.
Therapy operations should not be
performed while service mode is active.

Contact Service to disable the service mode.

Slices Cannot
Be Positioned

Monitor slices cannot be positioned at
the location of the treatment cell.

Restart the scan protocol on the MR scanner.

 

Software
Components
Unavailable

The software cannot access the therapy
controller component. Therapy cannot
continue until control is regained.

If the software does not recover in 30
seconds, restart the Application.

 

Software Error
Prevents
Proceeding

An internal software error prevents
continuation of the procedure.

Save the state and restart the Application.

Software Failed
During
Sonication

Software failed to perform the
sonication. Either the software state or
its logic produced unexpected results.

Abort the sonication, reselect the treatment
cell and energy dose, then retry.

Software
Failure During
Scanning

Scanning failed due to a failure in the
software state or logic.

Re-select the treatment cell and retry.

Sonication
Failed

The sonication has failed. Sonication
can fail for multiple reasons including a
user abort.

Retry the sonication. If the reason for the
failure is unclear, check the log for more
detailed information.

 

Sonication
Failed (Heating
in Near Field)

Heating detected in the near-field
warning zone, sonication has been
aborted.

Wait for the cooling time to complete, check
the cumulative temperature dose and verify
that no unintended burns have occurred
before continuing the treatment.
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Sonication
Feedback
Control Failed

The HIFU Controller failed to modify
sonication based on feedback.

Restart the generator cabinet.

 

Sonication
Hardware
Disabled

Sonication hardware has been disabled,
the hardware needs to be reset before
the operation can continue.

Restart the generator cabinet.

Sonication Not
Allowed,
Change
Sonication
Parameters

The chosen combination of cell size,
location and power would result in
overheating at the skin surface or in
subcutaneous fat, and is therefore not
allowed.

Use a smaller cell size, lower power level or a
cell at a different location.

 

Surface
Segmentation
Instance
Cannot Be
Displayed

One or more of the retrieved Surface
Segmentation instances cannot be
displayed because their spatial
orientation is unknown or not supported.

Retrieve a planning stack that is geometrically
related to the retrieved Surface Segmentation
instances.

 

Surface
Segmentation
Instances Have
Unknown
Positions

One or more of the retrieved Surface
Segmentation instances has an
unknown position relative to the
retrieved planning stacks. They might
be displayed in the wrong position.
Display them anyway?

Retrieve a planning stack that is geometrically
related to the retrieved Surface Segmentation
instances. If such a planning stack is not
available and you wish to display the Surface
Segmentation instances with unknown
position anyway, select Yes.

 

System
Initialization
Timed Out

The system was not able to initialize the
hardware in a specified time. This
indicates a problem with the hardware.

Restart the Sonalleve Application. If the
problem persists, try restarting the generator
cabinet and wait for the system to initialize. If
the problem is still not resolved, contact
Service.

 

System
Integrity
Compromised

Application files have been tampered
with. Typically this indicates an infection
caused by malware or virus programs.

Stop using the software, shut down the
Sonalleve Console and contact Service.

System Service
Not Available

A system service has failed, which is
preventing the hardware from starting.

Save the state and close the Sonalleve
Application. Restart the Sonalleve Console. If
the problem persists, contact Service.

 

Table Top
Unlocked,
Sonication Is
Prevented

Sonication cannot be enabled. The
Table Top locking switch indicates that
the Table Top is unlocked.

Push the Table Top to its locked position.
Enable sonication with the Safety Device.

 

Table Top Water
Temperature
Too High

The Patient Table water temperature
has reached a critical level. The
sonication is stopped.

Wait for the water to cool down and try again
with lower power levels or shorter sonications.

 

Test Error This error is for software test use only.
You should never see this in normal
use.

Restart the Application. If the problem
persists, contact Service.
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Test Error 2 This error is for software test use only.
You should never see this in normal
use.

Restart the Application. If the problem
persists, contact Service.

 

Test Error 3 This error is for software test use only.
You should never see this in normal
use.

Restart the Application. If the problem
persists, contact Service.

Therapeutic
Power Level
Not Allowed

A therapeutic power level is not
permitted until a test sonication is
performed.

First perform a test sonication on the cluster.

Time mismatch
in Sonalleve
system
components

A time difference between the system
clocks in the Sonalleve Console and the
HIFU controller has been detected.
Clocks are being resynced. Sonications
will be enabled after approximately 10
minutes.

Continue the treatment with caution because
clock mismatch can affect the proper
functioning of the system. Disable the
Network Time Protocol (NTP) service if it has
been erroneously enabled. Contact customer
service.

Too Large
Thermal Dose
in Organ
Avoidance
Region

The planned treatment position would
cause too large thermal dose in the
marked organ avoidance region.

Reposition the treatment cell to avoid the
organ avoidance region.

 

Too Many
Transducer
Channels
Inactive

The hardware has deactivated several
transducer channels. The sonication is
stopped as the shape of the treatment
cell may be affected.

Check the acoustic contact or reduce
sonication power and retry the operation.
Restarting the generator cabinet may help. If
the problem persists, contact Service.

 

Too Many
Transducer
Channels
Inactive on One
Board

The hardware has deactivated several
transducer channels. The sonication is
stopped as the shape of the treatment
cell may be affected.

Check the acoustic contact or reduce
sonication power and retry the operation.
Restarting the generator cabinet may help. If
the problem persists, contact Service.

 

Transducer
Humidity High

Transducer humidity level is
approaching critical limits.

If the problem persists, schedule Service.

 

Transducer
Humidity Too
High

Water has ingressed into the transducer
and the sonication is stopped. The
transducer must be replaced.

If the problem persists, contact Service.

 

Transducer
Movement
Failure

The transducer positioner has failed to
move the transducer to the requested
position.

Perform Hardware Initialization. If the problem
persists, contact Service.

Transducer
Positioner
Connection
Failure

The connection to the transducer
positioner has been lost.

Wait 30 seconds for the connection to re-
establish. If the problem persists, restart the
generator cabinet.

Transducer
Positioner
Simulation
Mode in Use

Transducer movements are being
simulated by the software. Real
movements do not take place.

Use the configuration editor to turn the
simulation mode off.
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Transducer
Positioner
Uncalibrated

Transducer positioner has not received
the required calibration data. This might
indicate a communication failure
between the Patient Table and
generator cabinet, or incorrect system
configuration.

Close the Sonalleve Application, check the
system configuration and the cable
connections to the Patient Table, then restart
the generator cabinet and the Application. If
the problem persists, contact Service.

Transducer
Positioning
Failed

The transducer could not be positioned.
Either the configuration is invalid or the
hardware is unable to move to the given
position.

Wait for 30 seconds, then retry. If the problem
persists, restart the generator cabinet.

Transducer
Temperature
Elevated

A rise in the transducer temperature
has been detected. It is not a cause of
concern as long as the temperature
does not continue rising.

Check that the power level and sonication
duration are reasonable.

 

Transducer
Temperature
Too High

The transducer temperature has
reached a critical level and sonication is
stopped.

Wait for the transducer to cool down and try
again with lower power levels or shorter
sonications.

 

Transformation
Matrix Has Not
Been Received

The HIFU Controller has not received
the transducer transformation matrix.

Restart the Hardware Initialization.

Treatment Data
Storage
Unavailable

The software cannot access the internal
data storage area. Data can be lost or
overwritten.

Wait 30 seconds and retry the previous
operation. If the problem persists, restart the
software (data may be lost).

 

Unable to Write
Data

Writing of task data to the hard drive
has failed. The task data is necessary
for the software to continue operation.

Contact Service.

 

Uncertainty in
Temperature
Measurement

Temperature in the treatment cell area
could not be measured. Image artifacts,
patient or organ movement or low signal
could have caused this.

Try to identify the source of possible artifacts.
Attempt to reduce the artifacts with a REST
slab, for example, or select a treatment cell
location with a brighter signal.

 

Uncertainty in
Transducer
Position

The position of the transducer varies
too much between two consecutive
homings.

Perform Hardware Initialization and verify the
position of the transducer. If the problem
persists, contact Service. Check the system
log for more detailed information.

Unknown MR
Scanner Model

The retrieved planning image set was
not identified as being from a supported
scanner model.

Scan and retrieve new therapy planning
images. If the warning is not cleared after this,
contact Service.

Unreachable by
Hardware

The selected cell lies outside the reach
of the transducer hardware.

Use another cell in a valid position.

Unreachable by
Treatment Cell

The current treatment cell type cannot
be used to reach the designated target
area.

Use another cell in a valid position.
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Unreachable by
Treatment Cell
Type

At least one treatment cell is in an
invalid position.

Remove the invalid treatment cell, select a
smaller treatment cell or move the cluster
position closer to the Patient Table, so that
less electronic deflection is required in depth
direction.

 

Unsafe
Configuration
in Use

One or more configuration attributes are
in a non-default state. Some of these
modified attributes have been marked
as unsafe.

Revert the unsafe configuration attributes to
their default values.

Wrongly
Positioned
Treatment Cells

At least one treatment cell is out of the
available target area or out of the area
covered by the monitor slices.

Move or delete the treatment cells that cannot
be heated or monitored.
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10.11 Legal notices

Sonalleve MR-HIFU - Instructions for Use
Published by Profound Medical
Profound Medical reserves the right to make changes to both this Instructions for Use and to the
product it describes. Product specifications are subject to change without notice. Nothing contained
within this Instructions for Use is intended as any offer, warranty, promise or contractual condition,
and must not be taken as such.
© Profound Medical 2025
All rights are reserved. Reproduction in whole or in part in any form or by any means, electrical,
mechanical or otherwise is prohibited without the written consent of the copyright holder.
Unauthorized copying of this publication may not only infringe copyright and reduce the ability of
Profound Medical to provide accurate and up-to-date information to users.
Non Profound Medical product names may be trademarks of their respective owners.
Published in Canada

10.11.1 Profound REACH statements

REACH requires Profound Medical to provide chemical content information for Substances of Very
High Concern (SVHC) if they are present above 0.1% of the article weight. The QA Phantom 4510
000 82232 for Sonalleve MR-HIFU systems may contain acrylamide (CAS nr.: 79‑06‑1) more than
0.1% but less than 0.25% of the phantom weight.
REACH requires Profound Medical to provide chemical content information for Substances of Very
High Concern (SVHC) if they are present above 0.1% of the product weight. Components within
electric and electronic equipment may contain phthalates above the threshold (e.g. bis(2-
ethyl(hexyl)phthalate), CAS nr.: 117-81-7).
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